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About this manual 

This data management manual will explain in detail all data management procedures for the 
Assessment of Minimum Proficiency Levels (AMPL). 

Chapter 1 is an introductory chapter. In this chapter the data management tasks for AMPL are outlined, 
the roles of different data management staff are defined, and the terminology used in this manual is 
explained. 

Chapter 2 gives a short overview of the data management software, ACER Maple and describes its 
installation, initialisation, and user settings. The main ACER Maple functions available to AMPL users 
are also outlined in this chapter. 

Chapter 3 details all the documentation that is necessary for data management. 

Chapter4 explains how to prepare for data administrator training. 

Chapter 5 first provides instructions on checking and importing List of Classes1 and List of Students 
data into ACER Maple to be sampled for assessment.  

When these data are imported, ACER Maple performs some data checks and if discrepancies are found, 
produces the Import Field Data Validity Report. The second part of chapter 5 explains how to resolve 
these discrepancies.  

Chapter 6 provides instructions on how to undertake class and student sampling in ACER Maple. 

Chapter 7 provides instructions on how to populate tracking form templates with data from ACER 
Maple. The tracking form Excel templates that are despatched with ACER Maple are used for this 
process. Any discrepancies that may be produced in the Export Field Data Validity Report are also 
explained. 

Chapter 8 provides instructions on labelling and packaging materials. 

Chapter 9 that explains procedures related to the receipt of materials after the assessment:  

• First it provides instructions on how to check the materials received from Test Administrators,   

• then it explains how to check and import updated tracking form data into ACER Maple, and the 
errors and warnings that may be listed in the Update Field Data Validity Report.  

• Finally, it describes how to update the School Participation Form and what to do with the Update 
Institution Participation Validity Report which may be generated if there are discrepancies in the 
school participation data. 

Chapter 10 that explains how to organise data entry of responses after the assessment and provides 
instructions for data entry operators that can be used for their training. 

Chapter Error! Reference source not found. is the data submission chapter. It describes the tasks for e
xplaining any discrepancies remaining in the data and then submitting the data to ACER for further 
processing. 

Appendix 1 contains checklists that have to be filled when data is ready to be submitted to ACER. 

Appendix 2 contains troubleshooting advice. 

Appendix 3 contains procedures for ‘blind’ sampling. 
 

 

 
1 In this manual, student refers to a learner or a pupil to be assessed and class refers to a grouping of students in the same 
grade level, taught by the same teacher 
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Appendix 4 contains an index of tables. 

Appendix 5 contains an index of figures. 

This manual uses acronyms and technical terms. You can find the list of the most common acronyms 
at the end of this section. The terms are explained when they are first used.  

Throughout the manual, important notes and warnings are indicated using the following formatting:  
  

 

This is an important note or an ACER Maple tip. Many of these notes are AMPL 
requirements. 

 
  

 

This is a warning. Information in these boxes are crucial for correct procedures and must 
be read and followed carefully. 

 
  

 

This is a note to National Centres participating or not participating in certain options  agreed 
upon with ACER. 

 

In this manual, screenshots are used to illustrate examples of how the different ACER Maple features 
are used. 
  

 

Please note that although ACER Maple functionality in screenshots corresponds to version 
2. 16 or higher, some details, like version number, user details, or template column names 
can be different from what you will see on your screen. 

 

Acronyms used in this manual 

ACER Australian Council for Educational Research 

AMPL Assessment of Minimum Proficiency Level 

AMPLa AMPL design a is intended for the students from the end of lower primary school 

AMPLb AMPL design b is intended for the students from the end of upper primary school 

AMPLab AMPL design a+b is intended for the students from the end of upper primary school with 
the link to the students from the end of the lower primary school. 

DMR Data Management Resources are various Excel templates and Word documents that are 
necessary to complete data management tasks. 

DMTP Data Management Training Package Part 1 contains a Power Point presentation and other 
materials related to the data management tasks to be completed by the National Centre 
before the assessment. 

LCL List of Classes from which a class eligible to participate in the AMPL is sampled 

LSS List of Sampled Schools agreed between ACER and the National Centre and imported into 
ACER Maple by ACER 

LST List of Students from the sampled class. Only these students are eligible to participate in 
the AMPL. 

MRWF Main and Replacement Warning Form – one of the ACER Maple forms used to explain 
warnings produced when field data is imported or updated. 
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NC National Centre 

PAWF Participation& Attendance Warning Form – one of the ACER Maple forms used to explain 
warnings produced when field data is imported or updated. 

PC Personal Computer running a Microsoft® Windows operating system (laptop or desktop) 

 
QAS Questionnaire Adaptation Spreadsheet agreed between ACER and the NC 

QSA Questionnaire Structural Adaptation form agreed between ACER and the NC and imported 
into ACER Maple by ACER 

RLWF Respondent List Warning Form - the ACER Maple form used to explain warnings produced 
when response data is checked against tracking data 

SC School Coordinator 

SCF Sampled Class Form is filled with the details about sampled class 

SEN Special Education Needs 

SALF Student Assessment Labelling Form used to label student assessment instruments 

SPF School Participation Form used to register school participation status 

SQTF School Questionnaire Tracking Form used to label School Questionnaires and to record the 
receipt of the School Questionnaires 

SCQ School Questionnaire filled by school principals 

STF Student Tracking Form populated with sampling data from ACER Maple and used by Test 
Administrators to record student attendance and participation. 

STQ Student Questionnaire administered after the AMPL test 

TA Test Administrator 

TCS Target Cluster Size 

VM Virtual Machine Oracle VM VirtualBox software version 6.1.42 

(https://www.virtualbox.org/wiki/Download_Old_Builds_6_1) 

 

 

https://www.virtualbox.org/wiki/Download_Old_Builds_6_1
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1 INTRODUCTION TO DATA MANAGEMENT  
No table of contents entries found. 

1.1 Overview of data management tasks 

  

 

Data management with ACER Maple is a requirement for AMPL. 

Data management is a critical part of the AMPL data collection. It is preceded by school sampling, 
AMPL questionnaire adaptations, and preparation of all assessment instruments for printing. Once 
school sampling and all adaptations have been completed and all assessment instruments have been 
prepared for printing, the ACER data management team customises the data management software, 
ACER Maple for your National Centre (NC). 

When the ACER data management team complete customisation of ACER Maple for your NC, you will 
be notified that a pre-configured version of ACER Maple for your NC has been uploaded to the 
MS◦teams>AMPL Partner Collaboration >Country Folder>Data management (Maple). ACER will also 
explain how to download ACER Maple from this folder. 
  

 

Please make sure that well before you start on any other data management tasks, the List 
of Sampled Schools (LSS) and the Questionnaire Structural Adaptations (QSA) have been 
agreed between your NC and ACER; and you are familiar with the contents of these files 
(see section 2.4 for details). 

The entire data management process involves the following major tasks performed at the NC: 

Before the assessment 

1. Installation and initialisation of ACER Maple (chapter 2). 

2. Checking documentation and training test administrators (chapters 3 and 4). 

3. Checking and importing data for sampling (chapter 5). 

4. Class and student sampling (chapter 6). 

5. Populating tracking form templates with data from ACER Maple (chapter 7). 

6. Labelling assessment instruments (chapter 8). 

After the assessment 

7. Updating data from tracking forms in ACER Maple (chapter 9). 

8. Organising data entry and entering response data (chapter 10). 

9. Data submission to ACER and data cleaning participation (chapter 11). 

The sequence of all data management tasks is illustrated in Figure 1. This figure shows which tasks are 
performed before the assessment and which are performed after the assessment. It also shows that 
different tasks are performed by different personnel: data manager, data administrators and data 
entry operators. Their roles are defined in section 1.3. 
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Figure 1: Data management tasks for the AMPL 

All tasks illustrated in Figure 1 are outlined in this chapter and explained in detail in subsequent 
chapters of this manual.  

Before the assessment: 
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A) Make sure: 

• you have enough workstations for data administrators; 

• the PC on which you intend to install ACER Maple (called the host PC) satisfies all system 
requirements (section 2.2); 

• check the PC set-up (section 2.3);   

ACER Maple should then be downloaded from the MS Teams>AMPL Partner Collaboration >Country 
Folder>Data management (Maple), installed and initialised (sections 2.5 -2.10). 

B) After you download and initialise ACER Maple, you need to prepare and check all materials 
necessary for student sampling and data entry. These are: 

• initial data: 

• templates for field operation forms such as List of Classes (LCL), List of Students (LST) and 
Student Tracking Forms (STF); and 

• the data entry screens for the AMPL assessment instruments such as tests and questionnaires. 

Chapter 3 explains how to prepare and check necessary materials. 

C) After ACER Maple has been installed on a host PC and all materials have been prepared and checked, 
the data manager can train data administrators (chapter 4). 

D) After data administrators have been trained, they will check class lists received from schools and 
format them into LCL files, then import the LCL data into ACER Maple (sections 5.2 and 5.4).  

E) After data from the LCL have been successfully imported into ACER Maple, class sampling is 
undertaken, which results in the one class being sampled (chapter 6) and SCF form populated with the 
sampled class data (chapter 7).  

F) The School Coordinator (SC) must be contacted to obtain student lists from the sampled class. Data 
administrators will check and format the student lists received from schools into the LST files, then 
import the LST data into ACER Maple (sections 5.3 and 5.4). 

Import validation for steps D and F: Each time the data is imported into ACER Maple, the software will 
check the imported data for inconsistencies. Detected inconsistencies will be listed in the Import Field 
Data Validity Report. Some of these inconsistencies may be errors that must be corrected before 
student sampling can proceed, while others may be warnings of missing data that can be completed 
later by Test Administrators on the tracking forms (section 5.5). 
  

 

Data will only be transferred into the ACER Maple database when all errors have been 
corrected. 

G) After data from the LST have been successfully imported into ACER Maple, student sampling is 
undertaken in order to produce tracking forms with student identification and instrument allocation 
designated to each student (chapter 6). 

H) After students are sampled, the data from ACER Maple is used to fill:  

• the STF Excel template (chapter 7) and  

• the SALF and SQTF templates used to label assessment instruments (chapter 8).  

STFs that have been pre-populated with data from ACER Maple are then sent to the SC to be checked 
and updated before the assessment. Once finalised, the STF is then sent, together with other materials, 
to the TA to be used during the assessment.  
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After the assessment: 

A) The materials received from Test Administrators are checked, further updated (if necessary) and 
prepared for processing in ACER Maple (chapter 9). This involves: 

• Checking all student assessment instruments (Test Forms and questionnaires) against the STF 
and arranging assessment instruments for data entry (section 9.1). 

• Updating student demographic data (if corrected by the TA/SC) and participation data in ACER 
Maple, from the returned STF checked against student assessment instruments. This is usually 
done school by school. Errors that appear in the Update Field Data Validity Report must then be 
corrected in the data. Records that are classified as warnings and found to be true do not need to 
be corrected (see details in sections 9.2, 9.4, and 9.5). 

• Maintaining the School Questionnaire Tracking Form (SQTF) on receipt of the School 
Questionnaire. The SQTF is also updated by the data administrator in ACER Maple after all 
materials are returned and all student tracking data has been updated. Errors that appear in the 
Update Field Data Validity Report must then be corrected in the data. Records that are classified 
as warnings and found to be true do not need to be corrected (sections 9.3 and 9.5). 

• Maintaining the school participation status for each school during field operations. The School 
Participation Form (SPF) is updated by the data manager in ACER Maple after all student tracking 
data and the SQTF have been updated. Errors that appear in the Update Institution Participation 
Validity Report must then be corrected in the data. Records that are classified as warnings and 
found to be true must be explained (sections 9.6 and 9.7). 

B) While students are being assessed, office space and PCs for data entry operators must be prepared, 
and data entry operators should be employed and trained (section 10.1). 

C) When most of the materials have been received, checked, and prepared, data entry of responses 
can commence (section 10.2). 

D) After data entry is completed, it must be validated in ACER Maple against the updated tracking data. 
Errors that appear in the Respondent Validity Report must be corrected in the data. Warnings found to 
be true must be explained (sections 10.3 and 10.4). 

E) After all data has been checked, corrected, and warnings have been explained (where necessary), 
the data is submitted to ACER. The data manager then works with a member of the ACER data 
management team to verify the data further (chapter Error! Reference source not found.). 

1.2 Terminology 

This section provides definitions for terms that are used throughout the manual that have not been 
explained in the previous section. 

1.2.1 Domain (Survey ID, Entity ID and Admin ID) 

Due to the secure nature of the AMPL data, each member of the NC data management team will only 
be able to access part of the AMPL database. The part of the database to which an ACER Maple user 
has access is called the domain. 

Domain is defined by a combination of identification variables: Survey ID, Entity ID and Admin ID. 

Survey ID for the AMPL is defined as 033. 

Entity ID is a 6-digit string based on your country 3-digit ISO code (see Table 1). One NC can have one 
or more entities depending on their national options. 
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Table 1:Entity IDs for countries participating in the AMPL 

Country Grade Test design Entity ID Language 

India 

3 a 

To be advised 

ENG 

5 b ENG 

5 b HIN 

Kenya  6 ab 040400 ENG 

Lesotho 7 ab 042600 ENG 

The Gambia 3 a 027000 ENG 

Zambia 
4 a 

089400  ENG 
7 ab 

 

Admin ID is an administrative set of schools within each entity. The Admin ID values are assigned in 
the List of Sampled Schools (LSS). Each set of schools is assigned a different two-digit Admin ID value 
(starting from '01') within each entity as required. This is done to allow several data administrators to 
work simultaneously across a set of schools within a particular Admin ID.  
  

 

In addition to the Admin ID values assigned in LSS, a special value of Admin ID='00' is used 
by the data manager for operations related to all schools in the entity. This value is not 
used in LSS. 

 

1.2.2 Templates and related terms 

An Excel template is an Excel file that has been formatted in a particular way. ACER Maple uses two 
types of Excel templates: 

1. Input template is an Excel file intended to be populated with data by users and imported into 
ACER Maple, for example: 

 LSS and QSA templates: ACER populates these with initial data (in consultation with NCs) and 
imports them into ACER Maple before the software is despatched to NCs; or 

 LCL and LST templates: The SC fills this spreadsheet with details, which are then imported into 
ACER Maple by the data manager for sampling. 

2. Output template is an Excel file intended to be populated with data by ACER Maple as a result of 
sampling or validation. For example, STF templates are populated with sampling data by ACER 
Maple and later updated by Test Administrators. 

An Excel template can have several worksheets. A worksheet containing sections that need to be filled 
with data is called a data worksheet. The section containing data is called a data section. 

Field operation forms comprise LCL, LST, SCF, STF, SQTF, SALF and SPF. 

An ACER Maple template is a software structure that corresponds to a data worksheet within an Excel 
template. It enables ACER Maple to either import data from a corresponding input template into ACER 
Maple, or to populate a corresponding output template with data from ACER Maple. 

1.2.3 Discrepancies in validity reports 

The various validity reports generated during the data management process lists discrepancies found 
in the data by ACER Maple. Validity reports are generated whenever a user attempts to import data 
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from Excel, when students are sampled, or when a user attempts to export data to Excel. There are 
two types of discrepancies:  

• Errors are incorrect records that must be corrected, for example, ID discrepancies.  

• Warnings are inconsistent records that may be correct but must be double-checked and either 
corrected or explained. 

Resolution of discrepancies involves correcting all incorrect records and providing an explanation as to 
how any correct but inconsistent records have occurred, for any remaining warnings. Explanations are 
required by ACER as a part of the data submission task which is explained in detail in Chapter Error! R
eference source not found. . 

1.3 Data management staff employed by NCs 

NCs are advised to employ the following staff: 

• One data manager per entity: this is the person responsible for all data management operations 
in the entity (see section 1.2.1 on page 11 for definition of an entity). The data manager must be 
trained by ACER staff for all data management procedures. One NC can have one or more entities 
depending on their national options and as many data managers as there are entities2. 

• As many data administrators per entity as agreed with ACER sampling team: these staff 
members are trained by data managers and work under their instruction. Data 
administrators assist the data manager with operations designated on Figure 1, page 9 in 
blue boxes (  ). If necessary, the data manager can work as one of the data administrators3. 

• Data entry operators: up to ten data entry operators can work under the instruction of each data 
administrator. Data entry operators are employed for a short period of time to enter test and 
questionnaire responses into ACER Maple after assessment. Data entry operators must be 
trained by the data manager. 

1.4 Communication protocols 

If you require help when operating ACER Maple:  

• contact ACER Helpdesk at maplehelpdesk@acer.org, (cc Alla Routitsky at 
alla.routitsky@acer.org); 

• specify your 3-letter country code and subject in the subject line of the e-mail; 

• include in the e-mail:  

 detailed description of the problem;  

 screenshots and excel files if required. 

We’ll send you confirmation that we have received your e-mail and may ask for more information. At 
this stage you may need to send us your anonymised data. See Appendix 2, section 0 on how to extract 
this data. 

 

 

 
2 If there is one data manager in your NC and more than one entity, this data manager will need to login to ACER Maple 
with different login details for every grade level and language of assessment he /she is managing. 

3 If there are no data administrators in your NC, the data manager will still need to create an administrator login when 
initialising ACER Maple and use this login for various ACER Maple functions as instructed throughout this manual. However, 
this will slow down student sampling and reduce the number of data entry operators that can enter data simultaneously 
and delay the completion of data management tasks. 

mailto:maplehelpdesk@acer.org
mailto:alla.routitsky@acer.org
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2.1 Overview of ACER Maple 

The data management software, ACER Maple is a tool that is used to complete the following data 
management tasks: 

• Before the assessment, ACER Maple is used to: 
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1. import list of classes and sample a class of students to be assessed in each grade level agreed 
with ACER; 

2. import list of students from the sampled class(es), sample students, and allocate survey 
instruments to the sampled students;  

3. populate preconfigured tracking form templates with sampling data from ACER Maple. 

• After the assessment, ACER Maple is used to: 

1. import tracking data collected by Test Administrators into ACER Maple; 

2. enter responses from paper-based instruments into ACER Maple;  

3. validate response data against the tracking data; and 

4. submit anonymised data to ACER for further processing and analysis. 

ACER Maple is developed in R programming language and runs as a host-user system. The host is a PC 
that runs an R session that operates ACER Maple. Installation of R is provided in the ACER Maple 
package. ACER Maple has two databases: a confidential database that is available to the NCs and an 
anonymised database that is submitted to ACER for further processing. 

This chapter describes the system requirements, installation steps, user settings and general 
navigation rules for ACER Maple. 
  

 

Throughout the manual, screenshots are used to illustrate various functions of the ACER 
Maple software. Some details, like version number, or user details, or column names in 
some templates on the screenshots may vary, but illustrated functions are the same as in 
the version you are going to use. 

 

2.2 System requirements 

2.2.1 ACER Maple on a virtual machine 

For the AMPL survey, the preferred mode of deployment for ACER Maple is through a Linux-based 
virtual machine. Specialised software, VirtualBox, is installed on a dedicated host PC, which hosts the 
virtual machine. ACER Maple software is then loaded onto the virtual machine using a disk image. The 
dedicated host PC will always keep the virtual machine running, and users (single or multiple) can 
access ACER Maple from either the same host PC or separate PCs at any time using the IP address 
specified by ACER Maple, in a web-based browser. Using ACER Maple in this mode requires that: 

• all user PCs and the host PC be within the same LAN;  

• the IP address and port of the host PC is fixed (permanent); and  

• within the LAN, access to the host PC is not blocked by a firewall or network policy. 
  

 

You may need to ask your IT department to ensure that the LAN requirements described in 
this section, and the PC requirements described in sections 2.2.2 and 2.2.3, are met. 
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2.2.2 System requirements for the host PC 

The host PC must have:  

• Microsoft Windows 64-bit version; 

• a standard installation of Microsoft Office (no earlier than Office 2013), since data is imported 
into and exported from ACER Maple in Excel format;  

• preferably Mozilla Firefox browser; and 

• Oracle VM VirtualBox software version 6.1.42 downloaded from 
https://www.virtualbox.org/wiki/Download_Old_Builds_6_1. 

• Recommended 80GB disk space (minimum 50GB) and 16GB of RAM (minimum 8GB) to download 
and install ACER Maple in VirtualBox software: 

 Installation of VirtualBox software and disk image to install ACER Maple requires at least 23GB 
of disk space. 

 Users will need additional hard disk space to be available for database backups. 

 The ACER Maple VM (virtual machine) will utilise approximately half of the host PC’s total 
RAM for optimum performance. For example, on a host PC with 16GB RAM, the VM will only 
utilise 8GB. 

 
  

 

Google Chrome is also acceptable. However, it tends to have problems with exporting data 
from ACER Maple. If you encounter such problems, please switch to Mozilla Firefox. 

NO other browsers are supported 

 
  

 

Make sure that the chosen browser is the default internet browser on the user’s PC and 
that the browser’s default download location is disabled. 

 

2.2.3 System requirements for all user PCs 

All user PCs (connected to the host PC via LAN) must have:  

• Microsoft Windows 64-bit version; 

• a standard installation of Microsoft Office no earlier than Office 2013. This is necessary because 
data is imported into ACER Maple from Excel and also exported from ACER Maple into Excel; and 

• preferably Mozilla Firefox internet browser (see warnings in section 2.2.2 above). 

2.2.4 Security recommendations 

The following security recommendations apply to all PCs within the LAN that will be used to access 
ACER Maple: 

• all PC drives are encrypted using BitLocker or similar; 

• the host PC firewall is deployed so that HTTP ports are accessible from other machines on the 
same network.  

• the PC hosting the ACER Maple VM should be either: 

 a dedicated server; or 

 a desktop PC; or 

https://www.virtualbox.org/wiki/Download_Old_Builds_6_1
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 if it is a laptop, the firewall rule for exposing the HTTP ports must be specific to the LAN where 
the work is performed; 

• all PCs have reliable4 antivirus systems which are kept up to date; 

• all PCs are subject to a patching schedule for the operating system and any other relevant 
software;  

• all PCs must be used for work purposes only; and 

• ACER Maple is not accessible from outside the LAN. 
  

 

Note that although Mozilla Firefox or Google Chrome internet browser is a requirement, 
an internet connection is NOT REQUIRED. In the case of PCs involved in data management 
operations, an internet connection is NOT RECOMMENDED for security reasons. 

 

2.3 PC Setup 

Before downloading ACER Maple, check that the system requirements are met on all PCs intended for 
the use of ACER Maple (see sections 2.2.2 and 2.2.3 for details). Once this has been confirmed, follow 
the instructions in this section to set up each of the PCs for ACER Maple. 

2.3.1 Download and install VirtualBox software on a host PC 
  

 
Before you start download check that you have: 

• enough space on your PC (see section 2.2); 

• good internet connection; and 

• administrative rights to download software. 

You may need to clean up space and/or ask your IT department to download VirtualBox 
software on a host PC, if one of the above is not met 

 

 

 

 
4 Some antivirus systems interfere with ACER Maple functionality (e.g. Kaspersky). If you find that your antivirus systems 
prevent you from using ACER Maple or corrupt the software, you will need to switch to another antivirus system. 
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To download Oracle VM VirtualBox software and install it on the host PC: 

1. Navigate to the website https://www.virtualbox.org/wiki/Download_Old_Builds_6_1 in your 
internet browser (Figure 2). 

 
Figure 2: VirtualBox website landing page 

2. Click the Download VirtualBox 6.1 button in the middle of the page (see Figure 2). You will be 
taken to the Downloads page. 

 
Figure 3: VirtualBox website Downloads page 

3. Click on the Windows hosts option under VirtualBox … platform packages (Figure 3).  

4. You will be prompted to download the software installer. Save it in an appropriate location then 
run it. The VirtualBox setup wizard will open (Figure 4). Click Next to start the setup process. 

https://www.virtualbox.org/wiki/Download_Old_Builds_6_1
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Figure 4: VirtualBox setup wizard screen 1 

5. On the next two screens that appear, click Next and Next without changing any options 
(Figure 5). 

 
Figure 5: VirtualBox setup wizard screens 2 and 3 

6. The next screen will display a warning that installing the VirtualBox Networking feature will reset 
your network connection and temporarily disconnect you from the network. Click Yes to proceed 
(Figure 6). 

6.1.42 
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Figure 6: Networking feature warning 

7. Click Install on the Ready to Install screen that appears. (Figure 7) 

 
Figure 7: VirtualBox setup wizard screen 5 

8. Once the installation is complete, click ‘Finish’ (Figure 8). 
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Figure 8: VirtualBox setup complete 

2.3.2 Defining your default browser 

Preferably Mozilla Firefox should be used for ACER Maple5. 

To set Mozilla Firefox as your default browser: 

1. Open Mozilla Firefox. 

2. In the top right corner of the screen click . 

3. Click Options in the middle of the list. 

4. In the General > Startup section click Make default. 

2.3.3 Disabling browser default download location6 

To disable the default download location in Mozilla Firefox: 

1. Open Mozilla Firefox. 

2. In the top right corner of the screen click . 
 

 

 
5 If you use Google Chrome as your default browser: 

1. Open Google Chrome. 

2. In the top right corner of the screen click . 

3. Click Settings near the bottom of the list. 

4. Scroll down to Default browser. 

5. Click Make default. 
Then in Settings: 

6. 6 Scroll down to the bottom and click Advanced. 

7. Scroll down to the Downloads section. 

8. Click Ask where to save each file before downloading. 
 

6.1.42 
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3. Click Options in the middle of the list. 

4. Scroll down to the Files and Applications > Downloads section. 

5. Select Always ask you where to save files. 

2.3.4 Checking display and resolution 

1. In the Windows taskbar click Start ( ). 

2. Click Settings ( ). 

3. Click System. 

4. On the Display page, in the Scale and layout section ensure that:  

 the “…(Recommended)” options are selected under the Change size of text, apps and other 
items drop-down list; and  

 the Display resolution drop-down list. Repeat this step for all monitors that are connected to 
your PC by selecting the corresponding numbered display listed at the top of the screen. 

2.4 Initial data readiness 

At the beginning of the sampling process, sampling tasks containing country-specific sampling information 
are agreed between your NC and ACER and uploaded onto ACER Teams. This process is finalised by 
agreement of the School Tracking Form. Excerpt from the School Tracking Form is imported into ACER 
Maple as a List of Sampled Schools (LSS). LSS will be uploaded for you to check into the following MS 
Teams folder: 

MS◦teams>AMPL Partner Collaboration >Country Folder>0.3 Sampling. 

Please check the data in the LSS carefully before any data is imported into ACER Maple. After 
checking the LSS (see section 2.4.1 for details): 

• If you think that minor changes to the School Tracking Form are still required, the LSS can be re-
negotiated by send an e-mail to Clare Ozolins at Clare.Ozolins@acer.org. 

• Otherwise send e-mail to Clare Ozolins at Clare.Ozolins@acer.org and Alla Routitsky 
Alla.Routitsky@acer.org with the subject line: AMPL <CNT> LSS agreed, where CNT is you country 
3-letter code. 

At the same time, your Questionnaire Adaptation Spreadsheet (QAS) must be agreed with ACER. Excerpt 
from the QAS is imported into ACER Maple as a Questionnaire Structural Adaptations (QSA). SS will be 
uploaded for you to check into the following MS Teams folder: 

MS◦teams>AMPL Partner Collaboration >Country Folder>0.5 Questionnaire. 

Please check the data in the QSA carefully before any data is imported into ACER Maple. After 
checking the QSA (see section 2.4.2 for details): 

 If you think that minor changes to the QSA are still required, the QAS can be re-negotiated by 
sending an e-mail to Jennifer Hong at Jennifer.Hong@acer.org. 

 Otherwise send e-mail to Jennifer Hong at Jennifer.Hong@acer.org and Alla Routitsky 
Alla.Routitsky@acer.org with the subject line: AMPL <CNT> QSA agreed, where CNT is you 
country 3-letter code 

The data from LSS and QSA are imported into ACER Maple by the ACER data management team before 
a customised national version of ACER Maple for your NC is uploaded to ACER Teams. 

mailto:Clare.Ozolins@acer.org
mailto:Clare.Ozolins@acer.org
mailto:Alla.Routitsky@acer.org
mailto:Jennifer.Hong@acer.org
mailto:Jennifer.Hong@acer.org
mailto:Alla.Routitsky@acer.org
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ACER Maple cannot be customised and despatched to the NC until the School Tracking 
Form and QAS are agreed between your NC and ACER 

 
  

 

If the School Tracking form or QAS are re-negotiated after LSS and QSA have been 
imported into ACER Maple the re-negotiated file must be re-imported into ACER Maple by 
ACER.  

Try to avoid this situation by carefully checking the LSS and QSA files beforehand. 

 
  

 

If the School Tracking form is re-negotiated after LSS and QSA have been imported into 
ACER Maple please let Alla Routitsky at Alla.Routitsky@acer.org (cc to Maple Helpdesk 
maplehelpdesk@acer.org and Clare Ozolins Clare.Ozolins@acer.org) immediately. 

 
  

 

If the QAS are re-negotiated after LSS and QSA have been imported into ACER Maple 
please let Alla Routitsky at Alla.Routitsky@acer.org (cc to Maple Helpdesk 
maplehelpdesk@acer.org and Jennifer.Hong@acer.org.) immediately. 

 
  

 

If you have received and downloaded ACER Maple before realising the LSS or QSA needs to 
be changed:  

• wait for ACER to notify you that an updated version of the database can be 
downloaded; 

• download, and replace database as explained in -[##]-. 

 

2.4.1 Understanding the LSS and checking it against School Tracking Form 

Survey ID is a within-school sampling variable that distinguish the AMPL survey from other surveys 
using ACER Maple. It does not appear in the School Tracking Form.  

Survey ID=033 for the AMPL. 

CNT is your NC 3-letter code. Check that it corresponds to your country as indicated in Table 2. 

Entity 6-digit code, Class option and Combined option. Different NCs selected different combinations 
of test design, grade level to be assessed, number of students to be sampled, and (TCS) from each class 
(see Table 2):  

• Each NC must export and check as many LSS files as they are assigned entities (see Table 2). For 
most NCs this is one file. 

• Each Entity ID is a 6-digit number based on the countries 3-digit ISO code. 

• Class option is ‘2’ for all known entities. 

• Each Combined option is based on test designs selected and TCS. It is equals to your country 
standard ISO code unless otherwise agreed upon. 

mailto:Alla.Routitsky@acer.org
mailto:maplehelpdesk@acer.org
mailto:Clare.Ozolins@acer.org
mailto:Alla.Routitsky@acer.org
mailto:maplehelpdesk@acer.org
mailto:Jennifer.Hong@acer.org
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Table 2: LSS codes with respect to national options 

Country LSS variables National options 

 CNT Entity 6-digit code Class option Combined option Grade Test design TCS 

Kenya KEN 040400 2 404 6 ab 25 

Lesotho LSO 042600 2 426 7 ab 22 

The Gambia GMB 027000 2 270 3 a  

Zambia ZMB 089400 2 894 4,7 a & ab 20 

India QIN To be advised To be advised 

Fictitious 
country 

ZZA 098100 2 220 4,6 a & ab 20 

 

Check that Entity ID and corresponding Class option and Combined option match the national options 
you selected. 

Number of schools in the LSS, their identification, and their distribution: 

1. Each LSS must contain ALL schools selected for you by ACER.  

2. Check that School names and their National IDs correspond to Stratum ID, and School within 
stratum assigned by ACER sampling team exactly the same way as agreed in the School Tracking 
Form. 

3. Check that Admin ID is assigned to the schools the way you agreed with ACER sampling team and 
that you have as many values as the number of data administrators you intend to use. 

4. Check that the AMPL School No. values are unique. Ensure that you and data administrators 
know which AMPL School No. values assigned to the schools they are responsible for. 

Table 3 contains examples of excerpts from LSS file for ZZA (a fictitious country). 

Any arrangements must be agreed with the ACER sampling team. 
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Table 3: LSS example for ZZA grade 6 

1 
Survey ID CNT Entity 6-digit code Admin ID Stratum ID School within stratum  School Name National ID AMPL School No. Class 

option 
Combined 
Option 

2 033 ZZA 098100 01 01 0001 School 123 ZZA123 1 2 220 

3 033 ZZA 098100 01 01 0002 School 124 ZZA124 2 2 220 

4 033 ZZA 098100 01 01 0003 School 125 ZZA125 3 2 220 

5 033 ZZA 098100 01 01 0004 School 126 ZZA126 4 2 220 

6 033 ZZA 098100 01 01 0005 School 127 ZZA127 5 2 220 

7 033 ZZA 098100 02 02 0001 School 128 ZZA128 6 2 220 

8 033 ZZA 098100 02 02 0002 School 129 ZZA129 7 2 220 

9 033 ZZA 098100 02 02 0003 School 130 ZZA130 8 2 220 

10 033 ZZA 098100 02 02 0004 School 131 ZZA131 9 2 220 

11 033 ZZA 098100 02 02 0005 School 132 ZZA132 10 2 220 
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2.4.2 Comparing the QSA to the agreed national versions of the questionnaires. 

All questionnaires require cultural and linguistic adaptations. However, some questions may require 
structural adaptations, meaning that the number of response categories and the meaning of these 
categories may change. These adaptations will be extracted by ACER questionnaire team into the 
Questionnaire Structural Adaptation (QSA) form and imported into ACER Maple to enable data entry 
as specified in the adaptations. 

The questions that may require structural adaptations in the Student Questionnaire are: 

ST03: What is the main language that you speak at home? 

ST06: What is the highest level of formal education completed by your mother or female guardian?  

ST08: What is the highest level of formal education completed by your father or male guardian?  

The questions that may require structural adaptations in the School Questionnaire are: 

SC04: What is the highest level of education you have completed? 

SC08: What is the primary language of instruction at your school? 

Check in the QSA that: 

• the response categories listed in the National category label column correspond to the 
categories in your agreed national versions of the questionnaires as indicated in Table 4; and 

• in addition to questionnaire response categories check that QSA data contain auxiliary values for 
each question type. Auxiliary values foe QSA items are listed and their usage is explained in 
Table 5. 

Table 4: QSA Question type ID for questionnaire items 

Question type ID Questionnaire items 

1 ST03 

2 ST06 and ST08 

3 SC04 

4 SC08 
 

Table 5: Auxiliary values added to the questionnaire items in the QSA 

International category 
label 

Data entry 
code 

Usage 

N/A 97 Item has not been printed properly 

Invalid 98 More than one response is provided where only one is required 

Missing 99 Response is not provided 

 

Example of QSA for ZZA grade 6 (fictitious country) is provided in Table 6. The columns that require 
checking are highlighted in blue.  

For example, ZZA data manager need to check that in their Student Questionnaire, question about 
language spoken at home (Question type ID=1), has response categories as follows: 01-English; 02- 
Kiswahili, 03-Other languages. In addition, he/she needs to check, that Auxiliary codes 97,98,99 are 
present in QSA for this question type. Similarly, every question listed above must be checked. 
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Table 6: QSA Example (ZZA, grade 6) 

1 

Survey 
ID 

Entity 6-
digit code 

Question 
type ID 

Question type 
label 

International 
category label 

Data entry 
code National category label National category label (eng) 

International 
code 

2 
033 098160 1 

Language spoken 
at home 

Language of 
assessment 01 English English eng 

3 033 098160 1 -//- Language 2 02 Kiswahili Swahili swh 

4 033 098160 1 -//- Other languages 03 Other languages Other languages qot 

5 033 098160 1 -//- N/A 97   qna 

6 033 098160 1 -//- Invalid 98   qin 

7 033 098160 1 -//- Missing 99   qms 

8 
033 098160 2 Parent education 

ISCED level 6 or 
higher 01 

Completed undergraduate or 
higher 

Completed undergraduate or 
higher 

600 

9 

033 098160 2 -//- ISCED level 4 or 5 02 

Completed middle level college 
(e.g. technical course, diploma 
course, certificate course) 

Completed middle level college 
(e.g. technical course, diploma 
course, certificate course) 400 

10 033 098160 2 -//- ISCED level 3 03 Completed secondary school Completed secondary school 398 

11 033 098160 2 -//- ISCED level 1 04 Completed primary school Completed primary school 100 

12 
033 098160 2 -//- 

Did not complete 
ISCED level 1 05 Did not complete primary school Did not complete primary school 099 

13 033 098160 2 -//- N/A 97   997 

14 033 098160 2 -//- Invalid 98   998 

15 033 098160 2 -//- Missing 99   999 

16 

033 098160 3 
Principal 
education ISCED level 7 or 8 01 

Completed higher degree (e.g. 
Master’s degree, Post graduate 
degree) 

Completed higher degree (e.g. 
Master’s degree, Post graduate 
degree) 700 

17 
033 098160 3 -//- ISCED level 6 02 

Completed university level (e.g. 
Bachelor's degree) 

Completed university level (e.g. 
Bachelor's degree) 

600 

18 

033 098160 3 -//- ISCED level 4 or 5 03 

Completed middle level college 
(e.g. technical course, diploma 
course, certificate course) 

Completed middle level college 
(e.g. technical course, diploma 
course, certificate course) 400 

19 033 098160 3 -//- ISCED level 3 04 Completed secondary school  Completed secondary school  398 
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1 

Survey 
ID 

Entity 6-
digit code 

Question 
type ID 

Question type 
label 

International 
category label 

Data entry 
code National category label National category label (eng) 

International 
code 

20 
033 098160 3 -//- 

ISCED level 2 or 
below 05 

Did not complete secondary 
school 

Did not complete secondary 
school 

200 

21 033 098160 3 -//- N/A 97   997 

22 033 098160 3 -//- Invalid 98   998 

23 033 098160 3 -//- Missing 99   999 

24 
033 098160 4 

Language of 
instruction 

Language of 
assessment 01 English English eng 

25 033 098160 4 -//- Language 2 02 Kiswahili Swahili swh 

26 033 098160 4 -//- Other languages 03 Other languages Other languages qot 

27 033 098160 4 -//- N/A 97   qna 

28 033 098160 4 -//- Invalid 98   qin 

29 033 098160 4 -//- Missing 99   qms 
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2.5 ACER Maple despatch 

The ACER Maple software for the AMPL, can be downloaded from the following MS Teams folder: 

MS Teams>AMPL Partner Collaboration > Data Management Resources.  

It contains: 

• Six files that must be:  

 downloaded separately into convenient location on the C-drive of the host PC;  

 zipped files unzipped after they are downloaded; 

 software installed as instructed in section 2.6 

The software is first used for training. After all documentation required for customisation of ACER 
Maple to your NC requirements are agreed with ACER you will receive your national database that 
should be used to update data in the previously installed ACER Maple as explained in section 2.8. 

2.6 ACER Maple installation 

  

 

Policies and procedures for the purpose of supporting local security and privacy legislation 
for individual ACER Maple deployments are outside the scope of this document. 

To install ACER Maple: 

1. Check that you are ready to use ACER Maple (section 2.6.1). 

2. Decide on the mode of deployment (section 2.6.2). 

3. Download all files from MS Teams>AMPL Partner Collaboration > Data Management Resources 
one at a time. 

4. Set up ACER Maple in the VM deployment configuration (section 2.6.3). 

2.6.1 Initial checks before installation of ACER Maple 

Before downloading ACER Maple, ensure that the system requirements and PC setup tasks described 
in sections 2.2– 2.3 have been completed on all PCs to be used for ACER Maple. 
  

 

You will not be able to use ACER Maple if the system requirements are not met. 

ACER will notify your NC by email when your customised national version of data for ACER Maple is 
ready and has been uploaded to MS Teams>AMPL Partner Collaboration >Country Folder>Data 
management (Maple). This email will also contain instructions for downloading ACER Maple from this 
site. Check with your NPM when this is scheduled. 
  

 

ACER Maple cannot be customised until the data from LSS and QSA have been agreed and 
uploaded into ACER Maple by ACER (see section 2.4 for details). 
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Note to the India NC: In addition to the above, ACER Maple cannot be customised until 
Hindi assessment instruments are: 

1. prepared for printing (but not printed); 

2. sent for final optical check to ACER; 

3. agreed upon. 

Hindi assessment instruments must be sent for final optical check at least two month 
before the start of the assessment and should not be printed untile final optical check is 
agreed upon. 

 

2.6.2 Different modes of ACER Maple VM deployment 

ACER Maple VM can be deployed either: 

• for a single user for the purposes of accessing the system and data solely on one workstation. 
No other users or workstations are connected to the local area network (LAN) and the 
workstation is not connected to the internet while ACER Maple is running; or 

• for multiple LAN users for the purposes of accessing the system using their workstations. One 
of the workstations will host the ACER Maple VM; or 

• on a dedicated server which hosts the ACER Maple VM, which can be accessed from a single 
or multiple PCs within the same LAN. 

In each of these settings, the ACER Maple VM is installed on a single host PC/server (laptop or desktop). 
A user (or users) within the same LAN can then connect to the ACER Maple VM using an internet 
browser. In this way, multiple users can access ACER Maple (at the same time, if necessary) to perform 
all required data management tasks, without needing the ACER Maple VM to be installed on every PC. 
ACER Maple can also be accessed by a user directly on the host PC. Network security and firewall rules 
should allow other PCs within the LAN to connect to the ACER Maple host PC. 

A NC can have as many data administrators for each entity as there are values in the Admin ID column 
in the agreed LSS for this entity. 
  

 

If Admin ID is ‘01’ for all schools in the LSS , contact Clare Ozolins at Clare.Ozolins@acer.org. 
Your LSS should then be re-negotiated and re-uploaded into ACER Maple by ACER to 
accommodate the number of data administrators you are employing. 

2.6.3 Installation instructions 

To install ACER Maple on a virtual machine: 

1. Create a directory on the host PC named C:\MapleFiles. This will be a shared folder accessible by 
both the host PC and the VM. 

2. Download the VM image shared by ACER (through MS Teams>AMPL Partner Collaboration>Data 
Management Resources) to a convenient location. It may take a while to download depending on 
your internet connection. 

  

 

The VM image is a large file of around 5GB. After the image is unpacked by VirtualBox it 
will require around 20GB of storage space and 2GB of RAM allocated to the ACER Maple 
VM on the host PC. 

mailto:Clare.Ozolins@acer.org
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3. Open Oracle VM VirtualBox software if it is not already open, either through the Start ( ) 
menu or the icon on desktop (Figure 9). 

 
Figure 9: VirtualBox desktop icon 

4. Click on File > Import Appliance, or the Import button (Figure 10).  

 
Figure 10: The Oracle VM VirtualBox Manager screen  

5. Another window will appear asking you to choose the appliance to import (Figure 11). Under 
Source select Local File System. 

6. Under File manually enter or navigate (using the  button) to the location where the VM image 
shared by ACER was saved in step 2. 

 
Figure 11: Select appliance to import screen 

7. Click Next. A screen will appear specifying the appliance settings (Figure 12). 
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Figure 12: Appliance settings screen 

8. In the Machine Base Folder field, specify an appropriate location for the VM base folder where 
the VM resides on the host PC (see Figure 12). Note it must be a different location to the 
C:\MapleFiles folder created in step 1. The folder will be created automatically if it does not 
already exist. 

9. Click Import.  

• The ACERMapleVBox VM will be imported into the Oracle VM VirtualBox Manager environment 
(it may take a few minutes depending on your PC).  

• Note that an error will occur if the C:\MapleFiles directory was NOT created in step 1 (page 30). 
If this occurs, you will need to: 

 click OK to dismiss the error message(Figure 13);  

 
Figure 13: ACERMapleVBox VM import error 
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 create the missing directory, and  

 delete anything in the VM base folder (i.e. C:\temp\VMs) before attempting to import the VM 
image again.  

10. Once the import process is completed, the name of the ACERMapleVbox will appear in the list of 
available virtual machines (Figure 14). 

 

 
Figure 14: ACERMapleVBox VM loaded in VirtualBox 

11. Click on the ACERMapleVBox machine on the left-hand side of the screen to select it and click 
Start (see Figure 14).  

12. If initiating the ACERMapleVBox machine for the first time it will likely display an error message 
saying that the network adapter settings need to be changed (Figure 14) 

 
Figure 15: Network adapter settings error message 

13. Click Change Network Settings (see Figure 15) to open the network settings screen (Figure 16). 
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Figure 16: ACERMapleVBox VM network settings screen 

14. Make sure that “Bridged Adapter” is selected (see Figure 16) then click OK. 

15. Once the network adapter is configured properly a new window will appear displaying the Oracle 
VM VirtualBox loading screen followed by the Ubuntu loading screen (Figure 17). 

 
Figure 17: Oracle VM VirtualBox and Ubuntu loading screens 

16. Once the VM has finished loading the ACERMapleVBox VM login screen will appear (Figure 18). 
The ACERMapleVBox VM is running successfully. Dismiss any messages that appear at the top of 
the screen7. 

 

 

 
7 If instead of UBUNTU screen  a pop-up errors message appears saying “Not in a hypervisor partition”, see section A2.1, 
Appendix 1 for instructions. 
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Figure 18: ACERMapleVBox VM login screen 

  

 

The ACERMapleVBox VM login screen can be minimised but must remain open while ACER 
Maple is in use. Closing this window will shut down ACER Maple and all unsaved work 
will be lost. 

 

17. The VM will be registered within your Local Area Network (LAN) in accordance with LAN policies, 
and it will obtain a local IP address. This IP will need to be used by all users to connect to the host 
PC. 

18. Run the start_MAPLE.bat that was provided with the ACER Maple installation package (see 
section 2.5). This will automatically obtain the IP address of the VM and open it in your default 
browser. 

19. The first time a user connects to the IP address of the VM, a warning about the connection not 
being private (Figure 19) is displayed8. To dismiss the security certificate warning click Advanced. 

 

 

 
8 The security warning is displayed because the ACER Maple VM is configured with a self-signed security certificate supplied 
by ACER. It is possible to replace the self-signed certificate supplied by ACER with your organisation’s security certificate. 
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Figure 19: VM security certificate warning 

20. Click Proceed on the Advanced screen (see Figure 20). 

 
Figure 20: VM security certificate warning advanced 
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21. The ACER Maple Login screen will be displayed (Figure 21). 
 

 
Figure 21: ACER Maple Login screen 

2.7 Access, exit and back-up 

2.7.1 Starting ACER Maple VM on the host PC 

To start up the ACER Maple VM on the host PC: 

1. Open Oracle VM VirtualBox software if it is not already open, either through the Start ( ) 
menu or the icon on desktop (Figure 22). 

 
Figure 22: VirtualBox desktop icon 

2. Click on the ACERMapleVBox machine on the left-hand side of the screen to select it and click 
Start (Figure 23). 
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Figure 23: ACERMapleVBox VM loaded in VirtualBox 

3. Once the VM has finished loading the ACERMapleVBox VM login screen will appear (Figure 24). 
The ACERMapleVBox VM is running successfully. Dismiss any messages that appear at the top of 
the screen. 

 
Figure 24: ACERMapleVBox VM login window 

  

 

The ACERMapleVBox VM login screen can be minimised but must remain open while ACER 
Maple is in use. Closing this window will shut down ACER Maple and all unsaved work 
will be lost. 
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4. Double click on the start_MAPLE.bat file that was provided with the ACER Maple installation 
package. 

  

 

The VM will be registered within your Local Area Network (LAN) in accordance with LAN 
policies. It will obtain a local IP address. This IP address will need to be used by all users 
to connect to the host PC 

 

5. Disregard the warning by clicking Advanced (Figure 25), then click Proceed to.. 

 

 

Figure 25: Obtaining IP address 
  

 

The numeric value in Figure 25 is an example. The value displayed on your machine can be 
different and can change over time if LAN configuration had been changed (e.g. more PCs 
are added) 

 

6. You can now access ACER Maple Login window on the host PC as well as on any other PC within 
the local area network 

2.7.2 Accessing ACER Maple Login window 

To access ACER Maple Login screen when the ACER Maple webpage is closed: 

1. Ensure that the ACERMapleVBox VM login window UBUNTU (Figure 24) is open on the host PC. 

2. Enter the IP address of the VM (from step Error! Reference source not found. on page Error! 
Bookmark not defined.) in the address bar of a new Mozilla Firefox browser. The ACER Maple 
Login screen will appear (Figure 26). 

This can be done either on the host PC or any other PC within the same LAN as the host PC.  
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Figure 26: The ACER Maple Login screen 

To access ACER Maple session when the ACER Maple webpage is greyed out indicating that session 
has been timed out: 

1. Ensure that the ACERMapleVBox VM login window UBUNTU (Figure 24) is open on the host PC. 

2. Refresh the browser (see section 2.10.4, page 53 for details). 

2.7.3 Information section on the left-hand side of the Login screen 

The information section on the left-hand side of the login screen (Figure 26) contains three important 
messages related to ACER Maple access from any PC on the same LAN as the host PC: 

IP address of host: <IP>.This is the IP address of the ACER Maple VM. Data managers must make it 
available to data administrators. 
  

 

The numeric value in Figure 26 is an example. The value displayed on your machine can be 
different and can change over time if LAN configuration had been changed (e.g. more PCs 
are added) 

 

You are currently connected to ACER Maple over LAN. This message is displayed on all PCs accessing 
the ACER Maple VM, including the PC hosting the VM, even if the host PC is a stand-alone PC. 

To access this application… This message repeats the IP address of the host PC within the LAN with 
instructions on how to access ACER Maple from any PC within the LAN.  

2.7.4 Closing a connection to an active ACER Maple session and creating a back-
up 

To close a connection to an active ACER Maple session: 

1. Click the Quit button at the top right of the page. A message will appear asking if you are sure 
you want to quit. 

2. Click Confirm. A second message will appear asking if you want to create a database backup 
(Figure 27). 
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Figure 27 Quit confirmation prompt 

3. Click Yes (Error! Reference source not found.). The background of the page used to quit the s
ession will become grey.  

 
Figure 28 Database backup prompt 

  

 

It is recommended that backups are created from every PC at least 
twice a day. For example, when a user takes a lunch break and at the 
end of the working day. 

Please note that these backups are created within the VM 
infrastructure on the host PC and overwrites the previous updates.  

It is recommended as an important risk management procedure that, 
while ACER Maple is being actively used, database backups are 
exported from the ACER Maple VM to the local hard drive of the host 
PC at least twice a day (see section 2.7.7, page 43 for details). 

 

2.7.5 Closing ACER Maple interface on a host PC and creating a back-up 

To close ACER Maple interface on a host PC: 

4. Click the Quit button at the top right of the ACER Maple screen. A message will appear asking if 
you are sure you want to quit (Figure 30). 

 
Figure 29 Quit confirmation prompt 

5. Click Confirm. A second message will appear asking if you want to create a database backup 
(Error! Reference source not found.). 

 
Figure 30 Database backup prompt 
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6. Click Yes. The background of the ACER Maple screen will become grey.  

7. Export current database backup as explained in section 2.7.7 on page 43.  
  

 
It is recommended as an important risk management procedure that, while ACER Maple is 
being actively used, database backups are exported from the ACER Maple VM to the local 
hard dive of the host PC at least twice a day (see section 2.7.7, page 43 for details). 

 
  

 

DO NOT SHUT DOWN ACER Maple VM (UBUNTU) UNLESS ALL USERS connected to the 
ACER Maple interface HAVE LOGGED OUT. 

 

 

2.7.6 Closing ACERMapleVM (UBUNTU) on a host PC 

The ACERMapleVM can be shut down ONLY IF ALL USERS CONNECTED TO THE ACER MAPLE DATABASE 
HAVE LOGGED OUT. 
  

 

Before powering off the ACER Maple VM, make sure that all users connected to the ACER 
Maple interface have logged out. Powering down the VM without logging out all users can 
corrupt the ACER Maple database which may result in significant data loss. 

 

After you made sure that all users connected to the ACER Maple interface have logged out, the ACER 
Maple VM can be shut down as follows: 

1.  Close the ACER MapleVBox VM login window (Figure 24, page 38), then 

2.  Select Power off the machine on the Close Virtual Machine window (Figure 31).  

 
Figure 31: Close Virtual Machine window 
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2.7.7 Exporting ACER Maple database backup for archiving/storage 
  

 
The following procedure is recommended to be performed at least twice a day as an 
important part of risk management. The exact timing of when the database backups 
should be exported will depend on your working environment and personal preferences 
and/or organisational practices 

 

To export ACER Maple database backup to the host computer for archiving/storage: 

1. Generate a backup from within the ACER Maple software interface by following the instructions 
in section 2.7.5 on page 41. 

2. Navigate to the C:\MapleFiles directory that was created when the VM was installed ( section 
2.6.3 step 1 on page 30) and manually create a new folder called ‘backup’ (Figure 32). 

 
Figure 32: User-created “backup” folder in C:\MapleFiles directory 

3. Within 5 minutes the directory will be automatically renamed to “backup_<date>_<time>” 
(Figure 33).  

 
Figure 33: System-created “backup_<date>_<time>” folder in C:\MapleFiles directory 

If the folder doesn’t automatically rename within 10 minutes please contact ACER Helpdesk at 
maplehelpdesk@acer.org. 

4. Open the renamed folder.  

• If the database had been backed up the day it is exported, then inside the renamed folder there 
should be a password-protected zip file named db_backup_<date>.zip (Figure 34).  

 
Figure 34: Password-protected zip file containing database backup 

mailto:maplehelpdesk@acer.org
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• If there is no database backup in the ACER Maple VM for the current day, the zip file 
exported to the “backup_<date>_<time>” folder will be called NoTodaysBackupFound.zip 
(Figure 35).

 
Figure 35: NoTodaysBackupFound.zip file 

• If this is the case repeat steps 1 - 4 of this instruction. 

5. Open the db_backup_<date>.zip file:  

 If it contains a folder named ‘shiny’ (Figure 36), go to the next step.  

 
Figure 36: Contents of db_backup zip file 

 If the ‘shiny’ folder is not in the zip file, repeat steps 1 - 5 of this instruction 

6. Once the db_backup_<date>.zip file has been successfully created, the “backup_<date>_<time>” 
folder can be moved or copied to an alternative location (e.g. USB or HD that is physically 
secured against unauthorised access). 

  

 

Please note that if an error does occur with the ACER Maple software, any data that has 
not been backed up may be permanently lost. 

 

2.8 Updating ACER Maple data 

Sometimes ACER Maple data have to be updated either with the data that had been backed up by the 
NC or with the data sent to your NC by the ACER data management team. 

• If the current data is updated with the data sent to you by ACER: 
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1. Open Oracle VM VirtualBox software if it is not already open, either through the Start ( ) 
menu or the icon on desktop.  

2. Click the start button.  

3. Copy Maple_update.zip from the MS Teams>AMPL Partner Collaboration >Country 
Folder>Data management (Maple) into the C:\MapleFiles folder created when ACER Maple 
had been installed (see 2.6.3) 

4. Within 5 minutes the ACER Maple VM will be updated with the database files with the files 
from the zip file.  

5. If update was successful, the zip file will be renamed automatically to Maple_Update_<Date>-
<Time>.zip 

• If the current data is updated with the data previously backed up: 

1. Open Oracle VM VirtualBox software if it is not already open, either through the Start ( ) 
menu or the icon on desktop. 

2. Click the start button.  

3. Rename a back-up file into Maple_update.zip and copy it into the C:\MapleFiles folder created 
when ACER Maple had been installed (see 2.6.3) 

4. Within 5 minutes the ACER Maple VM will be updated with the database files with the files 
from the zip file.  

5. If update was successful, the zip file will be renamed automatically to Maple_Update_<Date>-
<Time>.zip 

2.9 User Settings 

2.9.1 First login 

Due to the secure nature of the AMPL data, ACER Maple is login protected. In order to login to ACER 
Maple, you need to know your domain (see section 1.2.1), username and login code. 

If you are a data manager, your domain consists of: 

• Survey ID: 033; 

• Entity ID: (Kenya 040400; Lesotho 042600; Zambia 089400; India tba) and 

• Admin ID: 00. 

The data managers’ secure usernames and temporary login codes will be emailed to your NC by ACER 
together with a notification that your customised national version of ACER Maple is ready to be 
downloaded from MS Teams>AMPL Partner Collaboration >Country Folder>Data management 
(Maple). Each NC can have one or more data managers depending on their national options. 

If you are a data administrator, your domain consists of: 

• Survey ID: 033; 

• Entity ID (Kenya 040400; Lesotho 042600; Zambia 089400; India tba); and 

• Admin ID: 2-digit number assigned to you by your data manager. 

The data administrator’s secure username and login code will be provided by the data manager after 
he/she has created data administrator login details as described in section 2.9.3. 
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To login for the first time: 

1. Open ACER Maple by pasting the IP address of the host PC into the address bar of an internet 
browser (only Mozilla Firefox or Google Chrome). The Login screen will appear (Figure 37). 

 
Figure 37: First time login function on the ACER Maple Login screen 

2. On the left-hand side of the Login screen under ‘Help’, click First time login. The Password 
Creation screen will appear (Figure 38). 

 
Figure 38: Password Creation screen 

3. Enter your Survey ID (033), Entity ID (6 digits) and Admin ID (2 digits). 

4. Enter your secure username and the login code. 

5. Create your password. The password must be at least 11 characters long and contain: 

 at least one upper-case letter; 

 at least one lower-case letter; 
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 at least one number; and  

 at least one punctuation character (e.g., !, @, #, $, %). 

6. Enter the password again. 

7. Click Create Password. 

8. Click Back to return to the Login screen (Figure 37). 

9. On the top right-hand side of the Login screen, Enter your Survey ID (033), Entity ID (6 digits) and 
Admin ID (2 digits). 

10. Enter your username and your new password.  

11. Click Login. The ACER Maple Main screen will appear (Figure 39). 

 
Figure 39: ACER Maple Main screen 

2.9.2 Changing your password (all users) 

To change your own password: 

1. On the Main screen select User settings > Change your password and then click Activate. The 
Change your password screen will appear (Figure 40). 

 
Figure 40: Change your password screen 

2. Enter your current password. 

3. Enter your new password. The password must be at least 11 characters long and contain: 

 at least upper-case letter; 

 at least one lower-case letter; 

 at least one number; and  

 at least one punctuation character (e.g., !, @, #, $, %). 
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4. Enter your new password again. 

5. Click Confirm (in the bottom right corner of the screen). A message confirming the update will 
appear.  

6. Click Dismiss. 

2.9.3 Creating and deleting data administrator logins 
  

 

The data manager must create exactly as many data administrator logins as there are 
Admin ID values in the LSS. 

Creating new data administrator logins 

To create new data administrator logins: 

1. On the Login screen enter your domain: Survey ID (033), Entity ID (6 digits) and Admin ID (00). 

2. On the Main screen select User settings > Manage administrators and then click Activate. The 
Manage data administrators screen will appear (Figure 41). 

 
Figure 41: Manage data administrators screen 

3. Ensure that ‘Create’ is selected on the left-hand side of the screen. 

4. In the ‘Number of new users’ field, select the number of new administrator logins you wish to 
create. The ‘New administrators’ table on the right is automatically updated with the required 
number of rows (Figure 42). 

 
Figure 42: Number of new users selected 
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5. In the ‘New administrators’ table, enter the User name and User affiliation for each new 
administrator login (Figure 43). 

 
Figure 43: New administrators’ table 

  

 

Each Admin ID must be assigned a unique ‘User name’. 

6. Click Save in the right bottom corner of the screen. A message confirming the creation of the 
new data administrators will appear. 

7. Click Confirm. Another confirmation message will appear. 

8. Click Dismiss. In the Existing administrators table, a row will appear for each new data 
administrator that has been created (Figure 44).  

The ‘First time login code (internal)’ column contains automatically generated first time login 
codes that each administrator will need the first time they log in to ACER Maple (section 2.9.1). 

 
Figure 44: Newly created data administrator logins in the Existing administrators table 

9. Click the  button under the Existing administrators table and save an Excel 
file in the location designated for data administrator training. You will need to provide each data 
administrator with their usernames and first-time login codes at the time of data administrator 
training (see more details about training in Chapter 4). 

Deleting data administrator logins 

To delete data administrator logins: 

1. On the Login screen enter your domain: Survey ID (033), Entity ID (6 digits) and Admin ID (00). 

2. On the Main screen select User settings > Manage administrators and then click Activate. The 
Manage data administrators screen will appear. 

3. Ensure that ‘Delete’ is selected on the left-hand side of the screen (Figure 45). 

4. In the Existing administrators table a new ‘Delete’ column will appear. Check the box beside any 
data administrator to be deleted. 
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Figure 45: Deleting data administrator logins in the Manage data administrators’ screen 

5. Click Save. A message confirming the deletion of the selected data administrator logins will 
appear. 

6. Click Confirm. A confirmation message will appear. 

7. Click Dismiss. 

2.10 Navigation and functions of ACER Maple 

2.10.1 The ACER Maple Main screen 

At the top of the Main screen of ACER Maple (Figure 46), next to the ACER Maple logo, is the ACER 
Maple version number. 
  

 

The version number on the Main screen must be the same as in the despatch email or 
higher.  

If the version number on the Main screen is lower than in the despatch email: 

• Make sure that you have downloaded the latest despatch from the dedicated website.  

• If the latest despatch contains a version lower than indicated in the despatch email, 
contact ACER Helpdesk at maplehelpdesk@acer.org, specifying your 3-letter country 
code and subject (Despatch version) in the subject line of the e-mail. 

 

Also, at the top of the Main screen, on the right-hand side, there are two buttons: Logout and Quit. 

• The Logout button allows a user to log out from ACER Maple without shutting down the 
application. 

• The Quit button shuts down the application. 

Listed directly beneath the ACER logo is the domain to which the currently logged-in user has access. 
Each AMPL user has access to the following domains depending on their affiliation (e.g. entity) and 
status: 

 Survey: AMPL: 2023: MS 

 Entity: your country 3-letter code and country name; and 

 Admin: 00 for data managers and 01, 02 etc. for data administrators. 

The middle section of the Main screen contains a list of main functions and the section on the right 
lists any options that are available for each of the main functions. Section 2.10.1 lists all of the functions 

mailto:maplehelpdesk@acer.org
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and associated options, and whether a data manager or data administrator login must be used to 
access them.  

After a main function and an option are selected, the Activate button must be clicked to initiate the 
function. 

 
Figure 46: ACER Maple Main screen 

2.10.2 Main functions of ACER Maple 

All of the ACER Maple main functions are accessed from the list of main functions on the Main screen 
(Figure 46). These functions and all related options are listed in Table 7. The last column in this table 
indicates whether a data manager or a data administrator must be logged in to ACER Maple to be able 
to use the listed function. Data administrators can only access a limited selection of main functions 
compared to data managers, and data entry operators can only key in data.  

Any options that are shaded green in Table 7 must be performed using a data administrator login, 
even though these options also appear in the list of main functions available to data managers. 
Similarly, a data entry operator login must be used only for keying in responses (yellow shading in 
Table 7). 

Table 7: ACER Maple functionality in relation to different users 

Main function Options User 

User settings Change your password All users 

Manage administrators Data manager 

Manage data entry operators Data administrator 

Export Initial data Data manager 

Template documentation Data manager 

Field data Data administrator 

List of candidates Data manager and data administrator 

Institution list Data manager 

Remaining warnings Data manager 

Import Field data Data administrator 

Sample and allocate 
instruments 

Sample and allocate Data administrator 

Update tracking data Field operation forms Data administrator 

Institution participation form Data manager 
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Main function Options User 

Response data Export data entry documentation Data manager 

Key in responses Data entry operator 

Upload responses Data administrator 

Validate respondent list Data administrator and data manager 

Export response data Data manager 

Final tasks Explain warnings Data manager 

Submit data Data manager 

Data information 
WIS data Data manager 

Response data Data manager 

2.10.3 Returning to the ACER Maple Main screen (Back button) 

After a main function and an option are selected and Activate is clicked, you will be transferred to the 
corresponding function screen. In the top right corner of any function screen there is a Back button 
which allows you to return to the Main screen (Figure 47), beside the Logout and Quit buttons. 

 
Figure 47: ACER Maple Back, Logout and Quit buttons 

Any time you click Back you will be asked to confirm that you wish to go back to the Main screen and 
warned that any unsaved changes will be lost (Figure 48). 

 
Figure 48: Back confirmation message 

 

Take this warning seriously: 

• if all changes have been saved, click Go to main screen; or 

• if all changes have not been saved, click Cancel and save your changes before returning to the 
Main screen. 

  

 

For navigation between ACER Maple screens only use the buttons within ACER Maple. 

The Go Forward (→) and Go back (←) browser buttons will trigger going to the 
next/previous browser page that was open before you logged in to ACER Maple and 
therefore your connection with ACER Maple will be lost. If there was any unsaved work this 
will also be lost. There will be no message warning about unsaved changes if the browser 
buttons are used. 
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2.10.4 Session timeout 

If you are logged in to ACER Maple but have been inactive for 2 hours or more you will automatically 
be logged out. The browser page will appear greyed out and a message will appear explaining that the 
session has timed out (Figure 49). 

 
Figure 49: Session timeout message 

In this case: 

1. Click the refresh button in your browser ( ) to refresh the page and re-activate ACER Maple;  

2. Login to ACER Maple. 
  

 

Use the refresh button in the browser only if the session has timed out or the Quite button 
has been used. The browser refresh button initiates a new session in ACER Maple. If your 
session was active at the time it will not be ended properly, and any unsaved or unfinished 
work will be lost. 

When you try to login again after refreshing the page, you may see a message warning that 
the user is already logged in. In this case click the ACER Maple Quit button, refresh the page 
again and login again. 
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3 NECESSARY DOCUMENTATION 
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3.3 Codebook and format files for field operation forms ......................................................... 58 

3.3.1 Exporting template codebook and format files ................................................................. 58 
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3.4 Keeping track of school participation ................................................................................. 63 

 

3.1 Initial Data 

During the school sampling process sampling tasks containing country-specific sampling information are 
agreed between your NC and ACER and uploaded onto ACER Teams. This process is finalised by agreement 
of the School Tracking Form. Excerpt from the School Tracking Form is imported into ACER Maple as a 
List of Sampled Schools (LSS) (see section 2.4.1 for details).  

At the same time, your Questionnaire Adaptation Spreadsheet (QAS) must be agreed with ACER. Excerpt 
from the QAS is imported into ACER Maple as a Questionnaire Structural Adaptations (QSA) (see section 
2.4.1 for details).  

After LSS and QSA are agreed and before the ACER Maple is despatched to your NC for field operations, 
these files are imported into ACER Maple by the ACER data management team. 

3.1.1 Checking Initial data 

Before using ACER Maple for the rest of your field operations, you need to: 

1.  Export initial data (section 3.1.2) 

2. Compare the exported LSS data to the LSS data agreed during school sampling process and saved 
in MS◦teams>AMPL Partner Collaboration >Country Folder>Sampling. The files must match 
exactly: 

 check these files carefully; 

 make sure that you understand the data in the LSS; and 

 keep the LSS and the agreed School Tracking Form handy during within-school sampling. 
  

 

If the two LSS files does NOT match exactly let Alla Routitsky know immediately 
(Alla.Routitsky@acer.org cc to Maple Helpdesk maplehelpdesk@acer.org). 

 

3. Compare the exported QSA data to the QSA data agreed during questionnaire adaptation process 
and saved in MS◦teams>AMPL Partner Collaboration >Country Folder>Questionnaires. The files 
must match exactly: 

 check these files carefully; 

 make sure you understand the data in the QSA; and 

 keep the QSA handy for data entry. 

mailto:Alla.Routitsky@acer.org
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If the two QSA files does NOT match exactly, let Alla Routitsky know immediatly  
(Alla.Routitsky@acer.org cc to Maple Helpdesk maplehelpdesk@acer.org). 

 

3.1.2 Exporting initial data 
  

 

The data manager login must be used for the following function.  

To export all initial data from ACER Maple in Excel format: 

1. On the Main screen select Export > Initial data and then click Activate. The Export Initial Data 
screen will appear (Figure 50). 

 
Figure 50: Export Initial Data screen 

2. Click Export. All initial data files will be combined into one zip file which will be available for 
download (Figure 51).  

 
Figure 51: Initial data download pop-up 

3. Select ‘Save File’ and save the zip file in an appropriate location and then unzip it. 
  

 

Keep the initial data files handy. You will need to be familiar with this data throughout the 
data management operations. 

mailto:Alla.Routitsky@acer.org
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3.2 Field operation forms and ACER Maple functions 

The MS Teams>AMPL Partner Collaboration >Data Management Resources> Field Operation Forms 
folder contains the following Excel files: 

• List of Classes (AMPL_LCL) 

• Sampled Class Form (AMPL_SCF) 

• List of Students (AMPL_LST) 

• Student Tracking Form (AMPL_STF) 

• School Questionnaire Tracking Form (AMPL_SQTF) 

• Student Assessment Labelling Form (AMPL_SALF) 

• School Participation Form (AMPL_SPF) 

Locate these forms and familiarise yourself with them prior to the data administrator training. For 
brevity only the second part of the acronym is used in this manual. 

The LCL, SCF, LST, STF, and the SQTF templates are used by data administrators. 

The SALF is filled with data by either data managers or data administrators and then used to label 
assessment materials. 

The SPF is used by data managers to record school participation after the assessment.  

Table 8 contains an overview of the data source(s) for each field operation form. It also explains how 
these forms relate to ACER Maple functions. 
  

 

The LCL and the LST Information worksheet will require linguistic adaptations which are 
explained in the Note to NC. Talk to your NPM if adaptations had not been done. 

 
  

 

Note to the countries, where the word ’class’ is used for grouping of students in the same 
grade level, taught by the same teacher. Make sure that in the Information worksheet of 
the LCL and the LST the adaptations in row 6 are made and the Note to NC is deleted (see 
examples in Table 13 and Table 15). Talk to your NPM if the changes had not been done. 

 
  

 

Note to the countries, where the word ’class’ is NOT used for grouping of students in the 
same grade level, taught by the same teacher. Make sure that in the Information 
worksheet of the LCL and the LST the word ’class’ is explained in row 6 and the Note to NC 
is deleted. Talk to your NPM if the changes had not been done. 
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Table 8: Overview of field operation forms and ACER Maple functions 

Field operation 
form to be used Data source ACER Maple function 

List of Classes 
(LCL) 

Completed List of Classes provided by 
schools. 

Use Import > Field data to import List of 
Classes data either school-by-school or for 
multiple schools simultaneously. 

Sampled Classes 
Form (SCF) 

After class sampling, ACER Maple 
generates data with which this form is 
populated. 

After class sampling, use Export > Field data to 
export sampled class data into the sampled 
class template. 

List of Students 
(LST) 

Completed List of Students provided by 
schools. 

Use Import > Field data to import List of 
Students data either school-by-school or for 
multiple schools simultaneously. 

Student 
Tracking Form 
(STF) 

Before the assessment: 

After student sampling, ACER Maple 
generates student tracking forms 
populated with sampled students’ data. 

Before the assessment: 

After student sampling, use Export > Field 
data to export sampled students’ data into the 
student tracking form template. 

During the assessment: 

TA adds student participation and 
updates student demographic data with 
help from SC. 

After the assessment: 

Use Update tracking data > Field Operation 
Forms to update student participation and 
demographic data. 

School 
Questionnaire 
Tracking Form 
(SQTF) 

Before the assessment: 

ACER Maple populates this form with the 
list of school principals for schools in 
each domain. Completed by the data 
administrator for each domain on 
receipt of materials. 

Use Export> Candidate List to populate the 
template with the data from ACER Maple. 

After the assessment: 

Completed by the data administrator for 
each domain on receipt of materials. 

Use Update tracking data > Field Operation 
Forms to update school questionnaire receipt 
after the assessment. 

Student 
Assessment 
Labelling Form 
(SALF) 

After student sampling and before the 
assessment, ACER Maple generates 
student SALF populated with sampled 
students’ data 

Use Export> Candidate List to populate the 
template with the data from ACER Maple. 

School 
Participation 
Form (SPF) 

Before the assessment: 

Exported from ACER Maple by the data 
manager.  

Use Export > Institution list to export list of 
schools eligible to participate. 

After the assessment: 

Completed by the data manager on 
receipt of materials. 

Use Update tracking data > Institution 
participation form to import school 
participation data. 

  

 

The processes of collecting class and student lists from schools and using tracking forms by 
TA and SC are explained in the relevant field operation manuals. Please ask your NPM for an 
adaptad version of the manual required. 
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3.3 Codebook and format files for field operation forms 

3.3.1 Exporting template codebook and format files 

Codebook files describe the internal structure of ACER Maple templates and give information about 
the variables in them. Codebook files are exported in Excel format. 

Format files contain only column headings. They are useful to check that column headings in the 
corresponding worksheet of the Excel template match the column headings in ACER Maple. Format 
files are exported in Excel format. 
  

 

The data manager login must be used for the following function.  

 

To export template codebook and format files: 

1. On the Main screen select Export > Template documentation and then click Activate. The Export 
template documentation screen will appear (Figure 52). 

 
Figure 52: Export template documentation screen 

2. From the Select templates drop-down list select following templates: LCL, SCF, LST, STF, and 
SQTF. 

3. In the Export options list de-select any export options that are not required. By default, both 
template codebook and template format options are selected. 

4. Click Export. All codebook and/or format files will be combined into a single zip file which you 
will be prompted to download (Figure 53).  

 
Figure 53: Template documentation zip file 
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5. Select Save File and click OK to save the zip file. Manually enter or navigate to an appropriate 
location to save the file.  

6. Once the file has downloaded, open it and extract the files to an appropriate location. 

7. Prepare sufficient number of copies for data administrators to use during training. 

8. Proceed to section 3.3.2 to learn how to interpret codebooks. 

3.3.2 Interpreting codebooks 

Each Excel codebook file contains two worksheets:  

1. a list of all variables in the template and information about them (e.g. formats); 

2. value labels for selected variables.  

The worksheet containing variables has 10 columns of data. The data in each column is explained in 
Table 9 (page 60). The provided examples are excerpts from the codebook of the standard List of 
Students (LST) template presented in Table 10. 

Value labels are not required for every value of every variable, but only for those values whose 
meaning could not be provided by the variable labels or column headings. Table 11 shows value labels 
for some variables in the standard List of Students (LST) template. 
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Table 9: Codebook columns in the worksheet containing variables 

Column Column heading Description 

A Column/Row headings The column heading as it appears in the Excel template. 

B Variable type There are four variable types: fixed-width string (e.g. Line No.), long string (e.g. Student Name), integer (e.g. Study programme), and numeric (e.g. 
AMPL School No.). The variable type determines how the validation rule is defined in the next five columns. 

C Variable min These two columns define the range of values for any variables that can be defined with a range of values (e.g. for Month of Birth the possible range 
of values is from 01 to 12). If the validation rule is not defined with a range of values, such as for a long string variable, Min=Max=0. 

D Variable max 

E Out-of-range values Any valid values not included in the range are listed (if required). E.g. Gender has an additional value of 9 –‘Missing' added to the range of 1-3. This 
column in the codebook is left blank if there is no out-of-range values. 

F Variable width For fixed-width string variables this is the exact number of characters that the variable can have (e.g. Gender must have exactly one character). For all 
other variables this is the maximum number of characters that the variable can have (e.g. Student Name can have up to 60 characters, but does not 
need to use all of them). 

G Decimal places For numeric variables this column lists the number of decimal places that are saved in the data. For all other variables It is 0. 

H Variable label A short description of the variable. 

I Variable name A short alphanumeric string. The variable name must be unique. It is used in a number of different places, particularly in SPSS and SAS control files 
when data is downloaded. 

J Table acronym The acronym of the ACER Maple table (internal) which contains the data for this variable. 
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Table 10: LST template codebook – variables worksheet 

 A B C D E F G H I J 

1 Column/Row headings Variable type Variable min Variable max Out-of-range values Variable width Decimal places Variable label Variable name Table acronym 

2 AMPL School No. numeric 0 99999999  8 0 Institution tracking srtrack MPT2 

3 Line No. fixed-width string 00000 99998  5 0 Input line number idinp MPT2 

4 Lower Grade integer 0 1  1 0 Pop 1 eligibility mpop1 TCD2 

5 Upper Grade integer 0 1  1 0 Pop 2 eligibility mpop2 MPT2 

6 Student Name long string 0 0  180 0 Record name in TCD tcname MPT2 

7 Gender fixed-width string 1 3 9 1 0 Gender mpin01 MPT2 

8 Month of Birth fixed-width string 01 12 [97;98;99] 2 0 Date of birth-month mpin04 MPT2 

9 Year of Birth fixed-width string 1920 2599 [9997;9998;9999] 4 0 Date of birth-year mpin05 MPT2 

10 SEN integer 0 6  1 0 SEN mpin14 TCD2 

11 Class Name long string 0 0  10 0 Group name mpin07  

12 Grade Level numeric 0 20 [96;97;98;99] 2 0 Year level mpin06  

13 Class ID integer 0 95  2 0 Group ID mpin12  
 

Table 11: LST template codebook – value labels worksheet 

 A B C D E 

1 Column/Row headings Variable name Variable label Value Value label 

2 Gender mpin01 Gender 1 Female 

3 Gender mpin01 Gender 2 Male 

4 Gender mpin01 Gender 3 Other 

5 Gender mpin01 Gender 9 Missing 

7 Lower Grade mpop1 Pop 1 eligibility 0 Ineligible for sampling 

8 Lower Grade mpop1 Pop 1 eligibility 1 Eligible for sampling 

10 Upper Grade mpop2 Pop 2 eligibility 0 Ineligible for sampling 

11 Upper Grade mpop2 Pop 2 eligibility 1 Eligible for sampling 

12 Month of Birth mpin04 Date of birth-month 97 N/A 
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13 Month of Birth mpin04 Date of birth-month 98 Invalid 

14 Month of Birth mpin04 Date of birth-month 99 Missing 

15 Year of Birth mpin05 Date of birth-year 9997 N/A 

16 Year of Birth mpin05 Date of birth-year 9998 Invalid 

17 Year of Birth mpin05 Date of birth-year 9999 Missing 

18 Grade mpin06 Year level 96 Ungraded 

19 Grade mpin06 Year level 97 N/A 

20 Grade mpin06 Year level 98 Invalid 

21 Grade mpin06 Year level 99 Missing 

22 Grade Level mpin06 Year level 96 Ungraded 

23 Grade Level mpin06 Year level 97 N/A 

24 Grade Level mpin06 Year level 98 Invalid 

25 Grade Level mpin06 Year level 99 Missing 

26 Class ID mpin12 Group ID 0 N/A, no group sampling required 

27 SEN mpin14 SEN 0 Default, no SEN 

27 SEN mpin14 SEN 1 Functional disability 

29 SEN mpin14 SEN 2 Cogn., behav. or emot. disability 

30 SEN mpin14 SEN 3 Limited language experience 

31 SEN mpin14 SEN 4 No materials in respondents' language 

32 SEN mpin14 SEN 5 Survey specific 

33 SEN mpin14 SEN 6 Survey specific 

34 No. of students mpin15 Group size 997 N/A 

35 No. of students mpin15 Group size 998 Invalid 
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3.4 Keeping track of school participation 

During the field operations stage of the AMPL, the data manager should ensure that school 
participation status is tracked. A code for each school should be recorded either:  

• in the School Participation Form exported from ACER Maple;  

OR 

• in a file where all other information about AMPL schools is recorded. 

School participation should then be updated in ACER Maple after all STF data from all participating 
schools) have been updated, and before the data is submitted to ACER (see details in section 9.6). The 
advantage of recording participation codes in the School Participation Form is that this form can be 
imported later into ACER Maple without any additional work. If school participation information is 
recorded elsewhere, the data needs to be manually transferred into the School Participation Form 
before it can be imported into ACER Maple. 
  

 

The data manager login must be used for the following function.  

To export the School Participation Form (SPF) listing all AMPL schools for your NC: 

1. On the Main screen select Export > Institution list and then click Activate. The Export institution 
list screen will appear (Figure 54). 

 
Figure 54: Export institution list screen 

2. Click Export. You will be prompted to save a zip file containing the School Participation Form. 

3. Manually enter or navigate to an appropriate location to save the file and click Save. 

4. Once the file has downloaded, open it and extract the School Participation Form to an 
appropriate location. 

  

 

Keep the the School Participation Form handy. You will need to provide a code for each 
school, including all replacements, as soon as you know the school’s participation status. 
School participation codes can be found in section 9.6.1. 
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4 DATA ADMINISTRATOR TRAINING 

4.1 Data administrator training agenda.................................................................................... 64 

4.2 Preparation for data administrator training ....................................................................... 65 

4.3 Training setup ..................................................................................................................... 65 

4.4 Prepare training List of Classes data ................................................................................... 66 

4.5 Prepare training List of Students data ................................................................................ 67 

4.6 Prepare updated STF .......................................................................................................... 72 

 

4.1 Data administrator training agenda 

Data managers are required to train data administrators before the assessment in how to use ACER 
Maple. For the purposes of training data administrators, data managers are advised to adapt materials 
in the MS Teams>AMPL Partner Collaboration > Data Management Resources and other training 
materials provided by ACER. However, not all topics included in the DM presentation will be required 
for data administrator training. 

The topics that must be covered in data administrator training are outlined in Figure 55 and explained 
in detail in corresponding chapters of this manual, as well as in the Data Management Training 
Presentation. The following section explains how the data manager should prepare for data 
administrator training. 

 
Figure 55: Data administrators’ tasks for the AMPL 
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4.2 Preparation for data administrator training 

Preparing the materials for data administrator training gives data managers an opportunity to better 
familiarise themselves with AMPL data management procedures and ACER Maple.  

Table 12 lists the data manager’s tasks in relation to data administrator training and provides 
references to relevant sections and/or chapters of this document.  

For the purposes of data administrator training, a number of fictitious ‘schools’ have been included in 
the LSS and can be used to test some of the ACER Maple procedures before any real data is available. 
These ‘schools’ are found in stratum 99 of the LSS.  

Table 12: Data manager tasks in relation to data administrator training 

Preparation task Reference 

Ensure that training setup corresponds to the real working conditions of 
data administrators. 

Section 4.3, Introduction, 
Chapters 1 and 2 

Prepare necessary documentation Chapter 3 

Download DMTP provided by ACER. DMTP 

Prepare training field operation forms for schools from stratum 99. Sections 4.4-4.6 and DMTP 

Adapt DMTP exercise on checking and importing LST. Chapter 5 and DMTP 

Adapt DMTP exercise on student sampling from schools in stratum 99 Chapter 6 and DMTP 

Adapt DMTP exercise on populating STF templates with sampling data. Chapter 7 and DMTP 

Adapt DMTP exercise on checking and updating STF ‘after the 
assessment’. 

Section 4.6, Chapter 9 and 
DMTP 

 
  

 

Note to ALL National Centres: 

Sections 4.4-4.6 provide fictitious examples. These examples must be modified to the grade 
level(s) assessed by your NC. 

 

4.3 Training setup 

Data administrator training should be set up to correspond to the real working conditions of data 
administrators as much as possible. To achieve this, you should make sure that: 

1. All data administrators attend the training. 

2. The required computing equipment is ready:  

 ACER Maple is installed in a LAN environment as described in Chapter 2 with one of PCs for 
each data administrator plus one host PC.  

 each PC meets the system requirements and PC setup (sections 2.2 and 2.3); and 

 administrator logins are created for each data administrator as explained in section 2.9.3. 

3. LCL, SCF, LST, STF, SALF and SQTF templates are copied over to every data administrator PC. 

4. Audio-visual equipment is ready to use. Some examples of this equipment might include: 

 a projector for viewing the Data Management Training Presentation, ensuring that the screen 
is visible from every data administrator workstation; or  
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 a second monitor for each data administrator, so that they can watch the Data Management 
Training Presentation on one monitor and complete the training exercises using another 
monitor. 

4.4 Prepare training List of Classes data 

The List of Classes (LCL) template is despatched together with ACER Maple. It is designed as an Excel 
file with two worksheets: 

• the Information worksheet, containing school information and instructions for School 
Coordinators; and 

• the List of Classes worksheet, containing class data. 

Both worksheets should be copied and populated with fictitious information by the data manager in 
preparation for data administrator training. 

Table 13 shows an example of the Information worksheet prepared for training. This example can be 
used as a basis for creating your own Information worksheet of the LCL template used for training. 
Please note that: 

• For training purposes, the AMPL School No value in row 5 must correspond to a ‘school’ in 
stratum 99 of the List of Sampled Schools (LSS) agreed between your NC and ACER. 

• The total number of classes listed in rows 4 and 5 should correspond to the number of classes 
listed in the List of Classes worksheet (‘4’ for grade 4 and ‘3’ for grade 6 in this example). 

• If only one grade level is assessed, only in formation for one grade level (whichever is assessed by 
your NC) should be provided. 

• The DIRECTIONS in row 6 should be:  

 As they are shown in Table 13 with the exception of grade level IF the word ‘class’ is used in 
your country for grouping of students in the same grade level, taught by the same teacher. 

 IF the word ’class’ is NOT used for grouping of students in the same grade level, taught by the 
same teacher, make sure that the word ’class’ is explained in row 6 and the Note to NC below 
row 6 is deleted. Talk to your NPM if the changes had not been implemented. 

• The grade levels in the DIRECTIONS in row 6 should correspond to the grade levels assessed in 
your country. 

Table 13: Example of LCL School information to be used training (as if ‘returned from school’) 

1 School information 

2 
School 
name: 

School 123 Telephone: 4584563 List prepared by: Mr SC ABC 

3 
National 
School ID.: 

ZZA123 Fax: 4584565 Date list prepared:  20/05/2023 

4 Address: Central avenue, 46 Email: sc@schoolcentral 
Total number of 
grade 4 classes 
listed: 

4 

5 
AMPL School 
No.: 

1   
Total number of 
grade 6 classes 
listed: 

3 

6 

DIRECTIONS FOR the List of Classes worksheet: Please list alphabetically by Class name ALL grade 4 and 6 
classes in your school and the number of students in each class. 

After the List of Classes worksheet is filled with class data, fill out the three boxes above (i.e. 'List provided 
by', 'Date list prepared',  'Total number of classes 4 listed', and  'Total number of classes 6 listed') 
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Table 14 shows an example of error-free class data in Excel format prepared for training. The data in 
this table can be used as the basis for creating your own LCL training data. You will need to create at 
least two lists of class data for training. One containing errors that data administrators should correct 
during the training and one that is error-free, like the example in Table 14. 

When creating error-free LCL data for training, adhere to the following rules: 

• AMPL School No. ‘returned from school’ should be empty. It will be populated with the AMPL 
School No value from the Information worksheet by the data administrator during training. 

• Line No. ‘returned from school’ should be empty. It will be populated with sequential 5-digit 
string (00001, 00002,…) by the data administrator during training. 

• Lower Grade ‘returned from school’ should be empty. It will be populated with ‘1’ for lower 
grade and with ‘0’ for upper grade. 

• Upper Grade ‘returned from school’ should be empty. It will be populated with ‘0’ for lower 
grade and with ‘1’ for upper grade. 

  

 

Note to National Centres assessing lower primary school students only: 

• fill the Lower Grade column with ‘1’ for all classes; and  

• fill the Upper Grade column with ‘0’ for all classes. 

 
  

 

Note to National Centres assessing upper primary school students only: 

• fill the Lower Grade column with ‘0’ for all classes; and  

• fill the Upper Grade column with ‘1’ for all classes. 

 

• Class name should be listed in alphabetical order and if the class name contains the grade level 
like in example in Table 14, it should correspond to the grade level value from the Information 
worksheet.  

• No. of Students should be close to the expected number of students in the class in your country. 

• Grade Level ‘returned from school’ should be entered by School Coordinator. 

Table 14: Example of LCL data in Excel format to be used training (as if ‘returned from school’) 

1 
AMPL School 

No 
Line No. 

Lower 
Grade 

Upper 
Grade 

Class Name No. of Students Grade Level 

2     4A 30 4 

3     4B 25 4 

4     4C 32 4 

5     4D 20 4 

6      6A 30 6 

7      6B 25 6 

8      6C 32 6 
 

4.5 Prepare training List of Students data 

After an error-free LCL for the fictitious school has been prepared and populated with ‘AMPL School 
No’ and ‘Line No’ (see sections 5.2), data administrators can proceed to import it into ACER Maple 
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(section 5.4). After the LCL has been successfully imported a class for assessment can be drawn 
(Chapter 6). After sampling the SCF template for the fictitious school can be populated with sampling 
data (Chapter 7). In real-life situation, the School Coordinator is informed about which class will be 
participated in the assessment and asked to send the list of students enrolled in the sampled class. For 
training, pretend that this had been done and the list of students is received. 

The List of Students (LST) template is despatched together with ACER Maple. It is designed as an Excel 
file with two worksheets: 

• the Information worksheet, containing school information and instructions for School 
Coordinators; and 

• the List of Students worksheet, containing student data. 

Both worksheets should be copied and populated with fictitious information by the data manager in 
preparation for data administrator training. 

Table 15 shows an example of the Information worksheet prepared for training. This example can be 
used as a basis for creating your own Information worksheet of the LST template used for training. 
When filling the Information worksheet in the LST please adhere to the following rules: 

• For training purposes, the AMPL School No value in row 5 must correspond to a ‘school’ in 
stratum 99 of the List of Sampled Schools (LSS) agreed between your NC and ACER. 

• The DIRECTIONS in row 6 should be: 

 As they are shown in Table 15 with the exception of grade level IF the word ‘class’ is used in 
your country for grouping of students in the same grade level, taught by the same teacher. 

 IF the word ‘class’ is NOT used in your country for grouping of students in the same grade 
level, taught by the same teacher, make sure that the word ’class’ is explained in row 6 and 
the Note to NC is deleted. Talk to your NPM if the changes had not been implemented. 

• Grade Level under Sampled class information should be populated with the grade level assessed 
in your country. 

• Class Name and Class ID under Sampled class information should be populated with the 
corresponding values exported after class sampling into the SCF template. 

• Only one change is required in the instructions under Special Educational Needs (SEN) Codes in 
the Information worksheet: survey language must be changed to English. 

  

 

Note to the India NC: 

For schools assessed in Hindi the survey language must be changed to Hindi 
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Table 15: Example of LST School information to be used training (as if ‘returned from school’) 

1 School information 

2 
School 
name: 

Central school Telephone: 4584563 List prepared by: Mr SC ABC 

3 
National 
School No.: 

XT3Q5 Fax: 4584565 
Date list 
prepared:  

20/05/2023 

4 Address: Central avenue, 46 Email: sc@schoolcentral 
Total number of 
students listed: 

65 

5 
AMPL 
School No.: 

1001     

6 

DIRECTIONS FOR the List of Students worksheet: Please list ALL students in your school in sampled class 
(see Sampled class information below) and provide their demographic data.  

Use the list of codes in the Special Educational Needs (SEN) to fill the corresponding column in the List of 
Students worksheet.  

After the List of Students worksheet is filled with student data, fill out the three boxes above (i.e. 'List 
provided by', 'Date list prepared', and 'Total number of students listed').  

7       

8 Special Educational Needs (SEN) Codes:  Sampled [classes] information 

9 Code Description   Grade Level Class Name Class ID 

10 0 No special educational needs  <> <> <> 

11 1 Functional disability…     

 
2 Cognitive, behavioural, or 

emotional disability…  
 

  

12 3 
Limited survey language 
experience… 

  
 

 

 

Table 16 shows an example of error-free student data in Excel format prepared for training. The data 
in this table can be used as the basis for creating your own LST training data. You will need to create 
at least two lists of student data for training. One containing errors, that data administrators should 
correct during the training, and one that is error-free, like the example in Table 16. 

When creating error-free LST data for training, adhere to the following rules: 

• School Name ‘returned from school’ should be empty. It will be populated with the school name 
from the Information worksheet by the data administrator during training. 

• AMPL School No. ‘returned from school’ should be empty. It will be populated with the AMPL 
School No value from the Information worksheet by the data administrator during training. 

• Line No. ‘returned from school’ should be empty. It will be populated with sequential 5-digit 
string (00001, 00002,…) by the data administrator during training. 

• Lower Grade ‘returned from school’ should be empty. It will be populated with ‘1’ for lower 
grade and with ‘0’ for upper grade. 

• Upper Grade ‘returned from school’ should be empty. It will be populated with ‘0’ for lower 
grade and with ‘1’ for upper grade. 

  

 

Note to National Centres assessing lower primary school students only: 

• fill the Lower Grade column with ‘1’ for all classes; and  

• fill the Upper Grade column with ‘0’ for all classes. 
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Note to National Centres assessing upper primary school students only: 

• fill the Lower Grade column with ‘0’ for all classes; and  

• fill the Upper Grade column with ‘1’ for all classes. 

 

• Student name is usually listed in alphabetical order. Provide the names used in your country. 

• Gender: if the names in your language differ by gender, make sure that: 

 1 is assigned to girls; and 

 2 is assigned to boys. 

• Month of Birth should be a random 2-digit string (between 01 and 12) as in the example in Table 
16. 

• Year of Birth: an appropriate value should be selected from the range of years within which the 
students from the grade level being assessed in your country were born. 

• SEN: most of the students should have ‘0’ (no SEN), and a small number of students should have 
‘1’ (Functional disability), ’2’ (Cognitive, behavioural or emotional disability), or ‘3’ (Limited 
language experience). 

• Grade Level: replace grade level(s) with the grade level(s) being assessed in your country. 

• Class name ‘returned from school’ should be empty. It will be populated with the class name 
from the Information worksheet by the data administrator during training. 

• Class ID ‘returned from school’ should be empty. It will be populated with the class name from 
the Information worksheet by the data administrator during training. 

For some ‘schools’ please create an LST containing errors and ensure that data administrators are 
trained to check LST data when it is received from schools. For example, include a Month of Birth value 
between ‘1’ and ‘9’ (i.e. without a leading zero), or/and Gender value of ‘0’. Read more about LST 
checks and correct formatting of LST variables in Chapter 5.  
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Table 16: Example of LST data in Excel format to be used in training (as if ‘returned from school’) 

1  For NC use <Name> <Surname>  F=1; M=2 MM YYYY  Class 

2 School Name AMPL School No. Line No. 
Lower 
Grade 

Upper 
Grade Student Name Gender 

Month 
of Birth 

Year of 
Birth SEN Grade Level Class Name Class ID 

3      Xab Yac 1 01 2010 0    

4      Xac Yad 1 11 2011 0    

5      Xaf Yag 2 09 2010 0    

6      Xad Yag 1 08 2010 0    

7      Xaj Yak 2 05 2010 1    

8      Xab Yac 1 03 2010 0    

10      Xb Yacd 2 12 2010 0    

11      Xab Yah 2 11 2010 0    

12      Xak Yalk 1 03 2010 1    

13      Xkl Yvb 2 05 2010 0    

              

28      Xab Ykm 2 02 2010 0    

29      Xed Ygbn 2 04 2009 0    

30      Xsd Ymnv 1 10 2010 0    

31      Xcv Ywdj 2 07 2010 0    

32      Xth Ysdf 1 04 2010 2    

33      Xwe Ywsc 1 08 2010 0    

34      Xab Yuhj 2 03 2010 0    

35      Xerb Yjkl 1 01 2010 3    
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4.6 Prepare updated STF 

After an error-free LST for the fictitious school has been prepared and populated with additional 
information by data administrators (section 5.3), data administrators can proceed to import it into 
ACER Maple (section 5.4). After the LST has been successfully imported the student sample can be 
drawn (Chapter 6). After sampling the STF template for the fictitious school can be populated with 
sampling data (Chapter 7). 

Table 17 shows an example Student Tracking Form in Excel format containing training data ready to be 
updated in ACER Maple. The data in this table can be used as a basis for creating your own STF training 
data. Any STF training data should contain a AMPL School No value that corresponds to a ‘school’ in 
stratum 99.  

For some fictitious schools please create an STF with errors and ensure that data administrators are 
trained to check STF data when it is returned by Test Administrators. 
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Table 17: Example of STF data in Excel format ready to be updated in ACER Maple during training 

1 School Name AMPL School No.  School Coordinator   Test Administrator Session Date 1 (DD/MM) Session date 2 (DD/MM) 

2 Central school 1001  Mr SC ABC  Ms TA XYZ 30/05 31/05 

3  LST 
 

 
F=1; 
M=2 MM YYYY  Attendance Participation Class  

4 
Student Name Line No. 

AMPL 
Participant ID 

Test 
Form 

Gender 
Month of 
Birth 

Year of Birth SEN Test StQ LG UG 
Grade 
Level 

Class Name Comments 

5 Xab Yac 00001 92100106 5 1 01 2010 0 1 1 9 1 6 6C  

6 Xac Yad 00002 92100104 6 1 11 2011 0 0 1 9 0 6 6C  

7 Xaf Yag 00003 92100105 7 2 09 2010 0 1 0 9 0 6 6C  

8 Xad Yaf 00004 92100101 8 1 08 2010 0 0 0 9 1 6 6C  

9 Xaj Yak 00005 92100103 3 2 05 2010 1 1 1 9 0 6 6C  

10 Xab Yac 00006 92100108 4 1 03 2010 0 0 1 9 1 6 6C  

11 Xb Yacd 00007 92100102 5 2 12 2010 0 1 0 9 1 6 6C  

12 Xab Yah 00008 92100109 6 2 11 2010 0 1 1 9 1 6 6C  

13 Xak Yalk 00009 92100107 7 1 03 2010 1 0 0 9 0 6 6C  

14 Xkl Yvb 00010 92100110 8 2 05 2010 0 0 0 9 0 6 6C  

15 Xab Yfg 00011 92100115 3 1 06 2010 0 0 0 9 0 6 6C  

16 Xab Ykm 00012 92100120 4 2 02 2010 0 0 0 9 0 6 6C  

16 Xed Ygbn 00013 92100111 5 2 04 2009 0 0 0 9 0 6 6C  

18 Xsd Ymnv 00014 92100116 6 1 10 2010 0 0 0 9 0 6 6C  

19 Xcv Ywdj 00015 92100112 7 2 07 2010 0 0 0 9 0 6 6C  

20 Xth Ysdf 00016 92100117 8 1 04 2010 2 0 0 9 0 6 6C  

21 Xwe Ywsc 00017 92100113 3 1 08 2010 0 0 0 9 0 6 6C  

22 Xab Yuhj 00018 92100114 4 2 03 2010 0 0 0 9 0 6 6C  
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5.1 Class and student sampling logistics 

The logistics of sampling are illustrated in Figure 56, outlined below and explained in detail in relevant 
sections of this manual: 

1. After data administrators have been trained, they will start checking class lists received from 
schools and formatting them into LCL files (sections 5.2), then importing the LCL data into ACER 
Maple (section 5.4).  

2. After data from the LCL have been successfully imported into the ACER Maple database, class 
sampling is undertaken, which results in one class of each grade level being sampled (chapter 6) 
and SCF form populated with the sampled class data (chapter 7).  

3. After that the SC must be contacted and asked for the student lists from the sampled class. After 
List of Students is received from schools, data administrators check and format the student lists 
received from schools into the LST files, then import the LST data into ACER Maple (sections 5.3 
and 5.4). 

4. Each time the data is imported into ACER Maple, the software will check the imported data for 
inconsistencies. Detected inconsistencies will be listed in the Import Field Data Validity Report. 
Some of these inconsistencies may be errors that must be corrected before student sampling can 
proceed, while others may be warnings of missing data that can be completed later by Test 
Administrators on the tracking forms (section 5.5). 

  

 

Data will only be transferred into the ACER Maple database when all errors have been 
corrected. 
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Figure 56: Sampling logistics 

5.2 Preparing LCL data for import 

The List of Classes (LCL) is crucial for sampling in the AMPL project because only students sampled from 
sampled classes are eligible for assessment. The data stored in these lists are used in student tracking 
forms, to validate sampling data and for weight adjustments after the data is collected and submitted 
to ACER. 
  

 

To make LCL import efficient, the data in each LCL must be checked and corrected before 
being imported into ACER Maple. 
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It is important for the data manager to export the LCL codebook (see section 3.3) and make 
it available to all data administrators, before the data administrators begin preparing the 
LCL data for import. 

It is preferable for the LCL data to be prepared and imported one school at a time as soon as it is 
received. The process for preparing a file for importing starts with establishing a file naming 
convention, as described in section 5.2.2. The remaining steps for preparing the file are outlined in 
section 5.3.2, and explained in detail in sections 5.2.3 - 5.2.12. 

5.2.1 File naming conventions 

Before any LCLs start arriving from schools, the data manager must establish a file naming convention 
and ensure that all data administrators adhere to it.  
  

 

All data administrators within your NC must use the same file naming convention. 

 

• Each LCL file should be saved in Excel format in a designated location. 

• Each LCL file must have in the file name ‘LCL’, an AMPL school number, the school name, and the 
date when the LCL was prepared (e.g. LCL_121_Central school_AsReceived210502).  

 If an LCL has been received electronically, it should be saved according to the established file 
naming convention before any further preparation of the file begins. 

 If an LCL has been received in hard copy, it must be: 

1. checked, in hard copy, as explained in sections 5.2.3 - 5.2.5; 

2. corrected (if required), in hard copy, as explained in section 5.2.6;  

3. keyed into an LCL Excel template (5.2.7-5.2.11); 

4. saved according to the established file naming convention before any further preparation 
continues (5.2.12). 

5.2.2 List of Classes data preparation outline 

The following 9 steps outlines how to prepare the List of Classes data: 

1. Check grade level(s) and class names (section 5.2.3). 

2. Check the number of classes in the List of Classes worksheet against the Information worksheet 
(section 5.2.4). 

3. Check the number of students in the List of Classes worksheet (section 5.2.5). 

4. Contact school if required (section 5.2.6). 

5. Sort the LCL data (section 5.2.7). 

6. Add the appropriate value in the ‘AMPL School No.’ (section 5.2.8). 

7. Add appropriate values in the ‘Line No.’ column (section 5.2.9). 

8. Add appropriate values in the ‘Lower Grade’ and ‘Upper Grade’ columns (section 5.2.10). 

9. Ensure that the data adheres to the validation rules for each column (section 5.2.11). 

10. Save the file (section 5.2.12). 
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5.2.3 Check grade level and class names 

Check that the number in the Grade Level column matches the grade level assessed in your country 
(refer to Table 18). 
  

 

If in your NC two grade levels are assessed, make sure that each list contains only one 
grade level. E.g., grade 4 classes must be listed separately from grade 6 classes. 

 

Table 18: Grade levels assessed by AMPL countries 

Country Grade level assessed 

India 3 and 5 

Kenya 6 

Lesotho 7 

The Gambia 3 

Zambia 4 and 7 
 

In the Class Name column 

• If grade level is not included in the class name, or class name is not provided9, go to section 5.3.4. 

• If grade level is included in the class name (e.g. 6a), highlight any class names with grade level 
that does not match the number in the Grade Level column or the grade level assessed in your 
country. 

5.2.4 Check the number of classes 

The number of classes in the List of Classes worksheet must be the same as the number provided in 
the Information worksheet. 

Make a note if this is not the case. 

5.2.5 Check the number of students 

The number of students in the List of Classes worksheet for each class must be a reasonable number 
for your country. If it is too small or too large from your point of view, make a note 

5.2.6 Contact school if required 

After completing checks described in sections 5.2.3 - 5.2.5: 

• if there are no highlighted cases or additional notes that were made during checking, go to 
section 5.2.7. 

OTHERWISE 

• contact the school to verify the data for any highlighted cases or additional notes that were 
made during checking.  

Possible queries for the school and the actions required to correct the data are listed in Table 19. 
 

 

 
9 Class names and students name are optional. They are provided for convenience of administration. 
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Table 19: Possible queries regarding LCL checks, and actions required 

Possible query Actions required 

Query any class names 
with incorrect grade levels 

• If any classes are in the correct grade level, but there was an error in 
the class name, correct the class name in the LCL. 

OR 

• If any classes listed are in the wrong grade level, ask the School 
Coordinator to send a corrected list and destroy the incorrect one. 

Query any suspicious or 
missing student numbers 

• If the School Coordinator provides updated data, update the records 
in the LCL. 

OR 

• If the data is not available, enter missing values as indicated in the 
codebook and ask the School Coordinator to provide the data later 
for sampled class(es) 

Query any instance where 
the number of classes in 
the List of Classes 
worksheet is not the same 
as the number provided in 
the Information worksheet 

• If the number provided in the Information worksheet is incorrect, 
correct the number in the worksheet. 

OR 

• If the number of classes in the List of Classes worksheet is incorrect, 
ask the School Coordinator to send a corrected list and destroy the 
incorrect one. 

 

After enquiries are made: 

• If all corrections have been made in the existing LCL, save a new version of the LCL with 
“_Updated” added to the end of the file name. Ensure that the new file is saved in a suitable 
location. 

• If the School Coordinator is required to send an updated List of Classes, delete the existing one. 
When the updated LCL has been received, it will need to be checked again. 

5.2.7 Sort LCL data 

If an “_Updated” LCL has been saved, it will need to be checked to ensure that the listed records are 
ordered correctly before ACER Maple can import it. Open the updated LCL in Microsoft® Excel to check: 

• If the records on the LCL are ordered alphabetically according to class name (e.g. 6a is listed first, 
then 6b,…). 

OTHERWISE 

• Sort the LCL data alphabetically by Class Name as follows: 

1. If the file has opened in Microsoft® Excel in Protected View, click the Enable Editing button at 
the top of the screen. 

2. Highlight row 1 and ALL class records in the List of Classes worksheet. 

3. Click DATA. The DATA ribbon will be displayed at the top of the Excel screen. 

4. Click Sort. The Sort window will appear (Figure 59). 

5. Click ‘My data has headers’ in the top right-hand corner of the Sort window (see Figure 59). 

6. In the Sort by drop-down list, click ‘AMPL School No.’. 

7. Click Add Level 

8. In the Then by drop-down list, click ‘Grade Level’. 
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9. Click Add Level 

10. In the Then by drop-down list, click ‘Class Name’. 

11. Click Add Level 

12. Click OK. Microsoft® Excel will sort the data. 

 
Figure 57: Sorting LCL 

13. Check that the LCL has been sorted as specified: 

 If yes, save a copy of the file with extension “_Sorted” 

 Otherwise, close the file without saving, reopen it, and repeat steps 1 to 12 to sort again. 

5.2.8 Add the value in the ‘AMPL School No.’ column 

In the ‘AMPL School No.’ column, copy over the value from the ‘AMPL School No’ cell in the Information 
worksheet. Make sure that the number is the same for all records in the school. 

Click Save. 

5.2.9 Add values in the ‘Line No.’ column 

To add ‘Line No.’ values in the ‘Line No.’ column: 

• In the first row, enter ‘00001. Remember to use a single quotation mark to include leading 
zeroes. 

• In the second row, enter ‘00002. 

• Select the two cells, then position the cursor at the bottom right of the selection, and then click 
to expand the black square down to the row of the last student in the list (Figure 60). This will 
populate the line numbers “00001, 00002, 00003, …” for the school. 

• Click Save. 

  

Figure 58: Populating LCL ‘Line No.’ column 

5.2.10 Add values in the ‘Lower Grade’ and ‘Upper Grade ’ columns 

• In the ‘Lower Grade’ column, type ‘1’ for all lower grade classes and ‘0’ for all upper grade 
classes. 
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• In the ‘Upper Grade’ column, type ‘1’ for all upper grade classes and ‘0’ for all lower grade 
classes. 

• Check that ‘0’ and ‘1’ are assigned correctly. 

 If ‘0’ and ‘1’ are assigned correctly, click Save. 

 Otherwise correct and then click Save. 
  

 

Note to National Centres assessing lower primary school students only: 

• fill the Lower Grade column with ‘1’ for all classes; and  

• fill the Upper Grade column with ‘0’ for all classes 

• See example in Table 21. 

 
  

 

Note to National Centres assessing upper primary school students only: 

• fill the Lower Grade column with ‘0’ for all classes; and  

• fill the Upper Grade column with ‘1’ for all classes. 

• See example in Table 22 

 

5.2.11 Ensure the data matches the validation rules in each column 

Compare the prepared LCL data against the exported codebook and format files for the LCL and verify 
that the data matches the validation rules in each column, and the structure of the data. See section 
3.3 for instructions on exporting codebook and format files and how to interpret codebooks. 

As an example of a validation check consider the following: The ‘Month of Birth’ column requires a 2-
digit number (as specified in the validation rule for this column in the codebook). This means that if 
March is entered as ‘3’ or ‘March’, it must be changed to ‘03’ to avoid an error when importing the 
data into ACER Maple. To include a leading 0, key in a single quotation mark (‘) in front of ‘03’. 
  

 

Note that a single quotation mark (‘) is necessary to include leading zeros in columns ‘Line 
No.’ and ‘Month of Birth’. 

To ensure correct structure 

• Open LCL format 

• Make sure that all columns are in the right order 

• Copy the first row from the format and paste it in row 2 of the LCL data worksheet. 

Table 20 shows LCL data for a fictitious NC assessing two grade levels ready to be imported into ACER 
Maple. Table 21 and Table 22 shows similar examples of LCL for fictitious NCs assessing on ly one grade 
level. 
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Table 20: Example LCL data in Excel format ready to be imported into ACER Maple (lower and upper grades)  

1 AMPLSchool No. Line No. Lower Grade Upper Grade Class name No. of Students Grade Level 

2 1 00001 1 0 4A 30 4 

3 1 00002 1 0 4B 25 4 

4 1 00003 1 0 4C 32 4 

5 1 00004 1 0 4D 20 4 

6 1 00005 0 1 6A 33 6 

7 1 00006 0 1 6B 25 6 

8 1 00007 0 1 6C 32 6 
 

Table 21: Example LCL data in Excel format ready to be imported into ACER Maple (lower grade only)  

1 AMPLSchool No. Line No. Lower Grade Upper Grade Class name No. of Students Grade Level 

2 1 00001 1 0 4A 30 4 

3 1 00002 1 0 4B 25 4 

4 1 00003 1 0 4C 32 4 

5 1 00004 1 0 4D 20 4 
 

Table 22: Example LCL data in Excel format ready to be imported into ACER Maple (upper grade only)  

1 AMPLSchool No. Line No. Lower Grade Upper Grade Class name No. of Students Grade Level 

2 1 00005 0 1 6A 33 6 

3 1 00006 0 1 6B 25 6 

4 1 00007 0 1 6C 32 6 
 

5.2.12 Save the file 

Save a new version of the LCL with “_ForImport” added to the end of the file name. Ensure that the 
new file is saved in a suitable location. 

5.3 Preparing LST data for import 

The List of Students (LST) is crucial for student sampling. The data stored in these lists are used in 
student tracking forms and to validate sampling data. 
  

 

To make LST import efficient, the data for each LST must be checked and corrected before 
being imported into ACER Maple. 

 
  

 

It is important for the data manager to export the LST codebook (see section 3.3) and make 
it available to all data administrators, before the data administrators need to begin 
preparing the LST data for import. 

It is preferable for the LST data to be prepared and imported one school at a time as soon as it is 
received. The process for preparing a file for importing starts with establishing a file naming 
convention, as described in section 5.3.1. The remaining steps for preparing the file are outlined in 
section 5.3.2, and explained in detail in sections 5.3.3 - 5.3.13. 
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5.3.1 File naming conventions 

Before any LSTs start arriving from schools, the data manager must establish a file naming convention 
and ensure that all data administrators adhere to it.  

• Each LST file should be saved in Excel format in a designated location. 

• Each LST file must have in the file name ‘LST’, a AMPL school number, any other information that 
identifies the school (e.g. the school name), and the date that list was prepared (e.g. 
LST_121_Central school_AsReceived210502).  

  

 

All data administrators within your NC must use the same file naming convention. 

 

• If an LST has been received electronically, it should be saved according to the established file 
naming convention before any further preparation of the file begins (section 5.3.2). 

• If an LST has been received in hard copy, it must be: 

1. checked, in hard copy, as explained in sections 5.3.3- 5.3.5; 

2. corrected (if required), in hard copy, as explained in section 5.3.6; 

3. keyed into an LST Excel template and check the results (5.3.7-5.3.12); and 

4. saved according to the established file naming convention before any further preparation 
continues (5.3.13). 

5.3.2 List of Students data preparation outline 

To prepare the List of Students data: 

1. Check class names (section 5.3.3). 

2. Check gender and age distributions (section 5.3.4 ). 

3. Check the number of students in the List of Students worksheet against the Information 
worksheet (section 5.3.5). 

4. Contact school if required (section 5.3.6). 

5. Sort the LST data (section 5.3.7). 

6. Add the school name in the first column  (section 5.3.8). 

7. Add the appropriate value in the ‘AMPL School No.’ (section 5.3.9). 

8. Add appropriate values in the ‘Line No.’ column (section 5.3.10). 

9. Add appropriate values in the ‘Lower Grade’ and ‘Upper Grade’ columns (section 5.3.11) 

10. Ensure that the data adheres to the validation rules for each column (section 5.3.12). 

11. Save the file (section 5.3.13). 

5.3.3 Check class names 

• If grade level is not included in the class name, or class name is not provided10, go to section 
5.3.4. 

• If grade level is included in the class name (e.g. 6a): 
 

 

 
10 Class names and student names are optional. They are provided for convenience of administration. 
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1. check that the grade level indicated in the class name corresponds to the grade level assessed 
in your country (refer to Table 18 on page 78). 

2. highlight any class names with an incorrect grade level. 

5.3.4 Check the gender and age distributions 

The gender and age distributions must match the school’s demographic background (e.g. a single 
gender school cannot have students of both genders, or a student born in 2015 cannot be in grade 6). 

Highlight any records in the List of Students that have incorrect, suspicious or missing demographics 
data. Some examples of such records are:  

• a student who is the only female in the List of Students;  

• year of birth that is outside the usual range for students from the grade level being assessed 

• any student with missing gender or date of birth data. 

5.3.5 Check the number of students 

The number of students in the List of Students worksheet must be the same as the number provided 
in the Information worksheet. 

Make a note if this is not the case. 

5.3.6 Contact school if required 

After completing checks described in sections 5.3.3- 5.3.5: 

• if there are no highlighted cases or additional notes that were made during checking, go to 
section 5.3.7. 

OTHERWISE 

• contact the school to verify the data for any highlighted cases or additional notes that were 
made during checking.  

Possible queries for the school and the actions required to correct the data are listed in Table 23. 
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Table 23: Possible queries regarding LST checks and actions required 

Possible query Actions required 

Query any class names with 
incorrect grade levels 

• If any students are in the correct grade level, but there was an error 
in the class name, correct the class name in the LST. 

OR 

• If any students listed are in the wrong grade level, ask the School 
Coordinator to send a corrected list and destroy the incorrect one. 

Query any suspicious or 
missing demographics data11 

• If the School Coordinator provides updated data, update the 
records in the LST. 

OR 

• If the data is not available, enter missing values as indicated in the 
codebook and ask the School Coordinator to provide the data later 
in the STF for sampled students 

Query any instance where the 
number of students in the List 
of Students worksheet is not 
the same  as the number 
provided in the Information 
worksheet 

• If the number provided in the Information worksheet is incorrect, 
correct the number in the worksheet. 

OR 

• If the number of students in the List of Students worksheet is 
incorrect, ask the School Coordinator to send a corrected list and 
destroy the incorrect one. 

 

After enquiries are made: 

• If all corrections have been made in the existing LST, save a new version of the LST with 
“_Updated” added to the end of the file name. Ensure that the new file is saved in a suitable 
location. 

• If the School Coordinator is required to send an updated List of Students, delete the existing one. 
When the updated LST has been received, it will need to be checked again. 

5.3.7 Sort LST data 

If an “_Updated” LST has been saved, it will need to be checked to ensure that the listed records are 
ordered correctly before ACER Maple can import it. Open the updated LST in Microsoft® Excel to check: 

• If the records on the LST are ordered alphabetically according to class name (e.g. all students 
from 6a are listed first, then all students from 6b,…) AND student name within each class, go to 
section 5.3.9. 

OTHERWISE 

• Sort the LST data alphabetically by Class Name and Student name (within Class name) as follows: 

1. If the file has opened in Microsoft® Excel in Protected View, click the Enable Editing button at 
the top of the screen. 

2. Highlight row 2 and ALL student records in the List of Students worksheet. 

3. Click DATA. The DATA ribbon will be displayed at the top of the Excel screen. 

4. Click Sort. The Sort window will appear (Figure 59). 
 

 

 
11 Date of birth and gender must be entered into the Excel spreadsheet. In rare cases when actual date of birth or gender 
are not available at the time of sampling, missing values must be entered. See Appendix 3 if ‘blind’ sampling is required. 
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5. Click ‘My data has headers’ in the top right-hand corner of the Sort window (see Figure 59). 

6. In the Sort by drop-down list, click Class Name. 

7. Click Add Level. A new ‘Then by’ drop-down list will appear. 

8. In the ‘Then by’ drop-down list, click Student Name. 

9. Click OK. Microsoft® Excel will sort the data. 

 
Figure 59: Sorting LST 

10. Check that the LST has been sorted as specified: 

 If yes, save a copy of the file with extension “_Sorted” 

 Otherwise, close the file without saving, reopen it, and repeat steps 1 to 10 to sort again. 

5.3.8 Add the school name in the first column 

In the ‘School Name’ column, copy over the ‘School Name’ cell from the Information worksheet. Make 
sure that the name is the same for all records in the school. 

5.3.9 Add the value in the ‘AMPL School No.’ column 

In the ‘AMPL School No.’ column, copy over the value from the ‘AMPL School No’ cell in the Information 
worksheet. Make sure that the number is the same for all records in the school. 

5.3.10 Add values in the ‘Line No.’ column 

To add ‘Line No.’ values in the ‘Line No.’ column: 

• In the first row, enter ‘00001. Remember to use a single quotation mark to include leading 
zeroes. 

• In the second row, enter ‘00002. 

• Select the two cells, then position the cursor at the bottom right of the selection, and then click 
to expand the black square down to the row of the last student in the list (Figure 60). This will 
populate the line numbers “00001, 00002, 00003, …” for the school. 

  
Figure 60: Populating LST ‘Line No.’ column 
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5.3.11 Add values in the ‘Lower Grade’ and ‘Upper Grade ’ columns 

• In the ‘Lower Grade’ column, type ‘1’ for all lower grade students and ‘0’ for all upper grade 
classes. 

• In the ‘Upper Grade’ column, type ‘1’ for all upper grade students and ‘0’ for all lower grade 
classes. 

• Check that ‘0’ and ‘1’ are assigned correctly. 

 If ‘0’ and ‘1’ are assigned correctly, click Save. 

 Otherwise correct and then click Save. 
  

 

Note to National Centres assessing lower primary school students only: 

• fill the Lower Grade column with ‘1’ for all classes; and  

• fill the Upper Grade column with ‘0’ for all classes. 

 
  

 

Note to National Centres assessing upper primary school students only: 

• fill the Lower Grade column with ‘0’ for all classes; and  

• fill the Upper Grade column with ‘1’ for all classes. 

 

5.3.12 Ensure the data matches the validation rules in each column 

Compare the prepared LST data against the exported codebook and format files for the LST and verify 
that the data matches the validation rules in each column, and the structure of the data. See section 
3.3 for instructions on exporting codebook and format files and how to interpret codebooks. 

As an example of a validation check consider the following: The ‘Month of Birth’ column requires a 2-
digit number (as specified in the validation rule for this column in the codebook). This means that if 
March is entered as ‘3’ or ‘March’, it must be changed to ‘03’ to avoid an error when importing the 
data into ACER Maple. To include a leading 0, key in a single quotation mark (‘) in front of ‘03’. 
  

 

Note that a single quotation mark (‘) is necessary to include leading zeros in columns ‘Line 
No.’ and ‘Month of Birth’. 

To ensure correct structure 

• Open LST format. 

• Make sure that all columns are in the right order. 

• Copy the first row from the format and paste it in row 2 of the LST data worksheet. 

Table 24 shows LST data ready to be imported into ACER Maple. 

5.3.13 Save the file 

Save a new version of the LST with “_For_Import” added to the end of the file name. Ensure that the 
new file is saved in a suitable location. 
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Table 24: Example LST data in Excel format ready to be imported into ACER Maple (two grade levels) 

 For NC use 
<Name> 

<Surname>  F=1; M=2 MM YYYY  Class 

1 
School Name AMPL School 

No. Line No. 
Lower 
Grade 

Upper 
Grade Student Name Gender  Month of Birth  Year of Birth SEN Grade Level Class Name Class ID 

2 School 123 1 00001 1 0 Xab Yac 1 01 2010 0 4 4B 3 

3 School 123 1 00002 1 0 Xac Yad 1 11 2011 0 4 4B 3 

4 School 123 1 00003 1 0 Xaf Yag 2 09 2010 0 4 4B 3 

5 School 123 1 00004 1 0 Xad Yag 1 08 2010 0 4 4B 3 

6 School 123 1 00005 1 0 Xaj Yak 2 05 2010 1 4 4B 3 

7 School 123 1 00006 1 0 Xab Yac 1 03 2010 0 4 4B 3 

8 School 123 1 00007 1 0 Xb Yacd 2 12 2010 0 4 4B 3 

10 School 123 1 00008 1 0 Xab Yah 2 11 2010 0 4 4B 3 

11 School 123 1 00009 1 0 Xak Yalk 1 03 2010 1 4 4B 3 

12 School 123 1 00010 1 0 Xkl Yvb 2 05 2010 0 4 4B 3 

              

28 School 123 1 00026 0 1 Xab Ykm 2 02 2010 0 6 6C 3 

29 School 123 1 00027 0 1 Xed Ygbn 2 04 2009 0 6 6C 3 

30 School 123 1 00028 0 1 Xsd Ymnv 1 10 2010 0 6 6C 3 

31 School 123 1 00029 0 1 Xcv Ywdj 2 07 2010 0 6 6C 3 

32 School 123 1 00030 0 1 Xth Ysdf 1 04 2010 2 6 6C 3 

33 School 123 1 00031 0 1 Xwe Ywsc 1 08 2010 0 6 6C 3 

34 School 123 1 00032 0 1 Xab Yuhj 2 03 2010 0 6 6C 3 

35 School 123 1 00033 0 1 Xerb Yjkl 1 01 2010 3 6 6C 3 
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5.4 Importing Data for Sampling 

  

 

A data administrator login must be used for the following function. 

To import LCL or LST data into ACER Maple:  

1. On the Main screen select Import > Field data and then click Activate. The Import field data 
screen will appear (Figure 61). 

2. In the Available Templates drop-down list on the left-hand side of the screen select: 

 LCL if you are importing List of Classes;  

 LST if you are importing List of Students.  

3. In the Selected Template Preview use the horizontal scrollbar at the bottom of the previewed 
list to view all the columns in the template. 

4. In the Options list ensure that ‘Append to existing data’ is selected. 

 
Figure 61: Import field data screen 

5. Click Browse… and manually enter or navigate to the location of the Excel file containing the LST 
data to be imported. 

 

The Excel file selected for import must match the template selected in the Available 
Templates drop-down list. 

The Excel file will be uploaded into ACER Maple and its file name will appear in a tab beside the 
Browse… button. 

In the Uploaded File Preview a preview of the uploaded file will appear (Figure 62). Only the first 
15 rows of data will be displayed. The total number of rows and columns in the uploaded file will 
be displayed beneath the preview. 
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Figure 62: Uploaded File Preview for a List of Classes (LST) 

6. Click Import. ACER Maple then performs a number of validity checks on the data in the selected 
Excel file.  

The possible outcomes and required actions are described in Table 25 for the LCL and Table 26 for the 
LST. 
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Table 25: Possible outcomes when importing List of Classes data  

Outcome  Next steps 

LCL data has been validated, with no 
discrepancies, and is ready to be imported 
into the ACER Maple database. 

Pop-up message appears saying the data 
has been validated with no errors or 
warnings. 

1. Click Continue. 

2. Another pop-up message will appear listing the number of 
records updated. Click Dismiss. 

3. Import LCL data from another Excel file (if required); OR 

click Back to continue with other tasks; OR 

click Quit to close the session and create a back-up (see 
sections 2.7.4 / 2.7.5) 

LCL data contains some discrepancies that 
should be checked before importing 
(warnings). 

Pop-up message appears warning that 
there are discrepancies, but the data can 
be imported, and prompts you to save or 
download the report. 

Import Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location and open it. 

2. Refer to section 5.5 to check the records that appear in 
the report. 

3. If any corrections are required, click Cancel to dismiss the 
pop-up message, make the required corrections in the 
Excel file and attempt to import the LCL data again. 

4. If corrections are not required, click Continue to import 
the data. Another pop-up message will appear listing the 
number of records that have been imported. Click Dismiss. 

5. Explanations must be entered in ACER Maple before data 
can be submitted. 

LCL data contains some discrepancies that 
prevent the data from being importing 
(errors). 

Pop-up message appears warning that 
there are discrepancies, the data cannot be 
imported, and prompts you to save or 
download the report. 

Import Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location. Click Cancel to close the pop-up 
message. 

2. Manually enter or navigate to the location of the saved 
report and open it. 

3. Refer to section 5.5 to check the records that appear in 
the report. 

4. Make the required corrections in the Excel file and 
attempt to import the LCL data again. 
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Table 26: Possible outcomes when importing List of Student data  

Outcome  Next steps 

LST data has been validated, with no 
discrepancies, and is ready to be imported 
into the ACER Maple database. 

Pop-up message appears saying the data 
has been validated with no errors or 
warnings. 

1. Click Continue. 

2. Another pop-up message will appear listing the number of 
records updated. Click Dismiss. 

3. Import LST data from another Excel file. 

OR 

Proceed to sample students for the imported/updated 
schools (Chapter 6). 

LST data contains some discrepancies that 
should be checked before importing 
(warnings). 

Pop-up message appears warning that 
there are discrepancies but the data can be 
imported, and prompts you to save or 
download the report. 

Import Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location and open it. 

2. Refer to section 5.5 to check the records that appear in 
the report. 

3. If any corrections are required, click Cancel to dismiss the 
pop-up message, make the required corrections in the 
Excel file and attempt to import the LST data again. 

4. If corrections are not required, click Continue to import 
the data. Another pop-up message will appear listing the 
number of records that have been imported. Click Dismiss. 

5. Explanations must be entered in ACER Maple before data 
can be submitted. 

LST data contains some discrepancies that 
prevent the data from being importing 
(errors). 

Pop-up message appears warning that 
there are discrepancies, the data cannot be 
imported, and prompts you to save or 
download the report. 

Import Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location. Click Cancel to close the pop-up 
message. 

2. Manually enter or navigate to the location of the saved 
report and open it. 

3. Refer to section 5.5 to check the records that appear in 
the report. 

4. Make the required corrections in the Excel file and 
attempt to import the LST data again. 

5.5 Import Field Data Validity Report 

If you attempt to import List of Student data that contains errors and/or missing data, ACER Maple will 
produce an Import Field Data Validity Report (in Excel format) that contains information about these 
issues. Before you try to resolve them, make sure you have your List of Sampled Schools (LSS) handy.  
  

 

The Import Field Data Validity Report can contain multiple worksheets. Make sure you have 
checked the records in all worksheets in the report. 

5.5.1 Errors in List of Classes data 

Table 27 (page 94) lists errors that may appear in particular Error worksheets of the Import Field Data 
Validity Report when an LCL is imported. Table 27 also explains how these errors can be resolved. Most 
of the actions require updating the List of Classes Excel file. 

A file import error may also occur if the file you are attempting to import is not an Excel spreadsheet, 
or if no file was selected to import. In either case, locate the correct file and then attempt to import 
the LCL data again. 
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After all corrections have been made in the LCL Excel file, attempt to import the List of Classes data 
again. As long as errors exist within the LCL file for a particular school, you will not be able to import 
the LCL data. Class sampling for this school cannot proceed until the LCL has been imported 
successfully.  

If the situation arises where a school is not responding to queries, and you need to proceed with 
sampling before all errors have been corrected, you can replace any incorrect data with the 
appropriate missing code(s) (refer to the LCL codebook to find the correct missing codes for each 
variable). You can then proceed with sampling, and the missing codes will appear in the populated SCF 
Excel files as blank cells. You must then ensure that the SC updates the blank cells with the correct 
information before you proceed with student sampling. The updated data should be entered into ACER 
Maple using Update tracking data > Field Operation Forms (see Chapter 9) after the assessment. 

5.5.2 Warnings in List of Classes data 

Table 28 (page 95) lists discrepancies that may appear in Warning worksheets of the Import Field Data 
Validity Report when an LCL is imported and explains how they can be resolved.  

All discrepancies in Warning worksheets are related to missing codes in the data. It is always preferable 
to have non-missing data for number of students in each class before LCL data is imported. However, 
as described above, a situation may arise where a school is not responding to queries, therefore the 
missing codes are allowed. Sampling can then proceed, and the missing codes will appear in the 
populated SCF Excel files as blank cells. The SC must update the blank cells with the correct information 
before you proceed with student sampling. 
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Table 27: Import Field Data Validity Report for class lists: Errors worksheets – Possible warnings and their resolutions 

Description Error message in report How to resolve Action required  

Incorrect columns worksheet 

Excel file corresponds to a different 
template. 

OR 

Excel file is missing one or more columns. 

OR 

Excel file has one or more extra columns. 

OR 

Excel file has one or more columns with 
incorrect names. 

Incorrect columns:  
Missing – <Column Name>, 
Extra – <Column Name> 

• Check that you are selecting the correct 
List of Students Excel file to import and 
the correct template in ACER Maple. 

• Select the correct LCL Excel file to 
import or select the correct template 
in ACER Maple. 

OR 

• Add all missing columns 

OR 

• Delete all extra columns  

OR 

• Correct column names. 

Import duplication worksheet 

Data has already been imported for the 
same AMPL School No. 

Data for [AMPL School No.] 
‘X’ already imported 

• Check the AMPL School Numbers in the 
LCL Excel file. 

• Correct AMPL School No. in the LCL 
Excel file. 

OR 

• If the current AMPL School No. is 
correct, contact Clare Ozolins at 
Clare.Ozolins@acer.org to discuss 
your options. 

One or more rows contain a AMPL School 
No. and Line No. combination that has 
already been imported. 

Data for [AMPL School No.] 
and [Line No.] already exists 

• Check both AMPL School No. and Line 
No. in the LCL Excel file. 

• Correct AMPL School No. and/or Line 
No. in the LCL Excel file. 

Record duplication worksheet 

One or more rows contain a AMPL School 
No. and Line No. combination that has 
already been imported. 

Confidential data for [AMPL 
School No.] and [Line No.] 
already exists 

• Check both AMPL School No. and Line 
No. in the LCL Excel file. 

• Correct AMPL School No. and/or Line 
No. in the LCL Excel file. 

mailto:Clare.Ozolins@acer.org
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Description Error message in report How to resolve Action required  

Key violations worksheet 

There are one or more illegitimate AMPL 
School Numbers. 

[AMPL School No.] is 
illegitimate 

• Check the LSS– only the AMPL School 
Numbers provided there are legitimate. 

• Correct all AMPL School No. in the LCL 
Excel file. 

There are one or more missing values or 
empty cells for AMPL School Numbers. 

[AMPL School No.] is missing • Check AMPL School No. for the specified 
rows in the LCL Excel file. 

• Add correct AMPL School No. from the 
LSS to the LCL Excel file. 

Input line numbers are not sequential 
within a school. 

OR 

There are duplicate input line numbers 
within a school. 

[Line No.] is not sequential  • Check Line No. for the specified rows in 
the LCL Excel file. 

• Correct all Line No. in the LCL Excel 
file. 

Input line numbers do not begin at 00001 
for a school. 

[Line No.] does not begin at 
00001 

• Check Line No. for the specified rows in 
the LCL Excel file. 

• Correct all Line No. in the LCL Excel 
file. 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation rules. 

Description of validation rule 
violation(s) 

• Check the specified values against the List 
of Classes codebook for the specified 
rows in the LCL Excel file. 

• Correct all invalid values in the LCL 
Excel file. 

 

Table 28: Import Field Data Validity Report for class lists: Warning worksheets – Possible warnings and their resolutions 

Description Warning message in report How to resolve Action required 

LCL missing value(s) worksheet 

There are one or more missing values 
in a specific column. 

Missing value(s) in <Column 
Name> 

• Check the values in that column 
in the LCL Excel file. 

• Contact the school to get the 
information. 

• Update the LCL Excel file if it has not been 
imported yet. 

OTHERWISE 

• Make updates in the SCF form after sampling. 
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5.5.3 Errors in List of Students data 

Table 29 (page 97) lists errors that may appear in particular Error worksheets of the Import Field Data 
Validity Report when an LST is imported. Table 29 also explains how these errors can be resolved. Most 
of the actions require updating the List of Students Excel file. 

A file import error may also occur if the file you are attempting to import is not an Excel spreadsheet, 
or if no file was selected to import. In either case, locate the correct file and then attempt to import 
the LST data again. 

After all corrections have been made in the LST Excel file, attempt to import the List of Students data 
again. As long as errors exist within the LST for a particular school, you will not be able to import the 
LST data. Student sampling for this school cannot proceed until the LST has been imported successfully.  

If the situation arises where a school is not responding to queries, and you need to proceed with 
sampling before all errors have been corrected, you can replace any incorrect data with the 
appropriate missing code(s) (refer to the LST codebook to find the correct missing codes for each 
variable). You can then proceed with sampling, and the missing codes will appear in the populated STF 
Excel files as blank cells. You must then ensure that the SC/TA updates the blank cells with the correct 
information on or before the day of assessment. The updated data should be entered into ACER Maple 
using Update tracking data > Field Operation Forms (see Chapter 9) after the assessment. 

5.5.4 Warnings in List of Students data 

Table 30 (page 98) lists discrepancies that may appear in Warning worksheets of the Import Field Data 
Validity Report when an LST is imported and explains how they can be resolved.  

All discrepancies in Warning worksheets are related to missing codes in the data. It is always preferable 
to have non-missing data for gender or date of birth before LST data is imported. However, as 
described above, a situation may arise where a school is not responding to queries, therefore the 
missing codes are allowed. Sampling can then proceed, and the missing codes will appear in the 
populated STF Excel files as blank cells. The SC/TA must update the blank cells with the correct 
information on or before the day of assessment. 
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Table 29: Import Field Data Validity Report for List of Students: Error worksheets – Possible errors and their resolutions (all sampling options) 

Description Error message in report How to resolve Action required  

Incorrect columns worksheet 

Excel file corresponds to a different 
template. 

OR 

Excel file is missing one or more columns. 

OR 

Excel file has one or more extra columns. 

OR 

Excel file has one or more columns with 
incorrect names. 

Incorrect columns:  
Missing – <Column Name>, 
Extra – <Column Name> 

• Check that you are selecting the 
correct List of Students Excel file to 
import and the correct template in 
ACER Maple. 

• Select the correct LST Excel file to 
import or select the correct 
template in ACER Maple. 

OR 

• Add all missing columns 

OR 

• Delete all extra columns  

OR 

• Correct column names. 

Import duplication worksheet 

Data has already been imported for the 
same AMPL School No. 

Data for [AMPL School No.] 
‘X’ already imported 

• Check the AMPL School Numbers in 
the LST Excel file. 

• Correct AMPL School No. in the LST 
Excel file. 

OR 

• If the current AMPL School No. is 
correct, contact Clare Ozolins at 
Clare.Ozolins@acer.org to discuss 
your options. 

One or more rows contain a AMPL School 
No. and Line No. combination that has 
already been imported. 

Data for [AMPL School No.] 
and [Line No.] already exists 

• Check both AMPL School No. and Line 
No. in the LST Excel file. 

• Correct AMPL School No. and/or 
Line No. in the LST Excel file. 

Record duplication worksheet 

One or more rows contain a AMPL School 
No. and Line No. combination that has 
already been imported. 

Confidential data for [AMPL 
School No.] and [Line No.] 
already exists 

• Check both AMPL School No. and Line 
No. in the LST Excel file. 

• Correct AMPL School No. and/or 
Line No. in the LST Excel file. 

mailto:Clare.Ozolins@acer.org
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Description Error message in report How to resolve Action required  

Key violations worksheet 

There are one or more illegitimate AMPL 
School Numbers. 

[AMPL School No.] is 
illegitimate 

• Check the LSS– only the AMPL School 
Numbers provided there are legitimate. 

• Correct all AMPL School No. in the 
LST Excel file. 

There are one or more missing values or 
empty cells for AMPL School Numbers. 

[AMPL School No.] is missing • Check AMPL School No. for the 
specified rows in the LST Excel file. 

• Add correct AMPL School No. from 
the LSS to the LST Excel file. 

Input line numbers are not sequential 
within a school. 

OR 

There are duplicate input line numbers 
within a school. 

[Line No.] is not sequential  • Check Line No. for the specified rows in 
the LST Excel file. 

• Correct all Line No. in the LST Excel 
file. 

Input line numbers do not begin at 00001 
for a school. 

[Line No.] does not begin at 
00001 

• Check Line No. for the specified rows in 
the LST Excel file. 

• Correct all Line No. in the LST Excel 
file. 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation 
rules. 

Description of validation rule 
violation(s) 

• Check the specified values against the 
List of Students codebook for the 
specified rows in the LST Excel file. 

• Correct all invalid values in the LST 
Excel file. 

 

Table 30: Import Field Data Validity Report for student lists: Warning worksheets – Possible warnings and their resolutions 

Description Warning message in report How to resolve Action required 

<LST> missing value(s) worksheet 

There are one or more missing values in a 
specific column. 

Missing value(s) in <Column 
Name> 

• Check the values in that column in the 
LST Excel file. 

• Contact the school to get the 
information. 

• Update the LST Excel file if it 
has not been imported yet. 

OTHERWISE 

• Make updates in the tracking 
form after sampling. 
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5.6 Caution against Re-Importing Field Data 

5.6.1 Caution against Re-Importing List of Classes 

If classes have not yet been sampled in a school, you can re-import the LCL data using Import > Field 
data (as described in this section). However, do it only if the initial list was incorrect. For example, data 
for one school was uploaded for another school by accident or School Coordinator informed you that 
initial list was incorrect and sent an updated list. 
  

 

Do not re-import LCL data for a school in which classes have already been sampled unless: 

• students had not been sampled yet; and 

• you have agreed with ACER that you are permitted to do this; and 

• there is time to: 

1. re-sample classes; and  

2. inform School Coordinator that he/she needs to prepare lists of Students from 
different classes. 

If the above conditions are met, ensure that you delete Sampled Classes Form (SCF) 
produced from the incorrect List of Classes before re-importing the list. You must also make 
sure that the School Coordinator has deleted the previous SCF. 

If you found that classes have been sampled from an incorrect List of Classes but do not 
have time to re-sample and to send correct  SCF to the school, contact Clare Ozolins at 

Clare.Ozolins@acer.org. Explain what was wrong with the initial List of Classes and include 
the correct List of Classes with your e-mail. 

 

5.6.2 Caution against Re-Importing List of Students 

If students have not yet been sampled in a school, you can re-import the LST data using Import > Field 
data (as described in this section). 

If students have already been sampled in a school and you need to update demographic data for any 
students, you should not re-import the LST data into ACER Maple using Import > Field data. Updates 
to demographic data for students that have already been sampled should be made using Update 
tracking data > Field Operation Forms (see Chapter 9) after the assessment. 

If students have already been sampled in a school, the LST data should only be re-imported if the initial 
list was seriously compromised. For example, data for one school was uploaded for another school by 
accident. Or students from non-sampled classes were included in the LST by School Coordinator. 
  

 

Do not re-import LST data for a school which has already sampled students unless there is 
time to: 

3. re-sample students; and  

4. send the updated tracking forms to the school; and 

5. you have agreed with ACER that you are permitted to do this. 

If the above three conditions are met, ensure that you delete all tracking forms produced 
from the incorrect List of Students before re-importing the list. You must also make sure 
that the School Coordinator has deleted the previously received tracking forms. 
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Chapter 5: Preparing and importing data AMPL DMM 

ACER © 2023 Commercial in Confidence Page 100 of 207 

If you found that students have been sampled from a seriously compromised List of Student 
but do not have time to re-sample and to send correct tracking forms to the school, contact 
Clare Ozolins at Clare.Ozolins@acer.org. Explain what was wrong with the initial List of 
Student and include the correct List of Students with your e-mail. 

 

5.6.3 Re-Importing field data 

To re-import any LST data for a school which has already been imported into ACER Maple: 

1. On the Main screen select Import and then click Activate. The Import field data screen will 
appear (Figure 63). 

 
Figure 63: Import field data screen 

2. In the Available Templates drop-down list select the relevant template. 

3. Click Browse… and manually enter or navigate to the location of the Excel file containing the LST 
data to be imported. 

  

 

The Excel file selected for re-importing must match the template selected in the Available 
Templates drop-down list. 

4. In the Options list select ‘Replace specific records’. 

5. Click Import. ACER Maple will attempt to import the LST data from the selected Excel file, 
replacing the previously imported LST data for this school. 

6. ACER Maple then performs a number of validity checks on the data in the selected Excel file. The 
possible outcomes and required actions are described in Table 31 on the following page. 

Some warnings may not require any corrections in the data. It is also possible that after corrections 
have been made, some errors still remain. In this case, when you try to re-import the List of Student 
data, the validity report will be produced again. 
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Table 31: Scenarios when re-importing List of Student data for a school 

Scenario Message Next steps 

Students have not been 
sampled for this school, no 
errors or warnings. 

Data have been validated. No errors. 
No warnings. 

Please click Continue. 

• Click Continue. 

Students have not been 
sampled for this school, 
errors or warnings. 

Data contains errors and cannot be 
imported into the ACER Maple 
database. 

Please download the validity report. 

1. Click Download Validity Report. 

2. Follow the instructions in the 
relevant sub-sections of section 5.5 
to address the errors and/or 
warnings in the Import Field Data 
Validity Report. 

Students have been 
sampled for this school. 

AMPL School No. ‘X’ has been 
already sampled. 

Have you discussed the issue with 
sampling contractor? 

If Yes: 

All data for AMPL School No. ‘X’ will 
be replaced. 

Have you backed up your data? 

• Only click OK if: 

 you are sure there is enough 
time to re-sample students and 
send the updated tracking forms 
to the school; 

 the old tracking forms are 
deleted by you and by the 
School Coordinator before you 
produce new tracking forms; 
and 

 you have permission from ACER 
to do so. 

To obtain permission from ACER 
contact Clare Ozolins at 
Clare.Ozolins@acer.org, explaining 
what was wrong with the initial LST 
and attaching the correct LST to the 
message. 

OTHERWISE 

• If you do not have time to re-
sample and to send the correct 
tracking forms to the school, or 
do not have permission from 
ACER, click Cancel. 

 

mailto:Clare.Ozolins@acer.org
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6 SAMPLING 
 

 

A data administrator login must be used for the following function. 

After an LST has been successfully imported into ACER Maple, the students for that school can be sampled. 

To sample the students for a school, and allocate each student the appropriate instruments: 

1. On the Main screen select Sample and allocate instruments > Sample and allocate and then click 
Activate. The Sample and allocate instruments screen will appear (Figure 64). 

 
Figure 64: Sample and allocate instruments screen 

2. In the Select Population Type box select: 1: classes OR 2: students depending on whether you are 

sampling classes or students. 

3. In the Select Combined Option box select the available option. The option will be: 

2 - if you are sampling classes; OR 

XXX - if you are sampling students; XXX is assigned on your LSS in the Student combined option column 

and is usually, but not always is a standard ISO 3-letter code for your country (see Table 2 or your LSS). 

You have to select the option even if there is only one. 

4. In the Select School Type list keep ‘Main’ selected (unless you need to sample a replacement school). 
  

 

Do not select ‘Already sampled’ unless this has been agreed with ACER sampling team. 
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5. Click List Available Institutions to Sample. In the Available for Sampling box the AMPL School Number 
of all schools which are available for sampling will be listed (Figure 65). 

 
Figure 65: Schools available for sampling listed in the Available for Sampling box 

6. In the Available for Sampling box select the AMPL School Numbers of all schools to be sampled. Use 
Shift and/or Ctrl to select multiple schools as required (Figure 66). 

 
Figure 66: Selecting multiple schools in the Available for Sampling box 

7. Click  to move these schools into the Selected for Sampling box (Figure 67)12, the Sample button 
will appear. 

 

 

 

12 To remove schools from the Selected for Sampling field select the MILO School Numbers in this field and then click . 
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Figure 67: Multiple schools moved to the Selected for Sampling box 

8. Click Sample. ACER Maple will draw the sample. You will receive a pop-up confirmation that “School is 
sampled”. 

9. Click OK. 

 If you are sampling classes you will have an Instrument allocation warning that no allocation had 
been done. Click OK. 

 If you are sampling students, ACER Maple allocate instruments to the sampled students for the 
selected combined option in the selected schools and tells you that. Click OK. 

During the sampling and instrument allocation process ACER Maple will perform some validity checks of the 
data. The possible outcomes and required actions are described in Table 32. 

Table 32: Scenarios when using the Sample and allocate function 

Outcome  Next steps 

• Sampling and allocation successful, no 
discrepancies found. 

• Messages: ‘The selected Institutions have been 
sampled’ AND ‘Instruments have been allocated to 
the selected population in all selected institutions’ 

1. Click OK for each message. 

2. Proceed to populate tracking forms with data for 
these schools (Chapter 7). 

OR 

Complete sampling and allocation of instruments 
for another set of schools. 

• Sampling successful but the data contains some 
discrepancies that should be checked (warnings). 

• Message: ‘No allocation in background/initial data 
for this case’ 

The Sampling Validity Report is available for download. 

1. Download the Sampling Validity Report. 

2. Contact ACER Helpdesk at 
maplehelpdesk@acer.org; include your 3-letter 
NC code, a short description of the problem in the 
subject line. Attach report. 

 

mailto:
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7 POPULATING SCF AND STF TEMPLATES WITH 
SAMPLING DATA 

7.1 Populating SCF and STF templates with data from ACER Maple....................................... 105 

7.2 Export Field Data Checks .................................................................................................. 111 
 

7.1 Populating SCF and STF templates with data from ACER 
Maple 

 

A data administrator login must be used for the following function. 

After sampling the STF Excel templates need to be populated with sampled students’ data. 

To populate the STF templates with data: 

1. On the Main screen select Export > Field data and then click Activate. The Export field data 
screen will appear (Figure 68). 

 
Figure 68: Export field data screen 

2. In the Select Population Type box select: 

1: classes, if populating SCF; or 

2: students, if populating STF 

In the next two steps select the available option even if there is only one. 
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3. In the Select Combined Option select: 

2, if populating SCF; OR 

XXX - if you are sampling students; XXX is assigned on your LSS in the Student combined option 

column and is usually, but not always is a standard ISO 3-letter code for your country (see Table 2 
or your LSS). 

4. In the Select Sampling Level box select Main Sample. 

5. Click List Available Institutions to Export.  

6. In the Available for Export box the AMPL School Numbers of all schools whose STF is available to 
populate with data will be listed (Figure 69). 

 
Figure 69: Schools available to populate tracking forms with data are listed in the Available for Export box- 

7. In the Available for Export box select the AMPL School Numbers of all schools for which you are 
going to generate SCF or STF. Use Shift and/or Ctrl to select multiple schools as required (Figure 
70). 

 
Figure 70: Selecting multiple schools in the Available for Export box 

8. Click  to move these schools into the Selected for Export box (Figure 71). To remove schools 

from the Selected for Export box select their AMPL School Numbers and then click  

Once schools have been added to the Selected for Export box the Select excel template(s) button 
will appear. 
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Figure 71: Multiple schools moved to the Selected for Export box 

9. In the Select Template(s) box select the template displayed on your screen. 
  

 

A template must be selected in the Select Template(s) box although only one template is 
listed in this box for the AMPL NCs. 

10. Click Select excel template(s). A pop-up window will appear asking you to select the 
corresponding Excel file template (Figure 72). 

 
Figure 72: Pop-up to select the Excel file template  

11. Click Browse and manually enter or navigate to the location of the Excel template which matches 
the template selected in the Select Template(s) box. 

  

 

The Excel template selected in the folder must match the template selected in the Select 
Template(s) box. If this is not the case, it will cause an error and the export will be 
terminated. See section 7.2 for details 

The Excel template will be uploaded into ACER Maple and its file name will appear in a tab beside 
the Browse button  

Click Submit selection. The Export button will appear at the bottom of the screen.  

12. Click Export. ACER Maple will generate templates populated with data for the selected sampled 
population, combined option, sampling level, schools, and template. These populated forms will 
be combined into one zip file which will be available for download (Figure 73).  
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Figure 73: Downloaded zip file containing populated tracking forms 

13. Select ‘Save File’(Figure 73). 

14. Click OK and save the zip file in an appropriate location. 

15.  After the file has downloaded, unzip it.  
 

 

Each of the tracking forms will have the following file name: 
<Template◦acronym>_<AMPL◦School No.>_<School name>_<Date>. 

For example, the STF for school 1 produced on the 30 May 2023 will have the file name 
STF_1_2023_05_30. Keep these nameing convention for all tracking forms. 

 

• If you have generated Sampled Classes Form (see example in Table 33), you need to 
communicate class names to School Coordinators and to send to the SC: 

 an LST Excel template with Information worksheet filled as required (see section 4.5) with 

 instructions on how LST for sampled classes should be filled. 

• When preparing Student Tracking Form for Test Administrators:  

 if your NC assess two grade levels divide the file in two: one for lower grade and one for upper 
grade; 

 use your records to complete the School Coordinator and Test Administrator names; 

 provide dates for Day 1 and Day 2 of the assessment if they have already been agreed with 
the school. 

An example of an STF form ready for assessment administration is provided in Table 34, page 
110. 

 Save two forms using the following file name:  
STF_<AMPL School No.>_G<Lower grade>_<Date>_<SchoolName>_TAReady and 
STF_<AMPL School No.>_G<Upper grade>_<Date>_<SchoolName>_TAReady. 

 

For example, the form provided in Table 34 can be saved as 
STF_1_G6_2023_05_30_School123_TAReady. 

 

16. Send this form electronically to School Coordinator to check, or print it and send it by post. 
  

 

It is recommended that all tracking forms are sent in electronic format to the School 
Coordinator. If possible the Test Administrator can then use the electronic version during 
the assessment, as well as for updating data on the tracking forms. The forms, once they 
have been updated after the assessment, can then be returned in electronic format and no 
additional manual data entry will be required. 
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17. You are ready now to produce labels and package the field operation materials for the School 
Coordinator and Test Administrator (see Chapter 8). 

Table 33: Example SCF (two grade levels assessed). 

School Name Nat. School ID AMPL School No. School Co-ordinator 

School 123 ZZA123 1  Mr SC ABC 

Class Name Class ID 
Grade 
Level 

No. of 
Students 

Comments 

4A 00001 4 30   

6A 00005 6 33   
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Table 34: Example STF ready to be sent to Test Administrator and School coordinator for administration of grade 6 assessment. 

1 
School Name AMPL School No.  School Coordinator  

Test 
Administrator 

 
 Session Date 1 

(DD/MM) 
Session date 2 (DD/MM) 

2 
School 123 1001 

 Mr SC ABC 
Ms TA 
XYZ 

 
 30/05 

31/05 

3  LST 
 

 
F=1; 
M=2 MM YYYY  Attendance 

Participation 
Class  

4 
Student Name Line No. 

AMPL 
Participant ID 

Test 
Form 

Gender 
Month of 

Birth 
Year of 
Birth 

SEN Test  StQ LG UG 
Grade 
Level 

Class 
Name 

Comments 

5 Xab Yac 00001 92100106 5 1 01 2010 0 1 1 9 1 6 6C  

6 Xac Yad 00002 92100104 6 1 11 2011 0 0 1 9 0 6 6C  

7 Xaf Yag 00004 92100105 7 2 09 2010 0 1 0 9 0 6 6C  

8 Xad Yaf 00005 92100101 8 1 08 2010 0 0 0 9 1 6 6C  

9 Xaj Yak 00006 92100103 3 2 05 2010 1 1 1 9 0 6 6C  

10 Xab Yac 00008 92100108 4 1 03 2010 0 0 1 9 1 6 6C  

11 Xb Yacd 00009 92100102 5 2 12 2010 0 1 0 9 1 6 6C  

12 Xab Yah 00010 92100109 6 2 11 2010 0 1 1 9 1 6 6C  

13 Xak Yalk 00011 92100107 7 1 03 2010 1 0 0 9 0 6 6C  

14 Xkl Yvb 00012 92100110 8 2 05 2010 0 0 0 9 0 6 6C  

15 Xab Yfg 00014 92100115 3 1 06 2010 0 0 0 9 0 6 6C  

16 Xab Ykm 00015 92100120 4 2 02 2010 0 0 0 9 0 6 6C  

16 Xed Ygbn 00016 92100111 5 2 04 2009 0 0 0 9 0 6 6C  

18 Xsd Ymnv 00017 92100116 6 1 10 2010 0 0 0 9 0 6 6C  

19 Xcv Ywdj 00018 92100112 7 2 07 2010 0 0 0 9 0 6 6C  

20 Xth Ysdf 00020 92100117 8 1 04 2010 2 0 0 9 0 6 6C  

21 Xwe Ywsc 00021 92100113 3 1 08 2010 0 0 0 9 0 6 6C  

22 Xab Yuhj 00022 92100114 4 2 03 2010 0 0 0 9 0 6 6C  
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7.2 Export Field Data Checks 

When the Export > Field data function is used, ACER Maple checks that the tracking form template 
selected in ACER Maple matches the selected tracking form Excel template. Table 35 on the following 
page gives detailed information about the types of inconsistencies that may appear.  

<Template selected on screen> in Table 35 refers to the template selected on the Export field data 
screen. Error messages appear in pop-up windows with the title: ‘Problem with excel template for 
exporting <Template selected on screen>’. For example, if the STF_ENG template was selected the title 
will be: ‘Problem with excel template for exporting STF_ENG’. 

‘Row X’ in Table 35 refers to the row in the original unmodified template containing the heading titles 
(before any national adaptations were made). For example, in the STF_ENG template this is row 4. 
Therefore, the message will display: ‘Make sure that the column headers are in row number 4’. 

After all corrections have been made, attempt to generate the populated STF again. 
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Table 35: Messages when generating tracking forms populated with data 

Description Pop-up error message  How to resolve Action required 

Excel file is missing one or more columns. 

OR 

Excel file has one or more extra columns. 

OR 

Excel file has one or more columns with 
incorrect names. 

OR 

Excel file corresponds to a different 
template. 

Column headings in Excel file must 
correspond to the column names 
in <Template selected on screen> 

Make sure that the column 
headers are in the row number X 

• Check that you are selecting 
the correct Excel file to 
export and the correct 
template in ACER Maple. 

OTHERWISE 

• Carefully check all 
adaptations you made in the 
template of the Excel file and 
in ACER Maple when you 
modified the corresponding 
ACER Maple template. 

• Select the correct Excel file to import 
or select the correct template in 
ACER Maple. 

OR 

• Add the missing columns or modify 
the template in ACER Maple as 
required. 

OR 

• Delete any extra columns or modify 
the template in ACER Maple as 
required. 

OR 

• Correct the column names or modify 
the template in ACER Maple as 
required.  

• Make sure that the column headings 
are in the correct row. 

Excel file does not have any column 
headings in the row where the column 
headings are expected by ACER Maple. 

Column headings in the selected 
file are expected to be in row X 

This row in the selected excel file 
does not hold any data (empty 
cells) 

• Check that you are selecting 
the correct Excel file to 
export and the correct 
template in ACER Maple. 

OTHERWISE 

• Correct the template. 

• Select the correct Excel file to import 
or select the correct template in 
ACER Maple. 

OR 

• Make sure that the column headings 
are in the correct row. 

Some other file (not an Excel file) was 
selected by mistake to be populated with 
data. 

Please select an excel file (.xls, 
.xlsx) to upload 

• Select the correct file. • Select the correct file. 
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8.1 Using Mail Merge Function in Microsoft Word 

The Mail Merge function in Microsoft® Word allows users to create documents or labels by populating them 
with data from a Microsoft® Excel worksheet.  

The Mail Merge procedure for the AMPL is designed to produce the labels that will be attached to the cover 
of each of the assessment instruments.  

• Two labels must be printed for each student: 

 One label for each test form assigned to students on the STF; and 

 One label for the Student Questionnaire. 

• One label should be printed for each School Questionnaire. It is convenient to create a separate folder 
for labels. This folder is called Labels in this chapter. 

To create labels, you will need to use the following functions: 

1. The Export List of Candidates function in ACER Maple exports excel worksheets containing student and 
principal data required for labels. This function exports the list of all candidates that were sampled in 
the relevant administrative domain, i.e. in all schools associated with a given Admin ID account (section 
8.2). 

2. The Mail Merge function to create labels in a Microsoft® Word document (section 8.3).  

The Word document can then be printed on the adhesive labels which will be attached to the printed 
assessment instruments. 

8.2 Exporting labelling forms 

After student tracking forms have been populated with sampled students’ data, lists of student candidates 
can be exported and used to produce the required labels for each survey instrument. 
 

 

A data manager or data administrator login must be used for the following function. Data 
manager can export data for all sampled candidates in the entity and data administrator can 
export data for all sampled candidates in their administrative domain 

 

To export the required excel files from ACER Maple: 

1. On the Main screen select Export > List of Candidates and then click Activate. The Export list of 
candidates screen will appear (Figure 74). 
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Figure 74: Export list of candidates screen 

2. Click the Select Templates field at the top of the screen. A drop-down list will appear. 

3. Select the following templates:  

• AMPL Student Labelling Form (AMPL_SALF) 

• AMPL School Questionnaire Tracking Form (AMPL_SQTF) 

4. Once template(s) have been selected, the Export button will appear at the right bottom corner of the 
Export list of candidates screen (Figure 75). 

 
Figure 75: The Export button at the bottom of the screen 

5. Click Export (Figure 75). All selected files will be combined into one zip file which will be available for 
download (Figure 76).  

 
Figure 76: Save list of candidates 

6. Select ‘Save File’ and click OK to save the zip file. Manually enter or navigate to an appropriate location 
to save the file.  

7. After the zip file has been downloaded, unzip the Excel files into your Labels folder. 
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8. Open the exported AMPL_SALF data file saved in your Labels folder (see example in Table 36). Columns 
A-G contain information that will be mail-merged into labels.  

  

 

Column H specifies to which test form the label must be assigned. 

For example:  

• the label with the student ID=286100103 should be assigned to Test Booklet 5 (highlighted 
in red in Table 36); while 

• the label with the student ID=286100108 should be assigned to Test Booklet 6 (highlighted 
in green in Table 36), 

Table 36: Example of SALF data in Excel format to be used for labelling Student Test Forms and Questionnaires 

 A B C D E F G 

2 School Name AMPL School No. Grade Level Class Name Student Name AMPL Participant ID Test Form 

3 School 123 1 6 6C Xab Yac 28000103 5 

4 School 123 1 6 6C Xac Yad 28000108 6 

5 School 123 1 6 6C Xaf Yag 28000101 7 

6 School 123 1 6 6C Xad Yag 28000102 8 

7 School 123 1 6 6C Xaj Yak 28000112 3 

8 School 123 1 6 6C Xab Yac 28000104 4 

9 School 123 1 6 6C Xerb Yjkl 28000118 5 

 

9. Open the exported AMPL_SQTF data file saved in your Labels folder (see example in Table 37).  

 Column A exported empty and must be filled from the LSS file before it can be merged into labels.  

 Columns B-C are ready to be mail-merged into labels.  

 Columns D and E remain empty at this stage. They must be filled after School Questionnaires are 
returned to the NC (see section 9.3 for details).  

Table 37: Example of SQTF data in Excel format to be used for labelling School Questionnaires 

 A B C D E 

1 School Name AMPL School No. AMPL Participant ID Participation Code Comment 

2 School 123 1 38000101   

3 School 124 2 38800201   

4 School 125 3 38000301   

 

8.3 Creating Labels 

When the Student Data Labels (i.e. SDL) Excel file(s) is ready, you need to prepare your adhesive labels for 
printing. You will need to know the supplier and product number of your labels. Once you have this 
information you will be able to: 

1. Specify your label types and field titles in Word documents as explained in section 8.3.1. 

2. Populate this Word document with data and print your labels as explained in section 8.3.2 
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8.3.1 Specifying label type 

To specify label types: 

1. Open a new Word document. 

2. In the menu bar, click Mailings > Start Mail Merge > Labels. The “Label Options” dialog box will appear 
(Figure 77) 

 
Figure 77: Mail Merge Label Options dialog box 

3. Select your label supplier from the ‘Label vendors’ drop-down list.  

4. Select the product number from the “Product number” list13.  

5. The document should now display a table with an outline of the labels. If you don’t see the outline of 
the labels, go to Table Tools > Layout >View Gridlines. 

6. In the first label provide the following field titles: 

School Name  

AMPL School No.  

Grade Level 

Class Name 

Student Name 

AMPL Participant ID 

Booklet No. 

7. Save your document in the Labels folder with the file name TestLB_type. 

8. Repeat steps 1-5 to create labels for Student Questionnaires. 

9. In the first label provide the following field titles: 

School Name  

AMPL School No.  

Grade Level 

Class Name 

Student Name 

AMPL Participant ID 

10. Save your document in the Labels folder with the file name STQLB_type. 
 

 

 
13 If none of the options match your label package, choose “New Label”, enter your label’s information, and give it a name. Choose 
“OK” to add the new label to the “Product number” list. 
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11. Repeat steps 1-5 to create labels for School Questionnaires. 

12. In the first label for School Questionnaires provide the following field titles: 

School Name  

AMPL School No.  

AMPL Principal ID  

13. Save your document in the Labels folder with the file name SCQLB_type. 

8.3.2 Populating the STLB_type document with data and printing labels 

To populate the TestLB_type document with data and to print labels for Test forms: 

1. Open the TestLB_type document you created in section 8.3.1. 

2. Save a copy of the TestLB_type document with the date in the file name. 

3. In the menu bar, click Mailings > Select recipients > Use an existing list. 

4. Locate and open the Excel file containing the data for the school(s) for which you are creating labels 
(created in section 8.2).  

5. In the first label in the TestLB_<Date> document, insert the following fields: 

 Click Mailings > Insert Merge Field > School_Name next to the School Name title 

 Click Mailings > Insert Merge Field > AMPL_School_No. next to the AMPL School No. title 

 Click Mailings > Insert Merge Field > Grade_Level next to the Grade Level title 

 Click Mailings > Insert Merge Field > Class_Name o. next to the Class Name title 

 Click Mailings > Insert Merge Field > Student_Name. next to the Student Name title 

 Click Mailings > Insert Merge Field > AMPL_Participant_ID next to the AMPL Participant ID title 

 Click Mailings > Insert Merge Field > Booklet_No. next to the Booklet No. title 

6. Click Mailings > Update Labels. The result should be similar to what is shown in Figure 78 (depending 
on your label size) 

School Name «School_Name» 

AMPL School No. «AMPL_School_No» 

Grade Level «Grade_Level» 

Class Name «Class_Name» 

Student Name «Student_Name» 

AMPL Participant ID «AMPL_Participant_ID» 

Booklet No. «Test_Form» 
 

 «Next Record»School Name «School_Name» 

AMPL School No. «AMPL_School_No» 

Grade Level «Grade_Level» 

Class Name «Class_Name» 

Student Name «Student_Name» 

AMPL Participant ID «AMPL_Participant_ID» 

Booklet No. «Test_Form» 
 

Figure 78: Mail Merge document with fields inserted 

7. Click Mailings > Finish & Merge > Print Documents to populate document with data and print labels. 
An example of labels to be printed is shown in Figure 79. 



Chapter 8: Labeling and Packaging Assessment Materials AMPL DMM 

ACER © 2023 Commercial in Confidence Page 118 of 207 

School Name School 124 

AMPL School No. 2 

Grade Level 4 

Class Name 4D 

Student Name Xac Yad 

AMPL Participant ID 28000201 

Booklet No. 7 
 

 School Name School 124 

AMPL School No. 2 

Grade Level 4 

Class Name 4D 

Student Name Xac Yad 

AMPL Participant ID 28000202 

Booklet No. 8 
 

Figure 79: Labels ready to be printed 

8. To prepare labels for Student Questionnaires Repeat steps 2 to 7 using the STLB_type document you 
created in section 8.3.1 with the pre-populated SALF. 

9. To prepare labels for School Questionnaires Repeat steps 2 to 7 using the SQLB_type document you 
created in section 8.3.1 with the pre-populated SQTF that was despatched with ACER Maple. 

8.4 Labelling and Packaging Materials for Test Administrators 

To label and package materials: 

1. For each student in an SALF label file (created in section 8.3), print a copy of their ID label for test and a 
copy of their ID label for the questionnaire. 

2. Print STF for each school. 

3. Sort test forms in the order they are assigned in the STF. For example, if the first student in the STF is 
assigned form 5, the test forms should be sorted as follows: 5,6,7,8,3,4,5,…. 

4. Prepare as many copies of the Student Questionnaires as there are students listed in the STF. 

5. Prepare a copy of the school Questionnaire. 

6. Locate ALL labels printed for this school (for Test, Student Questionnaires and School questionnaire). 
Foe ALL labels located: 

 Make sure that AMPL School No. in the STF and on labels is the same. 

 Make sure that the school name in the STF and on labels is the same. 

7. Assign labels to the test booklets for the school. Assign labels to the Student Questionnaires in the 
order as students listed in the STF. 

8. Assign a label for the same school to the School Questionnaire 

9. Add the required number of the unlabelled instruments (at least one of each test form type and a 
Student Questionnaire) in case if replacement is required. 

10. Bundel instruments with the STF, and other documentation as required by Field Ops 
Manual_AMPLab_v0.114, section 6.5. 

 

 

 
14 
https://acerlimited.sharepoint.com/:b:/r/sites/AMPLab/Shared%20Documents/General/Manuals_Guides_Resources/Field%20Ops
%20Manual_AMPLab_v0.1.pdf?csf=1&web=1&e=s29whj 

 

https://acerlimited.sharepoint.com/:b:/r/sites/AMPLab/Shared%20Documents/General/Manuals_Guides_Resources/Field%20Ops%20Manual_AMPLab_v0.1.pdf?csf=1&web=1&e=s29whj
https://acerlimited.sharepoint.com/:b:/r/sites/AMPLab/Shared%20Documents/General/Manuals_Guides_Resources/Field%20Ops%20Manual_AMPLab_v0.1.pdf?csf=1&web=1&e=s29whj
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9.6.1 Preparing data in the School Participation Form ............................................................. 134 
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9.7 Update Institution Participation Validity Report .............................................................. 137 

 

Test Administrators must return ALL assessment materials and resources to the NC, using a secure 
service. These materials must be carefully checked and sorted in preparation for data entry as outlined 
below and explained in detail in the corresponding sections of this chapter. 

To prepare materials for data entry, all data administrators will need to: 

1. Check student assessment instruments against the STF and prepare them for data entry (section 
9.1). 

2. Conduct internal STF data checks (section 9.2). 

3. Check the school questionnaire and record its receipt in the SQTF (section 9.3)  

4. Update STF and SQTF data in ACER Maple (sections 9.4-9.5). 

5. After all materials from all schools have been returned, update school participation in ACER 
Maple (sections 9.6-9.7). 

9.1 Preparing Student Assessment Instruments for Data Entry  

When materials have been received from the Test Administrators after the assessment, data 
administrators must check test forms and questionnaires against STF Attendance codes (i.e. the 
attendance code recorded by the TA on the STF), and then prepare them for data entry in ACER Maple.  

Most of the returned student assessment instruments will have responses, but some of them will 
remain empty. These are either spares or instruments that were intended for students that did not get 
completed. Each data administrator will therefore need five boxes to sort the instruments from the 
schools that belong in their domain:  

• one box for empty student assessment instruments; and  

• a number of boxes for completed (or partially completed) student assessment instruments: 
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 one box for each of the AMPL Test Forms; and 

 one box for the AMPL Student Questionnaires. 

Instruments in each of these boxes should be sorted by AMPL school ID and by AMPL student ID within 
each school.  
  

 

All instruments must be kept secure and in order. 

 

9.1.1 Sorting student assessment instruments that have correct corresponding 
STF Attendance codes 

Table 38 shows correct STF Attendance codes for empty instruments, and for instruments with at least 
one response. It also shows how to sort the instruments in the corresponding boxes depending on 
whether they are empty or not.  

<X> in Table 38 is the booklet number (e.g. 1,2,…). The box labels are provided as an example for the 
purpose of explaining the sorting procedure. You can label them in another way if you prefer 

Table 38: STF Attendance codes for empty instruments and for instruments with at least one response 

STF Attendance 
code 

Student assessment instruments Box labelled 

Test=1 AMPL Test Form <X> with at least one response. DE<X> 

Test=0 Empty AMPL Test Form X. EMPTY 

StQ=1 AMPL Student Questionnaire with at least one response. DEQ 

StQ=0 Empty AMPL Student Questionnaire. EMPTY 
 

9.1.2 Preparing student assessment instruments that have incorrect 
corresponding STF Attendance codes for enquiries 

If there is a discrepancy between the STF Attendance code and the content of an instrument, then the 
instrument will need to be put aside, and the record in the STF should be flagged as requiring 
investigation. 
  

 
Examples 

1. If the Test=1 and the AMPL Test Form with the same student ID is empty, then the 
record in the STF must be flagged for investigation and the Test Form placed in the 
EMPTY box. 

2. If Test=0 and the AMPL Test Form with the same student ID has at least one 
response, then the record in the STF must be flagged for investigation and the 
booklet will need to be placed aside in case it requires a different label. 

 

After all booklets are checked, the data administrator needs to check the STF for internal discrepancies 
(see section 9.2). Once the STF has been checked, the data administrator or the data manager must 
contact the Test Administrator and/or School Coordinator to resolve discrepancies, correct the STF if 
required, and sort any instruments with discrepancies (see 9.2.4). 
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9.2 Conducting Internal STF Data Checks 

 

 

If STFs have been sent in electronic format to the School Coordinator and the Test 
Administrator, and the Test Administrator used the electronic version of the STF during the 
assessment to update data, then the STFs can also be returned in electronic format once 
they have been updated after the assessment. This will mean that no additional manual 
data entry will be required in the STF Excel files. 

  

 

If the STF has been returned in paper format, you will need to manually update the 
corresponding electronic Excel versions of the tracking forms that were initially populated 
with sampled students’ data (see chapter 7) before they can be updated in ACER Maple. 

 

The first thing you need to do when you receive a completed STF back from a school, is check the data 
that has been updated by the School Coordinator and Test Administrator. 

The data you need to check includes: 

• student demographic data (grade, gender, date of birth);  

• SEN codes against participation codes; and 

• participation codes against attendance codes. 

These checks are all explained in the following subsections. 

9.2.1 Checking student demographic data 

The following checks are required for student demographic data:  

• If the class name includes grade level, check that it is the correct grade for your country: 

• check that each students’ date of birth is within a reasonable range for the year level assessed in 
your country; 

• check that each students’ gender corresponds to the student names (wherever possible). 

Highlight any suspicious records in the STF. 

9.2.2 Checking SEN codes 

The box below lists all valid SEN codes for Student Tracking Forms in the  AMPL. 
  

 

SEN codes for student tracking forms for the  AMPL: 

0 – No SEN condition 

1 – Functional disability 

2 – Cognitive, behavioural, or emotional disability 

3 – Limited assessment language experience 

Check that  

• ALL SEN codes are valid (i.e. ALL SEN codes are less than or equal to 3); and 

• Participation code ‘3’ (excluded on SEN basis) is only assigned to students with SEN > ‘0’.  
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Highlight any discrepant records in the STF. 

9.2.3 Checking Participation codes against Attendance codes 

Valid STF Participation codes (columns LG and UG): 

1 – Participant 

2 – Parent refusal 

3 – Excluded on SEN basis 

4 – Now enrolled at another school 

5 – Not enrolled in this school, enrolment unknown 

9 – Population ineligibility 

0 – Non-participant for any other reason 

Valid STF Attendance codes (columns Test and StQ): 

1 – Attended Test/StQ 

0 – Did not attend Test/StQ 
  

 

At this stage, a student is considered to be a ‘participant’ (code ‘1’) if he or she attended a 
session for at least one of the instruments (i.e. provided at least one response in one of the 
instruments which has been marked with Attendance code ‘1’). 

 

For each record in the STF check the following:  

• if the STF Participation code is ‘1’, then at least one of the Attendance codes is ‘1’; and 

• if all three Attendance codes are ‘0’, the STF Participation code is NOT ‘1’. 

Highlight any discrepant records in the STF. 

9.2.4 Enquiring about discrepancies 

If any records have been highlighted in the STF, contact the Test Administrator and/or School 
Coordinator to find which data is correct and to update the STF as required.  

In cases where a student completed the wrong instrument (i.e. Student A completed student B’s 
instrument(s)), you will need to replace the label on student B’s instrument with the label for student 
A. 

Also make enquiries about missing data. 
  

 

Make every attempt to recover any missing data. It is extremely important for data analysis 
that demographic data for every student is available. 

 

After all discrepancies have been resolved sort the instruments into appropriate boxes as indicated in 
Table 38 (page 120) 
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9.3 Receiving AMPL School Questionnaires 

The School Questionnaire Tracking Forms (SQTF) had been exported for each domain when materials 
were prepared for schools (see section8.2). SQTF had been pre-populated by ACER Maple with the list 
of IDs for all principals in each domain  

On receipt of materials from the Test Administrators, the data administrator must check the 
AMPL◦School Questionnaire and record the following in their SQTF: 

• Any AMPL School Questionnaires that have at least one response must be recorded as ‘1’-
‘Returned’ in the SQTF, sorted by AMPL School Number, and securely stored for data entry. 

• Any empty AMPL School Questionnaires should be separated, sorted by AMPL School Number, 
and securely stored in the EMPTY box. The code that should be entered in the SQTF depends on 
the reason the questionnaire was empty (see Table 39). 

Table 39: School Questionnaire participation codes to be entered into SQTF 

Code Code meaning 

1 Questionnaire returned and filled 

2 Questionnaire returned empty 

0 Questionnaire sent but has not been recovered 

9 Questionnaire had NOT been sent (school did not participate) 

Once all school questionnaires that have been received back from schools have been recorded in the 
SQTF, update the SQTF for any remaining schools as indicated in Table 39. 
  

 

A school questionnaire code is required for each school. 

  

 

The length of a comment is restricted to 500 characters. If more space is required please 
include the AMPL School Number and your comment in the Sampling Data Submission 
Checklist. 

 

Save a copy of the completed SQTF Excel file with “_For_Import” added to the end of the file name.  

Ensure that the new file is saved in a suitable location, so that it can be uploaded into ACER Maple 
(instructions are provided in section 9.4). 

9.4 Updating Data from Tracking Forms in ACER Maple 

Once the updated data in a tracking form has been checked and corrected, the data needs to be 
updated in ACER Maple. 
  

 

A data administrator login must be used for the following function. 

To update data from tracking forms after the assessment: 

1. On the Main screen select Update tracking data > Field operation forms and then click Activate. 
The Update field operation forms screen will appear (Figure 80). 
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Figure 80: Update field operation forms screen 

2. In the Available Templates drop-down list select the relevant tracking form template: 

 AMPL_STF, if you are updating Students Tracking Form 

 AMPL_SQTF, if you are updating receipt of School Questionnaires  
  

 

The SQTF data can only be updated when the status of School Questionnaires in ALL schools 
in your domain is known. 

 

3. In the Selected Template Preview a preview of the selected template will appear. Make sure this 
is the required template. 

4. Click Browse… and manually enter or navigate to the location of the completed STF or SQTF Excel 
file to be imported. The Excel file will be uploaded into ACER Maple and its file name will appear 
in a tab beside the Browse… button. 
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5. In the Uploaded File Preview a preview of the uploaded file will appear (Figure 81). Only the first 
15 rows of data will be displayed. The total number of rows and columns in the uploaded file will 
be displayed beneath the preview. 

 
Figure 81: Uploaded File Preview for a student tracking form 

6. Click Import if the preview looks as expected. ACER Maple then performs a number of validity 
checks on the data in the selected Excel file.  

The possible outcomes and required actions are described in Table 40. 
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Table 40: Scenarios when updating field data 

Outcome  Next steps 

• Tracking data has been validated and is ready 
to be updated in the ACER Maple database. 

• Message: ‘Data have been validated. No 
errors. No warnings. Please click Continue.’ 

1. Click Continue. 

2. Another pop-up message will appear which 
shows the number of records updated. Click 
Dismiss. 

3. Update data in ACER Maple from another 
tracking form. 

OR 

Click Back to return to the Main screen. 

• Tracking data contains some discrepancies 
that prevent the data from being imported 
(errors). 

• Pop-up message appears warning that there 
are discrepancies, the data cannot be 
imported, and prompts you to save or 
download the report 

• The Update Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in 
an appropriate location. Click Cancel to dismiss 
the pop-up message. 

2. Manually enter or navigate to the location of 
the saved report and open it.  

3. Refer to section 9.5 to check the records that 
appear in the report. 

4. Make the required corrections in the Excel file 
and attempt to update the tracking form data 
again. 

• Tracking data contains some discrepancies 
that should be checked before importing it. 

• Pop-up message appears warning that there 
are discrepancies but the data can be 
imported, and prompts you to download the 
report. 

• The Update Field Data Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in 
an appropriate location and open it.  

2. Refer to section 9.5 to check the records that 
appear in the report. 

3. If any corrections are required, make them in 
the tracking form and attempt to update the 
tracking form data again. 

4. If corrections are not required, click Continue to 
import the data. Another pop-up message will 
appear listing the number of records that have 
been imported. Click Dismiss. 

5. Remaining warnings must be explained in the 
validity report Excel file and included in the 
data submission package, as described in 
chapter Error! Reference source not found. . 
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9.5 Update Field Data Validity Report 

If you attempt to update tracking data that contains discrepancies, ACER Maple will produce an Update 
Field Data Validity Report (in Excel format) that contains information about these issues.  
  

 

The Update Field Data Validity Report can contain multiple worksheets. Make sure you 
have checked the records in all worksheets in the report. 

9.5.1 Discrepancies that can be detected in the STF data 

Table 41 (page 128) and Table 42 (page 130) give detailed information about the types of discrepancies 
that may be listed in the Update Field Data Validity Report for STF data, as well as steps to resolve 
them:  

• error worksheets list incorrect records that need to be corrected before the data can be 
successfully updated in ACER Maple;  

• warning worksheets list suspicious records that need to be verified and either corrected or 
explained. 

After all corrections have been made, save the file and attempt to update STF data in ACER Maple 
again. 
  

 

There may be multiple versions of the Update Field Data Validity Report. 

It is possible that after corrections have been made, some errors or warnings still remain. 
In this case, when you try to update the student tracking form data in ACER Maple, the 
validity report will be produced again. 
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Table 41: Update Field Data Validity Report for student tracking forms: Error worksheets – possible errors and their resolutions   

Description Error message in report How to resolve Action required in student tracking form Excel file 

AMPL_STF key violations worksheet 

Duplicate Student ID(s). [Student ID] is found in rows <Row1>, 
<Row 2> 

• Check against tracking 
form populated by ACER 
Maple before the 
assessment. 

• Correct the incorrect Student ID. 

Empty Student ID(s). [Student ID] cannot be empty • Fill empty cell  

First digit in Student ID is incorrect. First digit in [Student ID] is incorrect  • Change first digit to ‘2’. 

Digit 2 in Student ID are incorrect. [Student ID] contains wrong entity 
identification  

 • Change digit 2 to your country AMPL  
code15. 

Non-existent Student ID. Data for [Student ID] does not exist in 
the software 

• Check against tracking 
form populated from 
ACER Maple before the 
assessment. 

• Correct Student ID. 

Digits 3-6 in Student ID are incorrect. Data for AMPL school number does not 
exist 

Combination of Student ID and Line No. 
does not exist in the data in ACER Maple. 

Data for combination of [Student ID] 
and Line No. has not been imported 

• Correct Student ID and/or Line No. as 
required 

Record with combination of Student ID 
and Line No. has not been sampled by 
ACER Maple. 

Data for combination of [Student ID] 
and Line No. has not been sampled 

AMPL_STF missing records worksheet 

The record of a sampled student is 
missing from the AMPL_STF. 

Record with [Student ID] and Line No. 
has been sampled but are not in the 
AMPL_STF 

• Check against tracking 
form populated from 
ACER Maple before the 
assessment. 

1. Add missing record and clarify student’s 
participation status with Test Administrator. 

 

 

 

 
15 The country codes in the student ID are:‘4’-KEN; ‘5’-LSO; ‘6’-ZMB; ‘7’-GMB. 
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Description Error message in report How to resolve 
Action required in student tracking form Excel 
file 

Incorrect columns worksheet 

Excel file is missing one or more columns. 

OR 

Excel file has one or more extra columns. 

OR 

Excel file has one or more columns with 
incorrect names. 

OR 

Excel file corresponds to a different 
template. 

Incorrect columns: Missing – <Column 
Name>, Extra – <Column Name> 

• Check that you are 
selecting the correct Excel 
file to import and the 
correct template in ACER 
Maple. 

OTHERWISE 

• Carefully check all 
adaptations you made in 
the template of the Excel 
file and in ACER Maple 
when you modified the 
corresponding ACER 
Maple template. 

• Add missing columns or modify 
template in ACER Maple as required. 

OR 

• Delete extra columns or modify 
template in ACER Maple as required. 

OR 

• Correct column names or modify 
template in ACER Maple as required. 

OR 

• Select correct Excel file to import or 
select correct template in ACER 
Maple. 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation 
rules. 

Description of validation rule 
violation(s) 

• Check specified values 
against tracking form 
codebook for specified 
rows in Excel file. 

• Correct invalid values. 

SEN vs "Participation" 

Participation code is ‘3’ indicating that 
student was excluded on SEN basis, but 
SEN code is ‘0’ (no special education 
needs) 

[SEN] must be greater than 0 if 
[Participation] is 3 

• Contact School Coordinator 
and/or Test Administrators 
to enquire about student 
SEN and participation 
status 

• Correct either the SEN code or the 
Participation code whichever is 
incorrect 
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Description Error message in report How to resolve 
Action required in student tracking form Excel 
file 

Participation discrepancies 

Participation code is ‘1’ indicating that 
the student participated in assessment, 
but all attendance codes are ‘0’ indicating 
that the student has not attended any of 
the instruments 

Candidate must attend at least one 
instrument to be marked as 
participating (Sampling level:0). 

• Contact Test Administrators 
to enquire about student 
attendance and 
participation status. 

• Check paper instruments 
for attendance code 

• Correct either the participation or 
attendance code whichever is incorrect 

Participation code is not ‘1’ indicating 
that the student did not participate in 
assessment, but one or more of the 
attendance codes are ‘1’ indicating that 
the student has attended one or more of 
the instruments 

Candidate must be participating to 
attend the [Test] or [STQ] (Sampling 
level:0). 

• Contact Test Administrators 
to enquire about student 
attendance and 
participation status. 

• Check paper instruments 
for attendance code 

• Correct either the participation or 
attendance code whichever is incorrect 

 

Table 42: Update Field Data Validity Report for student tracking forms: Warning worksheets – possible warnings and their resolutions 

Description Warning message in report How to resolve 
Action required in student tracking form 
Excel file 

AMPL_STF missing value(s) worksheet 

There are one or more missing 
values or empty cells for a 
specific column. 

Missing value(s) in <Column 
Name> 

1. Check the values in that column in the Excel file. 

2. Contact the school to get the information. 

• Update the AMPL_STF. 

SEN > 4. Is this SEN agreed? 1. Check the values in that column in the Excel file. 

2. If it is greater than 4, Contact School Coordinator 
to enquire about SEN of the student 

• Correct the SEN value if the value 
is not agreed with ACER. 

The students is indicated to 
attend the test, but not the STQ 
or vice versa 

Candidate is marked as 
participating but is not attending 
all instruments (Sampling level:0). 

1. Contact Test Administrators to enquire about 
student attendance status. 

2. Check paper instruments for attendance code 

• Correct attendance if required, 
otherwise provide TA explanation 
and save the report 
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9.5.2 Errors in updated School Questionnaire Tracking Form data 

Table 43 (page 132) gives detailed information about the types of discrepancies that may be listed in 
the Update Field Data Validity Report for SQTF data, as well as steps to resolve them. 

After all corrections have been made, save the file and attempt to update SQTF data in ACER Maple 
again. 
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Table 43: Update Field Data Validity Report for School Questionnaire Tracking Form: Error worksheets – possible errors and their resolutions 

Description Error message in report How to resolve 
Action required in School Questionnaire Tracking 
Form Excel file 

SQTF key violations worksheet 

Duplicate School Principal ID(s). [School Principal ID] is found in rows <Row1>, 
<Row 2> 

• Check against pre-populated tracking 
form (SQTF) exported from ACER Maple 

• Correct the incorrect School Principal ID. 

Empty School Principal ID(s). [School Principal ID] cannot be empty • Fill empty cell. 

First digit in School Principal ID is 
incorrect. 

First digit in [School Principal ID] is incorrect N/A • Change first digit to ‘3’. 

Digits 2 in School Principal ID are 
incorrect. 

[School Principal ID] contains wrong entity 
identification  

• Change digit 2 to your country AMPL  code16. 

Non-existent School Principal ID. Data for [School Principal ID] does not exist in 
the software 

• Check against pre-populated SQTF 
exported from ACER Maple 

• Correct School Principal ID. 

Digits 3-6 in School Principal ID are 
incorrect. 

Data for AMPL school number does not exist 

Combination of School Principal ID 
and Line No. does not exist in the 
data in ACER Maple. 

Data for combination of [School Principal ID] 
and Line No. has not been imported 

• Correct School Principal ID and or Line No. as 
required. 

Record with combination of School 
Principal ID and Line No has not 
been sampled by ACER Maple. 

Data for combination of [School Principal ID] 
and Line No. has not been sampled 

Digits 7-9 in School Principal ID are 
incorrect. 

[School Principal ID] has incorrect part for the 
record 

• Correct School Principal ID. 

SQTF missing records worksheet 

The record of principal is missing 
from the SQTF. 

Record with [School Principal ID] and Line No. 
has been sampled but are not in the SQTF 

• Check against pre-populated SQTF 
exported from ACER Maple 

1. Add missing record and clarify principal’s 
participation status with the Test Administrator. 
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Description Error message in report How to resolve 
Action required in School Questionnaire Tracking 
Form Excel file 

Incorrect columns worksheet 

Excel file is missing one or more 
columns. 

OR 

Excel file has one or more extra 
columns. 

OR 

Excel file has one or more columns 
with incorrect names. 

OR 

Excel file corresponds to a 
different template. 

Incorrect columns: Missing – <Column Name>, 
Extra – <Column Name> 

• Check that you are selecting the 
correct Excel file to import and the 
correct template in ACER Maple. 

• Add missing columns. 

OR 

• Delete extra columns. 

OR 

• Correct column names. 

OR 

• Select the correct Excel file to import or 
select the correct template in ACER Maple. 

Validation rules worksheet 

One or more records contain one 
or more values that violate 
variable validation rules. 

Description of validation rule violation(s) • Check the specified values against the 
tracking form codebook for the 
specified rows in the TTF Excel file. 

• Correct any invalid values. 

 
 

 

 
16 The country codes in the student ID are:‘4’-KEN; ‘5’-LSO; ‘6’-ZMB; ‘7’-GMB. 
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9.6 Updating School Participation 

9.6.1 Preparing data in the School Participation Form 

School participation status should have been tracked by your NC using either the School Participation 
Form exported from ACER Maple (section 3.2) or in another school file, where all other information 
about selected schools is saved.  

Once the participation status of all sampled and replacement schools has been confirmed, the 
sampling process completed, students assessed, and all tracking forms have been updated after the 
assessment, you will need to check the file where school participation status has been tracked to 
ensure that: 

• all schools from the LSS are listed; and 

• each school has the appropriate code according to its participation status (Table 44). 

If participation codes have been entered into another file, you will need to export the School 
Participation Form from ACER Maple (section 3.4), then transfer the codes and comments into the 
School Participation Form.  

The complete School Participation Form data must then be updated in ACER Maple (instructions in 
section 9.6.2). 

Table 44: School Participation Codes for the AMPL  

Code Code meaning 

1 Participant  

2 Refusal  

3 Non-participation for other reasons (please specify, e.g. school fire or flood, teacher strike, conflict 
zone)  

4 No eligible students  

5 School closed (permanently)  

7 Replacement school not contacted  

9 School exclusion (specify type and number of eligible students)  

11 School ineligible for other reasons (please specify)  
  

 

A school participation code is required for each school. 

  

 

Add an explanation in the ‘Comment’ column if required. You must provide an explanation 
in the ‘Comment’ column for codes ‘3’, ‘9’ and ‘11’. All other codes do not require 
comments unless you feel that it is necessary. 

  

 

The length of a comment is restricted to 500 characters. If more space is required please 
include your comment in the Sampling Data Submission Checklist together with the AMPL 
School Number. 
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9.6.2 Updating school participation in ACER Maple 

 

Do not import the School Participation Form data until the participation status for all 
schools has been updated. 

  

 

The data manager login must be used for the following function. 

To update school participation in ACER Maple: 

1. On the Main screen select Update tracking data > Institution participation form and then click 
Activate. The Update institution participation form screen will appear (Figure 82). 

 
Figure 82: Update institution participation form screen 

2. Click Browse… and manually enter or navigate to the location of the completed School 
Participation Form Excel file to be imported. The Excel file will be uploaded into ACER Maple and 
its file name will appear in a tab beside the Browse… button (Figure 83). 

 

Figure 83: Updated SPF Excel file uploaded into ACER Maple 
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3. In the Uploaded File Preview a preview of the uploaded file will appear (Figure 84). Only the first 
15 rows of data will be displayed. The total number of rows and columns in the uploaded file will 
be displayed beneath the preview  

 
Figure 84: Uploaded File Preview for a school participation form 

4. Click Import if the preview looks as expected. An alert will appear asking if you have updated ALL 
your data: 

 if the data has been updated, click Yes;  

OTHERWISE 

 click No and updated STF and SQTF data that had not been updated (section 9.5). 

5. ACER Maple then performs a number of validity checks on the data in the School Participation 
Form Excel file. The possible outcomes and required actions are described in Table 45. 
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Table 45: Scenarios when updating school participation data 

Outcome  Next steps 

• School participation data has been 
validated and is ready to be updated in the 
ACER Maple database. 

• Message: ‘Data have been validated. No 
errors. No warnings. Please click Continue’ 

1. Click Continue. 

2. Another pop-up message will appear listing the 
number of records updated. Click Dismiss. 

3. Proceed to Chapter Error! Reference source not f
ound. . 

• School participation data contains some 
discrepancies that prevent the data from 
being imported (errors). 

• Message: ‘Data contains errors and cannot 
be imported into the ACER Maple 
database.’ 

• Pop-up message prompts you to download 
the report. 

• The Update Institution Participation 
Validity Report is available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location. Click Cancel to dismiss the 
pop-up message. 

2. Manually enter or navigate to the location of the 
saved report and open it.  

3. Refer to section 9.7 to check the records that 
appear in the report. 

4. Make the required corrections in the Excel file 
and attempt to update school participation form 
again. 

• School participation data contains some 
discrepancies that should be checked 
before importing (warnings). 

• Message: ‘Data contains discrepancies but 
can be imported if corrections are not 
required.’ 

• The Update Institution Participation 
Validity Report is available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location and open it. 

2. Refer to section 9.7 to check the records that 
appear in the report. 

3. If any corrections are required, make them in the 
School Participation Form and attempt to update 
the school participation data again. 

4. If corrections are not required, click Continue to 
import the data. Another pop-up message will 
appear listing the number of records that have 
been imported. Click Dismiss. 

5. Remaining warnings must be explained in the 
validity report Excel file and included in the data 
submission package, as described in chapter 
Error! Reference source not found. . 

 

9.7 Update Institution Participation Validity Report 

The validity report produced by ACER Maple will be named 
Update_Institution_Participation_Validity_Report (<Date and Time>).xlsx, where <Date and Time> has 
<yyyy_mm_dd_hour_min> format. Save the file in an appropriate location and open it to review the 
error/warning messages. Each row in the report represents a discrepancy. Some of the discrepancies 
can be connected to other discrepancies listed in the excel file. 

Table 46 (page 139) and Table 47 (page 141) give detailed information about the types of discrepancies 
that may be listed in the Update Institution Participation Validity Report, as well as steps to resolve 
them. 

• Error worksheets list incorrect records that need to be corrected before the data can be 
successfully updated in ACER Maple. 

• Warning worksheets list suspicious records that need to be verified and either corrected or 
explained.  
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There may be multiple versions of the Update Institution Participation Validity Report . 

It is possible that after corrections have been made, some errors or warnings still remain. 
In this case, when you try to update the School Participation Form data in ACER Maple, the 
validity report will be produced again. 

Corrections may need to be made in participants’ tracking information, in the assessment data entered 
in ACER Maple, or in the School Participation Form (SPF). After all corrections have been made, attempt 
to import School Participation Form again.  

Please note that as long as errors exist in the Update Institution Participation Validity Report, you will 
not be able to update school participation. Successful completion of this task is one of the 
requirements for enabling the Submit data function, which is needed for the final task of submitting 
the database to ACER. 

If all errors have been resolved and the Update Institution Participation Validity Report contains only 
warnings (i.e. records that do not need to be corrected), school participation can be successfully 
updated (see Table 45). The validity report Excel file must be saved and all warnings listed in the file 
must be explained in the report as described in Table 45. This file will be required as part of the data 
submission to ACER (see section 11.2.3). 
  

 

It is possible that the Update Institution Participation Validity Report will not be produced 
by ACER Maple. This would happen if there were no discrepancies found in the data when 
updating the School Participation Form. In this case, there will be no warnings requiring 
explanation, and the report will not be required for data submission. 
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Table 46: Update Institution Participation Validity Report: Error worksheets – possible errors and their resolutions   

Description Error message in report How to resolve Action required 

Incorrect columns worksheet 

Excel file is missing one or more columns. 

OR 

Excel file has one or more extra columns. 

OR 

Excel file has one or more columns with 
incorrect names. 

OR 

Excel file corresponds to a different 
template. 

Incorrect columns:  
Missing – <Column Name>, 
Extra – <Column Name> 

• Check that you are selecting 
the correct SPF Excel file to 
import and the correct 
template in ACER Maple. 

OTHERWISE 

• Carefully check all 
adaptations you made in the 
template of the SPF Excel file 
and in ACER Maple when you 
modified the corresponding 
ACER Maple template. 

• Select the correct SPF Excel file to import 
or select the correct template in ACER 
Maple. 

OR 

• Add all missing columns or modify the 
template in ACER Maple as required. 

OR 

• Delete all extra columns or modify the 
template in ACER Maple as required. 

OR 

• Correct all column names or modify the 
template in ACER Maple as required. 

Key violations worksheet 

There are one or more illegitimate AMPL 
School Numbers. 

[AMPL School No.] is 
illegitimate 

• Check the LSS – only AMPL 
School Numbers provided in 
the LSS are legitimate. 

• Correct all AMPL School Numbers in the 
SPF Excel file. 

There are one or more empty cells for 
AMPL School Number. 

[AMPL School No.] is missing 1. Check the AMPL School 
Number(s) in the SPF Excel file. 

2. Check the LSS. 

• Add all correct AMPL School Numbers to 
the SPF Excel file. 

There are one or more duplicate AMPL 
School Numbers. 

[AMPL School No.] <#>is 
found in rows <row1, row2,..> 

• Correct all AMPL School Numbers in the 
SPF Excel file. 

Incomplete records worksheet 

Some AMPL School Numbers from the LSS 
are missing. 

All schools should be updated 
together 

1. Check the AMPL School 
Number(s) in the SPF Excel file. 

2. Check the LSS. 

• Add all correct AMPL School Numbers to 
the SPF Excel file. 
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Description Error message in report How to resolve Action required 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation 
rules. 

Description of validation rule 
violation(s) 

• Check the specified values in 
the SPF Excel file against the 
School Participation Form 
codebook. 

• Correct all invalid values in the SPF Excel 
file. 

SPF worksheet 

School participation code was entered 
incorrectly. 

OR  

List of Students were not imported for all 
schools. 

AMPL School No participating 
but no records were imported 
for sampling 

1. Check the school participation 
code in the SPF Excel file. 

2. Find out why the List of Students 
has not been imported. 

• Correct the school participation code in the 
SPF Excel file. 

OR 

• Proceed with sampling and assessment in 
the school. 

School participation code is entered 
incorrectly. 

OR  

Students were not sampled in all schools. 

AMPL School No participating 
but no records were sampled 

1. Check the school participation 
code in the SPF Excel file. 

2. Find out why the students were 
not sampled. 

School participation code is entered 
incorrectly. 

OR  

Tracking forms were not updated for all 
schools. 

AMPL School No participating 
but no records were identified 
as participating on the field 
operation form 

1. Check the school participation 
code in the SPF Excel file. 

2. Check whether the tracking form 
was updated in ACER Maple. 

• Correct the school participation code in 
the SPF Excel file. 

OR 

• Update the tracking form for the school in 
ACER Maple. 

School participation code is ‘3’, ‘9’ or ‘11’, 
but the reason for the code has not been 
specified in the ‘Comments’ column. 

Codes 3, 9, and 11 require 
specifications in Comment 
column. 

Check the school participation code in 
the SPF Excel file. 

• Correct the school participation code in 
the SPF Excel file. 

OR 

• Specify the reason for the code. 
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Table 47: Update Institution Participation Validity Report: Warning worksheets – possible warnings and their resolutions 

Description Warning message in report How to resolve Action required in School Participation Form Excel file 

SPF vs field operation forms worksheet 

School participation code is 
entered incorrectly. 

OR  

Tracking form has incorrect test 
participation codes. 

OR 

There is a reason for this 
discrepancy. 

AMPL School No is not participating 
but some records were identified as 
participating on the field operation 
form 

1. Check the school participation 
code in the SPF Excel file. 

2. Check the tracking form Excel 
file for the school. 

• Correct the school participation code in the 
SPF Excel file. 

OR 

• Correct the tracking form Excel file for the 
school and update it again in ACER Maple.  

SPF replacement worksheet 

School participation code is 
entered incorrectly. 

OR 

There is a reason for this 
discrepancy. 

Main and first replacement school 
both participating 

• Check the school 
participation code in the SPF 
Excel file. 

• Correct the school participation code in the 
SPF Excel file. 

OR 

• Specify the reason for having main and 
corresponding replacement school 
participating at the same time in the 
assessment for each line in the report Excel 
file.  

THEN 

• Contact Clare Ozolins at 
Clare.Ozolins@acer.org, explaining what 
happened. 

Main and second replacement school 
both participating 

First replacement and second 
replacement school both participating 

 

mailto:Clare.Ozolins@acer.org
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10.1 Data Entry Organisation 

Before responses from the paper-based survey instruments can be entered into ACER Maple, the process of 
data entry needs to be carefully planned and organised. NCs need to devise a data entry plan for each domain 
(i.e. each Admin ID) within their national context, to ensure they will have sufficient staff and equipment for 
their data entry requirements. NC planning depends on the test designs that had been implemented by it 
and availability to employ stuff and provide equipment for data entry operators. 

10.1.1 Available test designs 

The AMPL survey allows NCs to select from basic test designs AMPLa, AMPLab, AMPLb or a combination of 
them. Each test design comprises several booklet types (or test forms) that are rotated between students on 
the STF produced by ACER Maple. The Test Administrator then allocates each student with the booklet type 
according to the STF. 
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There is only one type of Student Questionnaire, and each student should be provided one questionnaire by 
the Test Administrator. There is only one type of School Questionnaire, and each school should be provided 
one questionnaire. The data from Student and School Questionnaires also need to be entered in ACER Maple 
database. Table 48 shows which instruments are used in each design. 

Table 48: Instruments used in various designs 

Design Booklet IDs rotated between students Other instruments 

AMPLa 7,8 Student Questionnaire School Questionnaire 

AMPLab 3,4,5,6,7,8 Student Questionnaire School Questionnaire 

AMPLb 1,2 Student Questionnaire School Questionnaire 
 

Currently either design AMPLab or a combination of designs AMPLa and AMPLab, or designs AMPLa are 
selected by participating NCs (Table 49). 

Table 49: Grades assessed, and test designs selected by participating NCs 

Country Lower Grade Test design Upper Grade Test design 

Kenya N/A N/A 6 AMPLab 

Lesotho N/A N/A 6 AMPLab 

Zambia 4 AMPLa 7 AMPLab 

The Gambia 3 AMPLa N/A N/A 

India To be advised 
 

NCs that selected a combination of two designs will need to employ more DEOs than NCs that selected only 
one design, since the sample size is twice as large.  

Once the appropriate number of data entry operators (DEOs) for each administrative unit has been decided 
upon, and employed appropriately, they need to undergo training before they can begin entering the data 
received from schools. 

10.1.2 Data entry planning 

Of all the survey instruments, the Student Questionnaire involves the most data being entered, because 
every student is expected to complete it. The School Questionnaire involves the least data being entered, as 
there will only be one completed per school. See Table 50 for the maximum expected number of records and 
responses that could be entered for each survey instrument. 
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Table 50: Expected records and responses in survey instruments 

Instrument Max. number of records per 
instrument 

Number of responses 
per person 

Data entry days per 
instrument per grade level 

AMPLb Test Forms (1-2) 2500 each 67 6-8 

AMPLa Test Forms (7-8) 2500 each 86 8-9 

AMPLab Test Forms (3-8) 840 each 86 3-4 

Student Questionnaire  5000 54  11-12 

School Questionnaire 150-300 (varies by sample design) 75 Less than 1 day 

Once DEOs are well-practiced in data entry for their allocated instrument(s), a DEO with a good keystroke 
will take about one second per response. Allowing for an initial slower period at the beginning of data entry, 
and accounting for page turning and various other interruptions, responses from AMPL Test Forms 1 and 2 
will take 6-8 working days for one person to enter. The time required for other instruments is estimated in 
the same way. 

The data manager will need to figure out how many personnel will be required to enter the data from all 
assessment instruments, and what equipment is available for this purpose. To aid these decisions, and to 
better manage the data entry process overall, a data entry plan should be devised. Two examples of how 
this can be done are provided below. 

As stated in section 1.3: 

• One data manager is responsible for all data management operations in the NC. 

• As many data administrators assist the data manager with school-by-school operations as there are 
domains (i.e. Admin ID values in the LSS). Each DA is responsible for a different domain. 

Therefore, 

• If only one design is selected by the NC, data manager can consider two DEOs working under the 
instruction of each data administrator. One of them entering responses from the test booklets and then 
the School Questionnaires, and another entering responses from the Student Questionnaires. The 
number of days required for data entry will depend on the number of domains defined in the LSS. With 
two domains (Admin ID=01 and 02) data entry can be completed in 6 days, with four domains (Admin 
ID=01, 02, 03, 04), data entry can be completed in three days. 

• If two designs are selected by the NC, the amount of data to be entered is increased twofold. In this 
case, it is prudent to consider at least three DEOs working under the instruction of each data 
administrator. One of them entering responses from the test booklets 3 and 4 (for two grade levels), 
another entering data  from booklets 5-8 and then the School Questionnaires, and the third DEO 
entering responses from the Student Questionnaires. This plan is illustrated in Table 51.  
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Table 51: Example of the data entry plan for AMPLa and AMPLab with three data entry operators per domain 

Instrument Admin ID 

 01 02 …… 

AMPL Test Form 3 &4 DEO1a DEO2a …… 

AMPL Test Form 5-8 + School Questionnaire DEO1b DEO2b …… 

Student Questionnaire DEO1c DEO2d …… 

 

The way to reduce time required for data entry is to have more domains (i.e. more data administrators). Data 
administrators at the time of data entry can work as DEOs if necessary. 

The data manager and data administrators will also need to ensure that sufficient equipment is available for 
data entry. Each DEO will need a PC to enter data into ACER Maple, but the same PC can be used for more 
than one DEO if they are working in shifts. 
  

 

The data manager and the data administrator can perform data entry tasks if necessary, 
but they will need separate DEO logins in ACER Maple to do so. 

 

10.1.3 Manage Data Entry Operators in ACER Maple 

After the data entry plan has been finalised, the data entry equipment has been prepared, and data entry 
operators (DEOs) have been employed, ACER Maple logins need to be created for each DEO. The Manage 
Data Entry Operators function allows data administrators to add, search, edit or delete DEO logins, or to 
reset a DEO’s first time login code (FTLC). All of these functions can be accessed from the Manage Data Entry 
Operators screen. 

Accessing the Manage Data Entry Operators screen 

  

 

A data administrator login must be used for the following function. 

To access the Manage Data Entry Operators screen: 

1. On the Main screen select User settings > Manage data entry operators and then click Activate. The 
Manage data entry operators screen will appear (Figure 85). 

From this screen you can Add a new record, or Search, Edit, Reset FTLC or Delete existing records. The 
instructions for these actions are provided in the corresponding sections on pages 146 to 157. 
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Figure 85: Manage data entry operators screen 

Add new record 

  

 

A data administrator login must be used for the following function. 

To create ACER Maple logins for each data entry operator: 

1. Follow the instructions on page 145 to access the Manage Data Entry Operators screen. 

2. Ensure that the New tab is highlighted on the left-hand side of the screen.  

3. Click Add a new record. A pop-up window will appear (Figure 86). 
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Figure 86: Add new data entry operator details 

4. Enter the User name and User affiliation for the DEO (see example in Figure 87). 

 
Figure 87: New DEO login details 

  

 

Each data entry operator login must be assigned a unique ‘User name’. 

5. In the Instruments assigned box, allocate at least one instrument to the DEO login being added, by 
selecting the appropriate tick box(es) (Figure 88). If an instrument is already listed as “[used]” it cannot 
be allocated again to a different DEO in the same domain. 
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Figure 88: Allocate instruments to DEO 

6. Click Save & Next. ACER Maple then performs a number of validity checks on the information that has 
been entered.  

The possible outcomes and required actions are described in Table 52. 
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Table 52: Possible outcomes when adding a new DEO credentials and data entry allocation 

Outcome  Next steps 

• All fields are entered and ACER Maple found no 
discrepancies 

• A pop-up window appears listing the number of 
records created. It will automatically disappear 
after a few seconds. 

• No further DEO logins are required 

1. Click Close. The Manage Data Entry 
Operators screen will return. The new DEO 
credentials entered in steps 4 to 6 will be 
listed in the middle of the screen, along with 
their First time login code (FTLC). 

2. Click Back to return to the Main screen.  

• All fields are entered and ACER Maple found no 
discrepancies 

• A pop-up window appears listing the number of 
records created. It will automatically disappear 
after a few seconds. 

• Another DEO login is required 

1. Repeat steps 4 to 6 to add another DEO 
login. 

2. After the information is entered, click Save 
& Next and follow the steps that correspond 
to the appropriate outcome described in this 
table. 

• There is an error in the data entered for the 
DEO. 

• A pop-up window appears describing the error 
that is preventing the data from being saved. It 
will automatically disappear after 10 seconds. It 
can also be closed manually by clicking ‘X’ in the 
top right corner. 

1. Make the required corrections to the data. 

2. After the data is corrected, click Save & Next 
and follow the steps that correspond to the 
appropriate outcome described in this table.  

 
  

 

To save in Excel data entry allocation and the first time credentials for DEOs: 

• Click Export ALL first-time credentials; and  

• Save exported file in the designated location. Then 

• Click Export ALL data entry allocation; and 

• Save exported file in the designated location. 

 

Search 

ACER Maple also includes a search function with the Manage Data Entry Operators function. 
  

 

A data administrator login must be used for the following function. 

To search the list of DEOs by user name, affiliation, or instrument assignment: 

1. Follow the instructions on page 145 to access the Manage Data Entry Operators screen. 

2. Ensure that the Search tab is highlighted on the left-hand side of the screen. 

3. Enter the information you wish to use to search the list of DEOs (Figure 89). If all search terms are 
blank, all DEO logins will be listed. 

• Enter a user name to locate a specific DEO; 

• Enter a user affiliation to see all DEOs with the same affiliation; and/or 
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• Select one or more instruments within the instruments assigned box to see which DEOs have 
been assigned those instruments. 

 
Figure 89: Search data entry operators 

4. Click the Search button at the bottom of the screen. All records matching the search terms that have 
been entered will be listed in the middle of the Manage Data Entry Operators screen (Figure 90).  

 
Figure 90: DEO search results 

If no records match the entered search terms, the message “No data available in table” will display in 
the centre of the screen. 
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Edit 

This option allows data administrators to make changes to the user name, user affiliation, and/or 
instruments assigned to any DEO in ACER Maple. 
  

 

A data administrator login must be used for the following function. 

To edit user name, affiliation, or instrument assignment: 

1. Follow the instructions on page 145 to access the Manage Data Entry Operators screen. 

2. Locate the entry of the DEO login with data that needs to be changed in the list in the middle of the 
screen. Use the Search function if necessary. 

3. Underneath the Action column heading, click Edit. A pop-up window will appear (Figure 91). 

 
Figure 91: Edit DEO details 
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4. Make the required corrections to the data: 

• User name and affiliation can be updated by directly editing the text in those fields; 

• Instrument assigned can be updated by deselecting any instrument currently assigned and 
selecting another. More than one instrument can be selected, as long as it is not listed as 
“[used]”. 

5. Click Save. You will be returned to the Manage Data Entry Operators screen and ACER Maple will 
perform some validity checks of the entered data. The possible outcomes and required actions are 
described in Table 53. 

Table 53: Possible outcomes when editing a DEO login  

Outcome  Next steps 

• All fields are updated and ACER Maple found no 
discrepancies. 

• A pop-up window appears listing the number of 
records updated. It will automatically disappear after 
a few seconds. 

• No other DEO logins need to be edited. 

1. Click Back to return to the Main screen. 

• All fields are updated and ACER Maple found no 
discrepancies. 

• A pop-up window appears listing the number of 
records updated. It will automatically disappear after 
a few seconds. 

• Another DEO login needs to be edited. 

1. Repeat steps 2 to 5 to edit another DEO 
login. 

2. After the information is updated, click 
Save and follow the steps that 
correspond to the appropriate 
outcome described in this table. 

• There is an error in the data entered for the DEO. 

• A pop-up window appears describing the error that is 
preventing the data from being saved. It will 
automatically disappear after 10 seconds. It can also 
be closed manually by clicking ‘X’ in the top right 
corner. 

1. Make the required corrections to the 
data. 

2. After the data is corrected, click Save 
and follow the steps that correspond to 
the appropriate outcome described in 
this table.  

Delete 

  

 

A data administrator login must be used for the following function. 

To delete a DEO credentials from ACER Maple: 

1. Follow the instructions on page 145 to access the Manage Data Entry Operators screen. 

2. Locate the entry of the DEO login with data that needs to be deleted in the list in the middle of the 
screen. Use the Search function if necessary. 

3. Underneath the Action column heading, click Delete. A pop-up window will appear listing the login that 
will be deleted, and a message asking if you want to continue. 

4. Click OK. Another pop-up window will appear listing the record that has been deleted. It will 
automatically disappear after a few seconds. The Manage Data Entry Operators screen will return. 

5. Repeat steps 2 to 4 for any other DEO logins that need to be deleted. 
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Reset first time login code (FTLC) 

The reset FTLC option is used when a DEO has forgotten their password and needs to have it reset by their 
data administrator. 
  

 

A data administrator login must be used for the following functions. 

To reset a DEO’s first time login code: 

1. Follow the instructions in the previous subsection (page 145) to access the Manage Data Entry 
Operators screen. 

2. Locate the entry of the DEO login with data that needs to be deleted in the list in the middle of the 
screen. Use the Search function if necessary. 

3. Underneath the Action column heading, click Reset FTLC. A pop-up window will appear warning that 
the FTLC for the selected record will be reset, that the previously set user password will become invalid, 
and a message asking if you want to continue. 

4. Click OK. Another pop-up window will appear listing the record that has been updated. It will 
automatically disappear after a few seconds. The Manage Data Entry Operators screen will return, with 
a new FLTC listed in the First time login code (FTLC) column of the DEO’s record in the middle of the 
screen. 

5. The new FTLC will need to be provided to the DEO. The DEO will need to follow the instructions in 
section 2.9.1 to complete the first-time login process again, using the new FTLC as the login code. 

10.1.4 Data entry documentation 

For training, you will need the codebooks for all instruments that were used by your National Centre for 
assessment. 

To export codebooks from ACER Maple: 

1. On the Main screen select Response data > Export data entry documentation and then click Activate. 
The Export data entry documentation screen will appear (Figure 50). 
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Figure 92: Export data entry documentation screen 

2. Under Export options on the left-hand side of the screen de-select Template Format. 

3. Under Headings for questions on the left-hand side of the screen select Screen label & item code. 

4. From the drop-down list on the top of the screen, under Select data entry templates, select all 
instruments that were used by your National Centre for assessment. 

5. Click Export. All initial data files will be combined into one zip file which will be available for download.  

6. Select ‘Save File’ and save the zip file in an appropriate location and then unzip it. 
  

 

Keep the codebooks handy. Your data management team will need to be familiar with validation 
rules throughout the data entry operations. 

 

10.1.5 Training 

The data manager will need to train all data entry operators (DEOs) before data entry in how to use ACER 
Maple. For the purposes of training DEOs, data managers are advised to adapt the Data Management 
Training Presentation Part 2 and other training materials provided by ACER17. However, not all topics included 
in this presentation will be required for DEO training. 

The topics that must be covered in the DEO training are: 
 

 

 
17 MS Teams>AMPL Partner Collaboration > Data Management Resources. 
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• ACER Maple login and navigation (chapter 2) 

• ACER Maple response formats and data entry rules (section 10.2.1) 

• Entering data into ACER Maple from paper-based instruments (section 10.2) 

Table 54 lists the data manager’s tasks in relation to DEO training and provides references to relevant 
sections and/or chapters of this document. 

Table 54: Data manager tasks in relation to data entry operator training 

Preparation task Reference 

Ensure that training setup corresponds to the real working 
conditions of data entry operators as close as possible. 

Section 4.3, Introduction, Chapters 1 and 2 

Prepare ACER Maple with updated STF data for students in schools 
in stratum 99, as described in the data administrator training 

Chapters 4 and 9 

Export all instruments that were used by your National Centre for 
assessment and make sure that DEOs have the codebooks for the 
instruments they are assigned to enter 

Section 10.1.4 

Download and adapt for your needs Data Management Training 
Presentation provided by ACER.  

MS Teams>AMPL Partner 
Collaboration>Data Management 
Resources>Workshops18 

Prepare paper-based instruments for training with fake data for 
students in schools in stratum 99 

Prepare paper-based instruments for 
training section (page 156) 

 

For the purposes of DEO training, a number of fictitious ‘schools’ have been included in the LSS and can be 
used to test the ACER Maple data entry procedures before any real data is available. These ‘schools’ are 
found in stratum 99 of the LSS. As outlined in the data administrator training chapter (chapter 4): 

• Training List of Students (LST) data should be prepared for some schools from stratum 99. 

• The training LST data should be imported. 

• Students from schools in stratum 99 should be sampled, and instruments allocated. 

• STF templates should be populated with sampling data from schools in stratum 99. 

• Populated STF templates should be “completed” with error-free participation data then used to update 
STF in ACER Maple. 

In addition to these data administrator training tasks, the data manager or data administrator will need to 
do the following in preparation for DEO training: 

• Prepare paper-based instruments for training with ‘fake’ responses for students/schools in stratum 99, 
according to the instrument allocated to them in the STF, and the participation data that was used to 
update the corresponding STFs in ACER Maple. 

• DEO logins are added by the data administrator in ACER Maple. 
 

 

 
18 
https://acerlimited.sharepoint.com/:p:/r/sites/AMPLab/Shared%20Documents/Data%20Management%20Resources/Workshops/A
MPL_DM_Training.pptx?d=w70c9ec3dfe9a4418873407409c3c3d31&csf=1&web=1&e=3hhuH9 

 

https://acerlimited.sharepoint.com/:p:/r/sites/AMPLab/Shared%20Documents/Data%20Management%20Resources/Workshops/AMPL_DM_Training.pptx?d=w70c9ec3dfe9a4418873407409c3c3d31&csf=1&web=1&e=3hhuH9
https://acerlimited.sharepoint.com/:p:/r/sites/AMPLab/Shared%20Documents/Data%20Management%20Resources/Workshops/AMPL_DM_Training.pptx?d=w70c9ec3dfe9a4418873407409c3c3d31&csf=1&web=1&e=3hhuH9
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• Data administrators need to ensure that the appropriate instrument(s) are allocated to each DEO for 
data entry training (according to the data entry plan). 

• Data from the training paper-based instruments should be entered by DEOs. 

Training Setup 

DEO training should be set up to correspond to the real working conditions of DEOs as much as possible. To 
achieve this you should make sure that: 

1. All DEOs attend the training. 

2. The required computing equipment is ready:  

 ACER Maple is installed in a LAN environment as described in Chapter 2 with one of PCs for each 
DEO plus one host PC; 

 each PC meets the system requirements and PC setup (sections 2.2 and 2.3); and 

 DEO logins are created for each DEO as explained in section 10.1.3. 

3. Paper-based instruments for training (containing ‘fake’ responses for students/schools in stratum 99) 
are provided to DEOs. 

4. Audio-visual equipment is ready to use. Some examples of this equipment might include: 

 a projector for viewing the Data Management Training Presentation, ensuring that the screen is 
visible from every DEO workstation; or  

 a second monitor for each DEO, so that they can watch the Data Management Training Presentation 
on one monitor and complete the training exercises using another monitor. 

Prepare paper-based instruments for training 

The data manager will need to provide enough copies of the following instruments to each DEO participating 
in the training: 

• AMPL test forms according to the design selected by the NC; 

• AMPL Student Questionnaire; 

• AMPL School Questionnaire 

Each DEO should receive at least two copies of the instrument(s) for which they will be entering real data 
when it is received from schools, according to the data entry plan (section 10.1.2). 

On the front cover of the test forms the same information should be provided as on booklets sent to the TAs, 
however not all of these data should be entered into ACER Maple, as shown in Table 55. 
Table 55: Data to be entered from the test cover page 

Information provided for TA on the paper test form Data to be entered in ACER Maple 

School Name   

AMPL School No.  AMPL School No.  

Grade Level Grade Level 

Class Name  

Student Name  

AMPL Participant ID AMPL Participant ID 

Booklet No. Booklet No. 
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On the front cover of the Student Questionnaire the same information should be provided as on the Student 
Questionnaires sent to the TAs, however not all of these data should be entered into ACER Maple, as shown 
in Table 56. 
Table 56: Data to be entered from the Student Questionnaire cover page 

Information provided for TA on the Student Questionnaire cover page Data to be entered in ACER Maple 

School Name   

AMPL School No.  AMPL School No.  

Grade Level Grade Level 

Class Name  

Student Name  

AMPL Participant ID AMPL Participant ID 
 

The data manager should refer to the STFs prepared for training to ensure that the information listed on the 
cover page of each test form is consistent with the information listed in the STF: 

• Student IDs used for AMPL test form should be consistent with what was allocated in the STF; 

• Students should be marked as attending the appropriate instrument session on the STF. 

On the front cover of the School Questionnaire the same information should be provided as on the School 
Questionnaires sent to schools, however school name should NOT be entered into ACER Maple, as shown 
inTable 57. 
Table 57: Data to be entered from the School Questionnaire cover page 

Information provided for TA on the School Questionnaire cover page Data to be entered in ACER Maple 

School Name   

AMPL School No.  AMPL School No.  

AMPL Participant ID AMPL Participant ID 
 

  

 
The data manager/administrator should ensure that the participation status of each school 
in stratum 99 being used for training purposes has been updated accordingly in the 
Institution Participation Form (section 9.6.2). 

 

Once the paper-based instruments have been prepared for training, DEO logins should be created and the 
appropriate instruments allocated to them for data entry training (section 10.1.3). 

10.2 Entering Responses into ACER Maple 

Once ACER Maple logins have been created for each DEO, instruments allocated to each DEO, and DEOs are 
trained, the data entry can commence.  

10.2.1 Data entry rules 

Each DEO must be provided with a set of instruments according to the data entry plan (see section 10.1.2 for 
details).  

Each instrument provided to the DEO must contain at least one response from the participant to whom this 
instrument had been assigned (see section 9.1 for details on instrument preparation for data entry). 



Chapter 10  Data Entry AMPL DMM 

ACER © 2023 Commercial in Confidence Page 158 of 207 

Before commencing data entry from the next instrument, the DEO must check whether the instrument has 
at least one response: 

• If the instrument has at least one response: 

 the DEO starts entering data from the cover page of this instrument according to the rules explained 
in the next sub-section of this section (page 158); and 

 then continue entering data in the response fields according to the rules explained in the following 
sub-sections depending on the type of the instrument (see page 158 for questionnaires and page 
161 test forms) 

• If there are no responses, the DEO must put the instrument aside for his data administrator or the data 
manager to place this instrument in the box with other empty instruments of the same type. 

Cover pages in the AMPL instruments 

  

 

Cover page data from the instruments that do not have students’ or principal’s responses must 
not be entered. 

 

Table 58 shows which data from the cover pages need to be entered in the corresponding records in ACER 
Maple. 
Table 58: Data to be entered from the cover pages of various instruments 

Instrument type Test instruments Student Questionnaire School Questionnaire 

Data to be 
entered from the 
cover page 

AMPL School No.  AMPL School No.  AMPL School No.  

Grade Level Grade Level  

AMPL Participant ID AMPL Participant ID AMPL Participant ID 

Booklet No.   
 

Units and items in AMPL questionnaires 

Each question in the paper-based questionnaire instruments correspond to a unit of one or more item(s). 
Items are questions or statements to which participants have to respond. Several items can be combined 
into one unit, or a unit may only contain one item. Within the AMPL questionnaires, units are numbered 
sequentially, and items within units are marked by letters. An example, unit 3, is provided in Figure 93. 



Chapter 10  Data Entry AMPL DMM 

ACER © 2023 Commercial in Confidence Page 159 of 207 

 
Figure 93: Question 5 from the AMPL Student Questionnaire 

Unit ST05 consists of five items. The corresponding ACER Maple variable names (ST05A, ST05B, ST05C, ST05D, 
and ST05E) are listed in light grey text on the side of the page. The items in Figure 93 are multiple choice 
(MC): they have several response options from which the participant selects one. Each response option has 
a corresponding response code next to it (i.e. 0, 1, 2, or 3 in Figure 93).  

For each MC item with single-digit code: DEO enters the code for the choice selected by the participant. Only 
one choice can be entered. If student selected more than one choice, code 8 (Invalid) must be entered if 
none of the choices are selected code 9 (Missing) must be entered. 

For each MC item with double-digit code: DEO enters the code for the choice selected by the participant. 
Only one choice can be entered. If student selected more than one choice, code 98 (Invalid) must be entered 
if none of the choices selected code 99 (Missing) must be entered. Figure 94 shows an example of a double-
digit MC item. 

 

5 How many of the following people usually live at home with you? 

This is the home where you mainly live but could include living in more than one home. 

 
Please tick one circle for each line. None One Two 

Three 
or more 

 

a) Parent(s) (including step-parents or foster parents) .... 0 1 2 3 ST05A 

b) 
Other adults (e.g., grandparents, aunt, uncle, cousin, 

friend) .......................................................................... 
0 1 2 3 ST05B 

c) Older brothers and sisters (or the same age as you) .... 0 1 2 3 ST05C 

d) Younger brothers and sisters ....................................... 0 1 2 3 ST05D 

e) Young cousins or friends .............................................. 0 1 2 3 ST05E 
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Figure 94: Question 2 from the AMPL Student Questionnaire 

Please note different layouts for two examples above:  

• in ST05 (Figure 93) response categories are positioned horizontally on the page (horizontal layout); and 

• in ST02 (Figure 94) response categories are positioned vertically on the page (vertical layout). 
  

 

Both single-digit and double-digit MC items can have horizontal and vertical layout. 

DEOs must be allerted to this difference during training: 

• If an item has horizontal layout relevant Invalid code is entered if there are two or more 
responses in a row and Missing code is entered if there are no responses in a row 

• If an item has vertical layout relevant Invalid code is entered if there are two or more 
responses in a column and Missing code is entered if there are no responses in a column. 

 

In addition to the MC questions, the School Questionnaire has open-ended items (OE), where principals are 
asked to provide a number as a response (Figure 95). 

2 When were you born? 

Please tick one circle next to the month and year you were born 

 a) Month ST02A b) Year ST02B 

 January ..................................  01 2007…………………………………………. 01 

 February ................................  02 2008…………………………………………. 02 

 March ....................................  03 2009…………………………………………. 03 

 April .......................................  04 2010…………………………………………. 04 

 May .......................................  05 2011…………………………………………. 05

 June .......................................  06 2012…………………………………………. 06 

 July ........................................  07 2013…………………………………………. 07 

 August ...................................  08 2014…………………………………………. 08 

 September .............................  09 2015…………………………………………. 09 

 October .................................  10 2016…………………………………………. 10 

 November..............................  11 2017…………………………………………. 11 

 December ..............................  12
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Figure 95: Question 14 from the AMPL School Questionnaire 

In the case of OE items the number entered by the respondent into the box, is entered by the DEO in the 
corresponding field of the data entry screen. If there is no respond in a box, the Missing code is entered (999 
or 9999 depending on the validation rule of the item). The Invalid code is entered only if the number entered 
in the box is outside the validation rule for the item. Validation rules are provided in the codebooks. 
Instructions on how to export codebooks are provided in section 10.1.4. 

Units and items in Test Forms 

In the AMPL Test Forms, items are not numbered sequentially throughout the booklets, but the numbering 
corresponds to the numbering of the data entry fields on the ACER Maple data entry screens. The 
corresponding ACER Maple variable names appear in grey text above the item numbers number (i.e. E1.1 
and E2.1 in Figure 96). 

 
Figure 96: Example MC test items  

Most of the items in the Test Forms are multiple choice (MC) with either letter assign to the response 
categories (item 1e, Figure 96) or the small circles with greyed-out codes beneath them: (item 2e, Figure 96): 

• Each letter in the MC items similar to 1e corresponds to a numeric code which is entered into ACER 
Maple if the letter is circled:  

 A=1 

 B=2 

 C=3 

 ........ 

14 How many teachers taught in your school on [1 March 2023]?  

 Please write the numbers in the boxes for each category. Write zero (0) in each box if none. 
Please include yourself if you teach.  

a) Full-time teachers .............................................   SC14A 

      
b) Part-time teachers ............................................  SC14B 
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• For each MC item with single-digit codes or letter codes: DEO enters the code for the choice selected 
by the student. Only one choice can be entered. If student selected more than one choice, code 8 
(Invalid) must be entered if none of the choices are selected code 9 (Missing) must be entered. 

• For each MC item with double-digit codes: DEO enters the code for the choiceselected by the student. 
Only one choice can be entered. If student selected more than one choice, code 98 (Invalid) must be 
entered if none of the choices selected code 99 (Missing) must be entered. 

Some items in the Test Forms are complex multiple choice (CMC) similar to the item shown in Figure 97. In 
these cases several participant choices are treated together as one response. 

 

Figure 97: Example CMC item 

In the example in Figure 97, four responses are treated together as one response: 

 Each ‘Yes’ must be coded as ‘1’; 

 Each ‘No’ must be coded as ‘2’; 

 Four numbers are entered into ACER Maple for the participant’s response e.g. 1212, or 1221, etc. 

Response options are usually coded in the order they appear on the page, when reading left to right, top to 
bottom. The first option is coded as 1, the second as 2 etc. For example, in another CMC item: 

 Each ‘Left’ must be coded as ‘1’; 

 Each ‘Right’ must be coded as ‘2’; 

 Four numbers are entered into ACER Maple for the participant’s response e.g. 121. 
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Data entry screens 

An ACER Maple data entry screen is shown in Figure 98. 

 
Figure 98: ACER Maple data entry screen for a test form 

The large yellow field at the top of the screen displays information about the field currently selected for data 
entry, with the variable name, variable type and validation rules (in brackets) listed on the left above the box. 
This information cannot be edited directly. 

The next fields, listed under “Cover Page” and before “Responses”, are for entering required information 
from the cover page. 

The remaining fields, listed under “Responses” are for entering participant responses. Item numbers appear 
above each field. 

Variables in ACER Maple 

Each item in a paper-based instrument corresponds to a variable in ACER Maple.  

There are five main types of variables in ACER Maple that are used to enter responses from the  AMPL survey 
instruments. Every response field in ACER Maple must contain either a response code (if a valid response has 
been provided), or an auxiliary code (if a valid response has not been provided). 

There are three auxiliary codes which can be used when a valid response has not been provided: 

• Not administered (N/A): This code is used when the respondent was unable to provide a response to a 
question due to problems with the survey instruments, such as printing errors or omissions, faulty 
cutting, folding or stapling, or missing booklet pages, etc. Note that if there were problems with the 
survey instruments, they should be reported in the Item Information for Cleaning document (section 0) 
when you submit your data. 

• Invalid: This code is used when the respondent has provided an invalid response, such as circling or 
ticking two answers when they should only choose one, or including extraneous text that invalidates 
their response. 

• Missing: This code is used when the respondent has not provided a response at all. 

Table 59 lists the main ACER Maple variable types and their auxiliary codes. 
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Table 59: ACER Maple variable types used for the AMPL 

Variable type Auxiliary codes 

 N/A Invalid Missing 

Open-ended numeric items, depending on validation rule will have: 
9997 9998 9999 

997 998 999 

Multiple Choice (with ≤6 choices) 7 8 9 

Multiple Choice (with >6 choices) 97 98 99 

Complex multiple choice (3 choices treated as one response) 997 998 999 

Complex multiple choice (4 choices treated as one response) 9997 9998 9999 

 

10.2.2 Accessing the ‘Key in responses’ screen 
  

 

A data entry operator login must be used for the following function. 

To enter a new response data record, or to search for and edit an existing record, data entry operators need 
to access the Key in responses screen as follows: 

1. On the Main screen select Response data> Key in responses and then click Activate. The Key in 
responses screen will appear (Figure 99). 

From this screen you can: 

 Add a new record, under the New tab; or  

 Search, Edit, Reset or Delete existing records under the Existing tab.  

The instructions for these actions are provided in the corresponding sections 10.2.3-10.2.7. 
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Figure 99: Key in responses screen 

10.2.3 Add a new record 
  

 

A data entry operator login must be used for the following function. 

To key in response data for a new record: 

1. Follow the instructions in section 10.2.2 to access the Key in responses screen. 

2. Ensure that the New tab is highlighted on the left-hand side of the screen. 

3. The following fields must be filled for each new record being added: 

• Under Pop Type DEO selects:  

 Students if entering data for AMPL test forms or Student Questionnaire; or  

 School principals if entering data for the School Questionnaire.  

• Under Instrument: DEO selects from the drop-down list the instrument for which data will be entered 
(e.g. 3 for booklet 3 in the example in Figure 99). 

• Under Data Entry Template: the data entry template name that corresponds to the selected survey 
instrument will appear automatically. 

4. Click Add a new record. The data entry screen for the selected instrument will appear in a pop-up 
window (Figure 100). 

• On the left above the large yellow field at the top of the screen information about the field currently 
selected for data entry is displayed as follows:  
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 the item number in the paper version of the instrument which corresponds to the field number,  

 then in brackets: variable type followed by validation rule. 

• On the right above the large yellow field, the data entry operator can choose whether pressing the 
arrow keys, ‘Tab’ or ‘Enter’ keys on a keyboard will be used to move between response data fields. 
Arrow keys option is selected by default. 

• Cover page variables are listed under the large yellow field at the top of the screen.  
  

 

Do NOT choose the option of copy over the cover page variables. It saves very littletime 
and create multiple dataentry errors which will take much longer to resolve. 

 

 
Figure 100:A data entry screen for a new record 

5. Under Responses, key in the required data into each field. 

 

Any fields containing data that violate validation rules will be highlighted in red. The record 
cannot be saved if any fields are red. 

6. When all data has been entered and there are no red fields, click Save & Next. 

7. A pop-up window will appear saying the data will be saved and asking if you want to continue. Click OK. 
ACER Maple then performs a number of validity checks on the data entered in the template. 

The possible outcomes and required actions are described in Table 60. 



Chapter 10  Data Entry AMPL DMM 

ACER © 2023 Commercial in Confidence Page 167 of 207 

Table 60: Possible outcomes when adding a new response data record in ACER Maple 

Outcome  Next steps 

• All fields are entered and ACER 
Maple found no discrepancies. 

• A pop-up window appears saying 
the record has been saved. It will 
automatically disappear after a 
few seconds. 

• All data fields are cleared for the 
next record to be keyed in. 

• The DEO does not intend to add 
any more records at this time. 

1. Click Cancel. A pop-up message will appear warning that 
the data will not be saved. 

2. Click OK. The Key in responses screen will return. 

3. Click Back to return to the Main screen. 

• All fields are entered and ACER 
Maple found no discrepancies. 

• A pop-up window appears saying 
the record has been saved. It will 
automatically disappear after a 
few seconds. 

• All data fields are cleared for the 
next record to be keyed in. 

• The DEO needs to add another 
record. 

1. Repeat steps 5 to 7 to add another record. 

2. Follow the steps that correspond to the appropriate 
outcome described in this table. 

• There is an error in the data 
entered. 

• A pop-up window appears 
describing the error that is 
preventing the data from being 
saved. It will automatically 
disappear after 10 seconds. It can 
also be closed manually by clicking 
‘X’ in the top right corner. 

1. Make any required corrections before clicking Save & Next 
again. 

2. Follow the steps that correspond to the appropriate 
outcome described in this table.  

10.2.4 Search 

ACER Maple also includes a search function with the Key in responses function. 
  

 

A data entry operator login must be used for the following function. 

To search the list of keyed in response data records by instrument, identifier (from cover page), the date the 
record was added to ACER Maple (Added date) or by DEO who added the record (Added by): 

1. Follow the instructions in section 10.2.2 to access the Key in responses screen. 

2. Ensure that the Existing tab is highlighted on the left-hand side of the screen. 

3. Enter the information you wish to use to search the list of keyed in response data records (Figure 101). 
If all search terms are left blank, all keyed in records will be listed. 

• Select from the drop-down Instrument list to see all records entered for that instrument. The total 
number of records entered for each instrument appears in brackets next to the instrument name. 
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• Enter a value for one of the identifier variables from the instrument cover page (eg AMPL school 
number, student/principal ID) to see all records matching that value. OR 

• Enter an appropriate “from-to” date range to show all records entered with that date range. 
OR/AND 

• Enter the username of a data entry operator to show all records entered by that operator. 

 
Figure 101: Search keyed in data records 

4. Click Search. All records matching the search terms that have been entered will be listed in the middle 
of the Key in responses screen (Figure 102). If no records match the entered search terms, the message 
“No data available in table” will display in the centre of the screen. 
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Figure 102: Keyed in data record search results 

10.2.5 Edit 

This option allows data entry operators to make changes to an existing data record. 
  

 

A data entry operator login must be used for the following function. 

To edit keyed in response data for an existing record: 

1. Follow the instructions in section 10.2.2 to access the Key in responses screen. 

2. Use the Search function (section 10.2.4) to locate the data record that needs to be changed. It will be 
listed in the centre of the screen. 

3. Underneath the Action column heading, click Edit. The corresponding data entry screen containing 
keyed in data will appear in a pop-up window. 

4. Make the required corrections to the data by directly editing the text in any field in the Cover Page or 
Responses section of the template. 

5. When all data has been entered and there are no red fields, click Save. 

6. A pop-up window will appear saying the data will be saved and asking if you want to continue. Click OK. 
ACER Maple then performs a number of validity checks on the data entered in the template.  

The possible outcomes and required actions are described in Table 61. 
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Table 61: Possible outcomes when editing a response data record in ACER Maple 

Outcome  Next steps 

• All fields are entered and ACER 
Maple found no discrepancies. 

• A pop-up window appears saying 
the record has been saved. It will 
automatically disappear after a 
few seconds. 

• The DEO does not need to edit any 
more records. 

1. Click Back to return to the Main screen. 

• All fields are entered and ACER 
Maple found no discrepancies. 

• A pop-up window appears saying 
the record has been saved. It will 
automatically disappear after a 
few seconds. 

• The DEO needs to edit another 
record. 

1. Repeat steps 2 to 6 to edit another record. 

2. Follow the steps that correspond to the appropriate 
outcome described in this table. 

• There is an error in the data 
entered. 

• A pop-up window appears 
describing the error that is 
preventing the data from being 
saved. It will automatically 
disappear after 10 seconds. It can 
also be closed manually by clicking 
‘X’ in the top right corner. 

1. Make any required corrections before clicking Save again. 

2. Follow the steps that correspond to the appropriate 
outcome described in this table.  

10.2.6 Reset 

The reset function deletes all keyed in response data for a record, without deleting their cover page 
identifiers, so that an “empty” record is retain in the database. 
  

 

A data entry operator login must be used for the following function. 

To reset the keyed in data for an existing record: 

1. Follow the instructions in section 10.2.2 to access the Key in responses screen. 

2. Use the Search function (section 10.2.4) to locate the data record that needs to be changed. It will be 
listed in the centre of the screen. 

3. Underneath the Action column heading, click Reset. A pop-up message will appear warning that the 
response data for the specified record will be reset to empty (Figure 103). 
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Figure 103: Reset response data warning 

4. Click OK. Another pop-up message will appear saying the record has been updated. It will automatically 
disappear after a few seconds. 

5. To re-enter data for the reset record, click Edit (underneath the Action column heading), and follow the 
instructions into section 10.2.5 to edit the empty record. 

10.2.7 Delete 
  

 

A data entry operator login must be used for the following function. 

To delete an existing response data record from ACER Maple: 

1. Follow the instructions in section 10.2.2 to access the Key in responses screen. 

2. Use the Search function (section 10.2.4) to locate the data record that needs to be deleted. It will be 
listed in the centre of the screen. 

3. Underneath the Action column heading, click Delete. A pop-up message will appear warning that the 
selected record will be deleted (Figure 104). 

 
Figure 104: Delete response data record warning 

4. Click OK. Another pop-up message will appear saying the record has been deleted. It will automatically 
disappear after a few seconds. 

10.3 Validating Respondent List 

After all response data has been successfully entered into ACER Maple, it needs to be checked against the 
student and school questionnaire tracking data updated in ACER Maple. 
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Every data administrator must validate respondent list for their domain AFTER:  

• ALL tracking data in the domain has been updated; and 

• ALL response data in the domain has been keyed in. 

Each data manager must validate respondent list for the entire entity AFTER ALL data 
administrators validated data in their domains, but BEFORE data is submitted. 

 
  

 

The data administrator or the data manager login can be used for the following function.  

 

To validate response data against student and school questionnaire tracking data: 

1. On the Main screen select Response data > Validate respondent list and then click Activate. The 
Validate respondent list screen will appear (Figure 105). 

 

Figure 105: Validate respondent list screen 

2. A summary of the keyed in data is provided in the middle of the screen. The following information is 
listed for each instrument: 

• The number of students/schools listed as participating (for the listed instrument) in the 
appropriate tracking form; 

• The number of students/schools that have had response data entered into the listed instrument; 
and 

• The number of records in both. If all data for the listed instrument has been entered correctly, the 
three numbers will be the same. 
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3. On the left-hand side of the screen you can select or deselect the instruments that you want to 
validate.  

• The first time you validate response data, ensure that all instruments are selected. 

• On subsequent occasions, you may choose to only validate response data for instruments that 
contained errors that you have tried to correct. 

• You should validate response data for all instruments one final time before submitting your data 
to ACER. 

4. Click Validate data for selected instrument(s). Two pop-up messages will appear, the first asking if you 
have entered all response data, the second all tracking data. Click Yes for both. ACER Maple then 
performs the validity checks. 

The possible outcomes are required actions are described in Table 62. 

Table 62: Possible outcomes when validating respondent list data 

Outcome  Next steps 

• The data has been validated with 
no discrepancies 

• A pop-up message appears saying 
the validation has been successful 

1. Click Dismiss.  

2. Click Back to return to the Main screen. 

• The data contains some 
discrepancies that need to be 
checked or corrected. 

• A pop-up message appears saying 
the data contains errors and/or 
warnings. 

• Respondent List Validity Report is 
available for download. 

1. Click Download Validity Report, save the file in an 
appropriate location. Click Cancel to close the pop-up 
message. 

2. Manually enter or navigate to the location of the saved 
report and open it. 

3. Refer to section 10.4.2 to check the records that appear in 
the report. 

4. If any corrections are required, make them in the 
corresponding tracking forms and/or data entry screens. 

5. Explanations of warnings listed in the report must be 
entered into the report by the data manager before data 
can be submitted (see section 11.1) 

 

10.4 Respondent List Validity Report 

If there are discrepancies between the response data that has been keyed in by data entry operators and 
corresponding student or school tracking information, ACER Maple will produce a Respondent List Validity 
Report (in Excel format) that contains information about these issues. Before you try to resolve them, make 
sure you have the relevant tracking forms and assessment instruments handy. 

There are two types of data inconsistencies listed in the report: errors and warnings. Errors and warnings in 
the report are organised into separate spreadsheets. Spreadsheet names clearly indicate which type of 
discrepancy the spreadsheet lists. 
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The Respondent List Validity Report can contain multiple worksheets. Make sure you have 
checked the records in all worksheets in the report. 

10.4.1 Errors in Respondent List Validity Report 

Table 63 (page 175) lists errors that may appear in particular Error worksheets of the Respondent List Validity 
Report. Table 63 also explains how these errors can be resolved. 
  

 

Column names in square brackets appearing in messages within the report, such as [AMPL 
School No.] and [Line No.], will be replaced by the translated column names for LST_FRE. 

After all corrections have been made in the appropriate data, attempt to validate the respondent list again. 
Your database cannot be submitted to ACER until all errors have been resolved and all warnings explained. 

10.4.2 Warnings in Respondent List Validity Report 

Table 64 (page 175) lists discrepancies that may appear in Warning worksheets of the Respondent List Validity 
Report and explains how they can be resolved. 
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Table 63: Respondent List Validity Report: Error worksheets – Possible errors and their resolutions 

Description Warning message in report How to resolve Action required 

<Instrument Name> (Error) worksheet 

One or more respondents 
are listed as participating in 
the tracking data but there is 
no data entered for them in 
the corresponding survey 
instrument 

Recorded as participating or 
attending instrument 
<Instrument ID> in tracking 
data, but is not entered in this 
instrument 

• Check the values in that column in the 
appropriate tracking Excel file. 

• Check the paper instruments for any 
instruments that may have been missed during 
data entry. 

• Contact the school to locate any missing 
instruments, and to verify information in STF. 

• Correct any errors in tracking data 
and update tracking in ACER Maple 

OR 

• Enter any missing records into 
corresponding assessment 
instrument template in ACER Maple 

Data is entered for a 
respondent in a survey 
instrument, but the 
respondent is listed as not 
participating in the tracking 
data 

Response data is entered, but 
respondent is not recorded as 
participating or attending 
instrument <Instrument ID> in 
tracking data 

• Check the values in that column in the 
appropriate tracking Excel file. 

• Check the paper instruments for any errors 
made during data entry 

• Contact the school to verify information in STF. 

• Correct any errors in tracking data 
and update tracking in ACER Maple 

OR 

• Correct or remove incorrect 
instrument records from ACER 
Maple 

Table 64: Respondent List Validity Report for student lists: Warning worksheets – Possible warnings and their resolutions  

Description Warning message in report How to resolve Action required 

<Instrument Name> (Warning) worksheet 

One or more respondents have 
data entered in one survey 
instrument but in the tracking 
data assigned a different survey 
instrument (only possible for 
rotated AMPL test forms) 

Candidate was allocated  
<Instrument ID 1> in tracking 
data, but data entered into 
<Instrument ID 2> 

• Check that the student was accessed 
using the paper instrument that the data 
was entered into. 

• Enter student data into correct 
instrument there was a data entry 
mistake made in ACER Maple  

• Contact the school to get information on 
why different instrument was given to the 
student. 

• Correct or remove incorrect 
instrument records from ACER Maple 

OR 

• Save the report excel file produced by 
ACER Maple 

• Specify the reason for assigning 
assessment instrument different from 
what specified in tracking form and 
save the report Excel file.  
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Data manager should perform the tasks described in this chapter. 

 

11.1 Explaining Warnings 

Due to the complexity of test administration and data processing in large scale surveys, it is possible 
that some discrepancies reported by ACER Maple are actually valid data. These inconsistencies are 
listed in various validity reports as warnings. Therefore, the presence of warnings in validity reports 
will not prevent the Submit data function from being enabled in ACER Maple. However, explanations 
must be provided as to how these inconsistencies occurred otherwise data cannot be submitted.  

It is essential for the data manager in the NC to provide explanations for all warnings that are kept in 
the ACER Maple database. There are three types of such warnings (see Table 65). To be explained, 
these warnings must be exported from ACER Maple using Export > Remaining warnings function as 
explained in section 11.1.1. 
 

Table 65: Validity reports that may produce warnings that require explanations 

Validity reports that may produce warnings kept in the 
ACER Maple database 

Form containing warnings Form 
acronym 

Update Field Data Validity Report produced when STFs are 
updated in ACER Maple (sections 9.4 and 9.5) 

Participation & Attendance 
Warning Form 

PAWF 

Update Institution Participation Validity Report produced 
when school participation information is imported into ACER 
Maple (sections 9.6 and 9.7) 

Main & Replacement Warning 
Form  MRWF 

Respondent List Validity Report produced after all participant 
responses have been entered into their corresponding 
assessment instruments (sections 10.3 and 10.4) 

Respondent List Warning Form 
RLWF 

 

After warnings had been exported, unzip and open exported Excel files: 

• if ALL exported files are empty, go to section 11.2 on page 183;  

• otherwise: 

 provide explanations in the last column of the exported Excel files (sections 11.1.2 - 
11.1.4);  
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 import the Excel files with explanations into ACER Maple (section 11.1.5); 

 once all remaining warnings previously saved in ACER Maple have been explained, 
submit your data to ACER (see section 11.2 on page 183). 

  

 

Errors listed in the validity reports produced by ACER Maple will prevent users from 
completing the corresponding tasks and the Submit data function will not be activated. 

 

11.1.1 Exporting remaining warnings from ACER Maple 
  

 

The data manager login must be used for the following function.  

To export remaining warnings: 

1. On the Main screen select Export > Remaining warnings and then click Activate. The Export 
remaining warnings screen will appear (Figure 106). 

 
Figure 106: Export remaining warnings screen 

2. Click Export. The zip file will be available for download. 

3. Select ‘Save File’ and save the zip file in an appropriate location. 

4. Unzip the file and follow instructions in sections 11.1.2-11.1.6 to explain warnings and import 
your explanations in ACER Maple. 
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11.1.2 Explaining warnings in the Participation & Attendance Warnings Form 
(PAWF) 

The warnings saved in this form come from the Update Field Data Validity Report that had been 
performed when the tracking data had been updated (see section 9.5).  

This form can contain the following warning: Candidate is marked as participating but is not attending 
all instruments (Sampling level:0). 

• If the student indeed was present for the test but not for the Student Questionnaire or vice 
versa, provide the Test Administrator explanation in the Explanation column (see example in 
Table 66). 

• Otherwise, this discrepancy must have been an error that must be corrected:  

 Please correct attendance on the STF and update it in ACER Maple again (section 9.4).  

 Re-run the Respondent List Validity Report again (section 10.4).  

 Export remaining warnings again. 

11.1.3 Main & Replacement Warnings Form (MRWF) 

The warnings saved in this form come from the Update Institution Participation Validity Report that 
had been performed when the school participation had been updated (see section 9.7) 

This form can contain the list of schools for which: 

• Main and first replacement school both participating 

• Main and second replacement school both participating 

• First replacement and second replacement school both participating 

Carefully check again that this indeed what happened and there are no errors in the SPF. 

• If there are still errors:  

 correct SPF  

 update school participation again (section 9.6) 

 export remaining warnings again. 

• If replacement schools were used for a reason, please provide it in the Explanation column (see 
example in Table 67). 

11.1.4 Explaining warnings in the Respondent List Warnings Form (RLWF) 

The warnings saved in this form come from the Respondent List Validity Report that had been 
performed after all response data had been entered (see section 10.4). 

This form can contain the following warning: Candidate was allocated <Instrument ID 1> in tracking 
data, but data entered into <Instrument ID 2>. 

• If the test administrator indeed allocated to the student listed on this form a different test 
booklet from the one indicated on the STF, he/she must have a reason for that. Please provide 
this reason in the Explanation column (see example in Table 68). 

• Otherwise, this discrepancy must have been an error that must be corrected. Please correct this 
error, re-run the Respondent List Validity Report and export remaining warnings again. 
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Table 66: Example warnings in the Participation & Attendance Warnings Form 

Survey 
ID 

Entity 
ID 

Admin 
ID 

AMPL 
School No. 

Row 
No. 

Participation 
lower grade 

Participation 
upper grade 

Attendance 
test 

Attendance 
questionnaire 

Warnings Explanations 

033 098100 01 1003 5 9 7 1 0 Candidate is marked as 
participating but is not 
attending all instruments 
(Sampling level:0). 

Student had been present at 
the first day of assessment 
but was absent at the second 

 

Table 67: Example warnings in the Main & Replacement Warnings Form 

Survey 
ID 

NC AMPL 
School 
Number 1 

Admin ID 
1 

Stratum 
ID 1 

School ID 
within the 
stratum 1 

AMPL 
School 
Number 2 

Admin ID 
2 

Stratum 
ID 2 

School ID 
within the 
stratum 2 

Explanation 

033 098100 1004 01 01 0002 1005 01 01 1002 Only 3 students were present for assessment in 
the main school and follow-up session was not 
possible to organise, so replacement school was 
used instead 

 

Table 68: Example warnings in the Respondent List Warnings Form 

Survey 
ID 

Entity 
ID 

Admin 
ID 

AMPL 
School No. 

AMPL 
Participant ID 

Test(1)/STQ(2) 
/SCQ(3) 

Test/Questionnaire 
Form 

Instrument 
ID entered 

Students(2)/ 
Prinicipals(3) 

Warnings Explanations 

033 098100 01 1003 92100305 7 1 8 2 Candidate was 
allocated 7 in 
tracking data, but 
data entered into 8 

Booklet 7 had missing 
pages and had to be 
replaced 

 

In the examples above the discrepancies are highlighted in red to attract your attention to them. This is not done In the Excel forms exported from ACER Maple. 
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11.1.5 Importing explained warnings into ACER Maple 

After all warnings have been explained you need to import the Excel files containing your explanations 
following the steps in this section. 
  

 

The data manager login must be used for the following function.  

To import explained warnings: 

1. On the Main screen select Final tasks > Explain warnings and then click Activate. The Explain 
warnings screen will appear (Figure 107). 

 
Figure 107: Explain warnings screen 

2. In the Available Templates drop-down list, select the relevant template as required. The first 
available template will already be selected. In the Selected Template Preview a preview of the 
selected template will appear. If required, use the horizontal scrollbar beneath this preview to 
view all the columns in the template. 

3. Click Browse… and browse to the location of the required file containing your explanations. 
Select the required file with explained warnings. The chosen Excel file will be uploaded into ACER 
Maple and its filename will appear in a tab beside the Browse… button. 

4. Click Import. ACER Maple performs some checks on the data in the selected Excel file. 
The possible outcomes and required actions are described in Table 69. 
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Table 69: Scenarios when importing explanation for the remaining warnings 

Outcome  Next steps 

Import successful, no discrepancies found. 

• ACER Maple produces a pop-up message 
indicating the number of records 
successfully uploaded, 

• Click Dismiss on the pop-up message.  

• If there are other forms where remaining warnings 
should be explained, provide explanations and 
repeat the steps provided in this section for all 
remaining forms. 

 If remaining warnings has been explained in 
all forms, follow data submission steps in 
sections 11.2.1-11.2.3. 

Import unsuccessful.  

• ACER Maple produces a pop-up message 
prompting to save Explain Warning Validity 

Report. 

• Click Dismiss on the pop-up message and navigate 
to an appropriate location to save the report. 

• Refer to section 11.1.6 to check records that appear 
in the report. 

 Make corrections in the Excel version of your 
template. 

 Attempt to import again. 

 If there are any warnings or errors left, you 
will be prompted to save another report. 

 

11.1.6 Explain Warnings Validity Report 

Table 70 on the following page gives detailed information about the types of inconsistencies that may 
be listed in the Explain Warnings Validity Report, and the steps to resolve them. 

To resolve the inconsistencies, you may need to export remaining warnings again following steps in 
section 11.1.1 and compare freshly exported version to the versions filled with explanations. Make 
sure that changes are made only in the last column where explanations are provided. All other data 
should stay unchanged. After all corrections in the relevant Excel file have been made, attempt to 
update the warnings data again.  
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Table 70: Explain Warnings Validity Report: Errors worksheets – possible errors and their resolutions   

Description Error message in report How to resolve 
Action required in the remaining warnings Excel 
file 

Incorrect columns worksheet 

Excel file corresponds to a different 
template. 

OR 

Excel file is missing one or more columns. 

OR 

Excel file has one or more extra columns. 

OR 

Excel file has one or more columns with 
incorrect names. 

Incorrect columns:  
Missing – <Column Name>, 
Extra – <Column Name> 

Check that you are selecting the correct Excel 
file to import and the correct template in 
ACER Maple. 

OTHERWISE 

Make sure that no adaptations were made to 
the chosen Excel file.  

Select the correct Excel file to import or select the 
correct template in ACER Maple. 

OR 

Add all missing columns. 

OR 

Delete all extra columns. 

OR 

Correct all column names. 

Key violations worksheet 

There are one or more illegitimate AMPL 
School Numbers. 

[AMPL School No.] is 
illegitimate 

Compare freshly exported version to the 
versions filled with explanations. 

Correct all AMPL School Numbers in the Excel file 
filled with explanations. 

There are one or more empty cells for AMPL 
School Numbers. 

[AMPL School No.] is missing 6. Compare freshly exported version to the 
versions filled with explanations. 

Add missing AMPL School Numbers in the Excel file 
filled with explanations. 

Validation rules worksheet 

One or more records contain one or more 
values that violate variable validation rules. 

Description of validation rule 
violation(s) 

Compare freshly exported version to the 
versions filled with explanations. 

Correct all invalid values in the Excel file filled with 
explanations. 

No explanation worksheet 

Not all warnings are explained. All warnings in the 
[template acronym] must be 
explained 

Check the Excel files filled with explanations Explain the warnings in the specified rows 
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11.2 Data submission 

11.2.1 Data Submission Schedule 

The data must be submitted to ACER within eight weeks of the completion of the assessment.  

11.2.2 Checking that ACER Maple Data is Ready for Submission 

Once all required data has been successfully entered into ACER Maple and all errors has been corrected 
in ACER Maple, the Submit data function will be enabled. This function will combine all data files 
necessary for submission into a single zip file, which you will upload to your MS Teams NC directory, 
Data Management folder. 
  

 

A data manager login must be used for the following function. 

To check that ACER Maple data is ready for submission to ACER: 

1. On the Main screen select Final tasks > Submit data and then click Activate. The Submit data 
screen will appear (Figure 108). 

 
Figure 108: Submit data screen 

2. Click Check Warnings and Institution Participation. ACER Maple then performs a number of 
checks. The possible outcomes and required actions are described in Table 71. 



Chapter Error! Reference source not found.: Error! Reference source not found. AMPL DMM 

ACER © 2023 Commercial in Confidence Page 184 of 207 

Table 71: ACER Maple messages when checking warnings and institution participation 

Message Action required 

Your warnings and participation 
files are incomplete. Once these 
are finalised you will be able to 
export your data for submission. 

1. Update school participation in ACER Maple so that no errors are listed in 
Update School Participation Validity Report (section 9.6). 

2. Resolve all errors are listed in Respondent List Validity Report (section 
10.4.1). 

3. Attempt to submit the data again. 

Your warning and participation 
files have been completed, you 
can now export your data for 
submission.  

1. Take a screenshot of ACER Maple and save the picture in an appropriate 
location, as explained in the note below. The saved picture will need to 
be inserted into the Data submission Checklist document (see section 
A1.2). 

2. After the screenshot has been saved, click Export. All required data files 
will be combined into a single zip file which will be available for 
download. 

3. Select ‘Save File’ and save the zip file in an appropriate location. 

  

 

To take a screenshot: 

1. Press the ‘Alt’ and ‘PrintScn’ keys on your keyboard simultaneously. 

2. Open the Paint app. 

3. Press the ‘Ctrl’ and ‘V’ keys on your keyboard simultaneously (i.e. ‘paste’ function). 

4. Save a copy of the file in an appropriate location. 

 

3. After the screenshot and data has been saved follow the steps in section 11.2.3. 

11.2.3 Delivery Method 

To deliver your complete data submission package to ACER:  

1. Complete the Item Information for Cleaning documents (see section A1.1) and the Data 
Submission Checklist (see section A1.2)19. 

 Summarise information from the Session Reports and provide responses to all questions in 
the Item Information for Cleaning document. 

 Paste the screenshot of the ACER Maple message (see section 11.2.2) into the Data 
Submission Checklist. 

 Provide responses to all questions in the Data Submission Checklist. 

2. Add your 3-letter NC code to the file name of the zip file exported from ACER Maple in section 
11.2.2. 

3. Login to MS Teams and locate the Data Management folder within your NC directory. 

4. Within the Data Management folder for your NC, upload the database submission package that 
includes the following: 

 Submit_Data_<Date_Time>_[CNT].zip file as exported from ACER Maple 

 Completed Data Submission Checklist document (MS Word document) (section A1.2) 

 Completed Item Information for Cleaning document (MS Word document) (section A1.1) 
 

 

 
19 The Word versions of these checklists can be found in the MS Teams>AMPL Partner Collaboration>COVID-19 MILO>MILO 
International resources>Data Management Resources 
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5. Send an e-mail to Maple Helpdesk <maplehelpdesk@acer.org> with the subject line “Data is 
ready for submission” and your 3-letter NC code in square brackets (i.e. [CNT]). 

  

 

ACER Maple only exports data necessary for analysis and reporting. This does not include 
confidential information, such as names collected by your NC during the  AMPL survey. 

Please keep the latest version of ACER Maple that was used to export data for submission, 
in case it is needed for future checks. 

11.3 Data Cleaning Participation 

Please designate a data manager who will work actively with ACER during the data processing. This 
person should be able to respond to any queries in a timely manner during a period of four to six weeks 
after database submission to ACER. 

Please do not hesitate to contact Alla Routitsky at <alla.routitsky@acer.org> (cc to Maple Helpdesk 
<maplehelpdesk@acer.org>) if you have any questions regarding data submission. 

 

mailto:maplehelpdesk@acer.org
mailto:alla.routitsky@acer.org
mailto:maplehelpdesk@acer.org
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APPENDIX 1 DATA SUBMISSION CHECKLISTS 

A1.1 Item Information for Cleaning ..........................................................................................186 

A1.2 Data Submission Checklist ................................................................................................190 
 

The Item Information for Cleaning and Data Submission Checklist word documents have been uploaded into 
the MS Teams>AMPL Partner Collaboration>Data Management folder. Please download the updated 
documents and use them in your data submission. 

Please fill these documents and include them into data submission package to ACER (see section 11.2.3).  

A1.1 Item Information for Cleaning 

ITEM INFORMATION FOR CLEANING 
  

  

 

Please complete this form and return it with your data. 

 

Country  

NPM  

e-mail  

Data manager  

e-mail  

 
  

 

You may need to summarise relevant information from the Session Reports returned by 
Test Administrators to be able to answer the following questions. 
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Q1 Were there any problems with the Test Forms? YES NO 

  
1 2 

 For example, poor printing; errors or omissions; missing pages; faulty cutting, folding or 
stapling   

 
If ‘Yes’, please describe the nature and extent of the problem.   

 
   

 
   

 
   

 
   

 
   

 
   

 

Q2 Were there any problems with specific test items? YES NO 

  
1 2 

 For example, errors or omissions, problems with graphics.   
 

If ‘Yes’, please identify the booklet number, item number and student ID, and 
describe the problem. 

  

 If an item has a problem for a large number of students, please describe this problem in Q1 
providing the booklet number, the item number, and the number of students effected. This 
question is about problems affecting only few students. 

  

 
Booklet Item Student ID    
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Q3 Were there any problems with the questionnaires? YES NO 

  
1 2 

 For example, poor printing; errors or omissions; missing pages; faulty cutting, folding or 
stapling 

  
 

If ‘Yes’, please describe the nature and extent of the problem.   

 
   

 
   

 
   

 
   

 
   

 
   

 

Q4 Were there any problems with specific student questionnaire items? YES NO 

  
1 2 

 For example, errors or omissions, problems with graphics.   
 

If ‘Yes’, please identify the item number and student ID, and describe the problem.   

 If an item has a problem for a large number of students, please describe this problem in Q3 
providing the item number, and the number of students effected This question is about 
problems affecting only few students. 

  

 Item Student ID    
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Q5 Were there any problems with specific school questionnaire items? YES NO 

  
1 2 

 For example, errors or omissions, problems with graphics.   
 

If ‘Yes’, please identify the item number and principal ID, and describe the 
problem. 

  

 Item Principal ID    

      

      

      

      
 

Q6 Please notify us about any other matter that may require additional data cleaning 

   

 
 

 
 

 
 

 
 

 
 

THANK YOU! 
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A1.2 Data Submission Checklist 

DATA SUBMISSION CHECKLIST 
   

  

 

Please note that this is a checklist only. Please refer to Chapter Error! Reference source not f
ound.  for more information 

 

Please insert a screenshot from data submission screen in ACER Maple here: 

 

 

 

Q1 

 

 

Q1 

Have ALL of your required data been entered into ACER Maple? 

 

YES NO 

 Required data: 
1 2 

 • List of Classes 

• List of Students 

• Student Tracking Forms 

• School Questionnaire Tracking Form 

• School participation 

• AMPL Test Forms 

• Student Questionnaire 

• School Questionnaire 

  

 
If ‘No’, please enter ALL the data BEFORE you proceed with data submission   

 

Q2 
Have you entered student details in your ACER Maple List of Students for 
sampling? 

YES NO 

  
1 2 

 
If ‘No’, please upload a complete set of hard copies of LSTs to:  
MS Teams>AMPL Partner Collaboration>{Your country 
folder}>Data Management 
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Q3 Have you summarised Item Information for Cleaning? YES NO 

  
1 2 

 
If ‘No’, please summarise item information BEFORE you submit your data.   

 

Q4 Please check that you included all materials required for submission: Included 

 ACER Maple Database extracted for data submission    

 Item Information for Cleaning    
 

Q5 Please notify us about any other matter that may require additional data cleaning 

   

 
 

 
 

 
 

 
 

 
 

THANK YOU! 
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APPENDIX 2 TROUBLESHOOTING 

A2.1 Installation troubleshooting ............................................................................................. 192 
Manual exception configuration in the LAN settings to bypass the proxy ................................................................. 192 
“Not in a hypervisor partition” error............................................................................................................................ 193 

A2.2 Resetting forgotten password .......................................................................................... 195 

A2.3 Restoring data in ACER Maple .......................................................................................... 198 

A2.4 Extracting anonymised database for troubleshooting ...................................................... 198 

A2.5 Re-sampling students. ...................................................................................................... 199 
 
 
 

A2.1 Installation troubleshooting 

Manual exception configuration in the LAN settings to bypass the proxy 

This section explains how to configure exception in the LAN settings of the Mozilla Firefox on each PC 
to bypass the proxy when connecting to the IP of the PC hosting ACER Maple. 

1. Go to Options and scroll down to the Network Settings or Network Proxy section (Figure 109). 

 
Figure 109: Mozilla Firefox Options – Network Proxy section 

2. Click Settings. The Connection Settings window will appear. 

3. Select ‘Manual proxy configuration’ and in the No proxy for field enter the IP address of the host 
PC (Figure 110). 
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Figure 110: Mozilla Firefox Connection Settings 

4. Click OK and then close the Options tab. 

“Not in a hypervisor partition” error 

 

If you see a pop-up error message saying “Not in a hypervisor partition” instead of the 
purple UBUNTU window, please follow below steps to solve the issue. 

The error message 
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The solution 

Step 1. Restart your laptop or desktop computer. Then, press the BIOS key when the boot 
screen appears to enter BIOS mode. (The BIOS key is usually the “ESC” key on the keyboard, 
but different computer models may have different BIOS keys) 

 
Step 2. Use the arrow keys to navigate the Configuration tab in the BIOS interface, where 
you can find the virtualization. 

 
Step 3. Once you've located the virtualization item (IVT, AMD-V, or something related to 
virtualization), press Enter to confirm that it is enabled. 
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Step 4. Click F10 to save your changes and exit BIOS. 

 
After enabling Virtualization in BIOS, restart your computer to restart the virtual machine 
in VirtualBox. You will open this VM smoothly this time. 

 

 

A2.2 Resetting forgotten password 

 

Only data managers can reset forgotten passwords. Data administrators must ask their 
data manager to reset their forgotten password for them. 

To reset a forgotten password: 

1. Open ACER Maple: 

• If using single user deployment, in ACER_MAPLE_V<#> folder double-click acer_maple_start.bat. 

• If using multiple user deployment, paste the IP address of the host PC into the address bar of a 
browser.  

The Login screen will appear (Figure 111).  
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Figure 111: ACER Maple Login screen 

2. If you are a data manager, on the left-hand side of the Login screen under ‘Help’, click Forgot 
password. The Reset Password screen will appear (Figure 112). 

 
Figure 112: Reset Password screen 

3. Enter your domain: Survey ID (033), Entity ID (6 digits) and Admin ID (00). 

4. Enter your username. 

5. Click Get passkey. A passkey will appear in the Passkey field. 

6. E-mail the passkey, domain and username to Maple Helpdesk maplehelpdesk@acer.org. 

7. You will receive an e-mail from ACER containing the data required for the fields ACER public key, 
Reset code and TempMsg. Due to the time difference between your country and Australia, it 
may take up to 24 hours to receive this e-mail. 

mailto:maplehelpdesk@acer.org
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8. After you receive e-mail from ACER, enter the ACER public key, reset code and TempMsg into the 
relevant fields. 

9. Click Reset password. 

10. Your password will be reset, and a temporary password will appear in a pop-up message. 

11. Copy the temporary password. 

12. Click Back. 

13. On the left-hand side of the Login screen under ‘Help’, click First time login. 
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A2.3 Restoring data in ACER Maple 

ACER Maple can back up the entire database every time a user clicks Quit if this user clicks YES on the 
prompt asking whether the user wants to back up the data (see section 2.7.4). The data backed up 
earlier will be overwritten. Therefore, the back-ups have to be regularly exported and archived as 
explained in section Error! Reference source not found..  

To restore a back-up kept in the archive into ACER Maple: 

14. Copy the zip file you want to restore into the C:\MapleFiles folder. 

15. Re-name it into Maple_Update.zip (Figure 113). 

 
Figure 113: Maple_Update.zip file in the C:\MapleFiles folder 

16. Within 5 minutes the ACER Maple VM will be updated with the database files with the files from 
the zip file. If update was successful, the zip file will be renamed automatically to 
Maple_Update_<Date>-<Time>.zip (Figure 114). 

 
Figure 114: ACER Maple VM updated with the database files from the back-up made earlier 

A2.4 Extracting anonymised database for troubleshooting 

To extract the anonymised database for troubleshooting: 

1. Create a back-up as explained in section 2.7.4. 

2. Export back-up as explained in section 2.7.7, 

3. Double click on the zip file within the back-up folder 

4. Open the shiny folder. Do not unzip the file. 

5. The actual backup consists of two folders: confidential_tables and tables (Figure 114). 
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Figure 115: Subfolders in the shiny folder in the backup file 

6. Delete the confidential_tables subfolder. 

7. Close the shiny folder. 

8. Upload your anonymised back-up file db_backup_<date>.zip onto MS Teams>AMPL Partner 
Collaboration >Country Folder>Data management (Maple). 

9. Send e-mail to ACER Helpdesk at maplehelpdesk@acer.org: 

 Include your 3-letter NC code and a short description of your issue in the subject line of the 
email, e.g. CNT_problems importing LST. 

 Include as much detail in your email as possible. 

 Indicate in the e-mail that you uploaded data for troubleshooting into your country folder. 

 Please take into account the time difference, helpdesk works standard business hours within 
the AEST/AEDT (Australian Eastern Standard/Daylight Savings Time) 

A2.5 Re-sampling students. 

You may need to re-sample classes or students from a school if the initial list was incorrect and you 
are sure there is enough time to produce new tracking forms and send these updated forms to the 
school before the test day. In this case, make sure that all old tracking form versions are deleted by 
the School Coordinator and the Test Administrator before you start the process. 

  

 

Do not re-sample classes in a school from which List of Students has already been sent to 
the NC unless: 

• the LCL was completely wrong; and  

• you will have enough time to send the updated LST to the School Coordinator; and 

• you have agreed with ACER that you are permitted to do this (contact Clare Ozolins at 
Clare.Ozolins@acer.org). 

Do not re-sample classes unless this has been agreed with ACER. 

 
  

 

Do not re-sample students in a school to which STF has already been sent unless: 

• the LST was completely wrong; and  

• you will have enough time to send the updated STF to the School Coordinator and test 
Administrator; and 

• you have agreed with ACER that you are permitted to do this (contact Clare Ozolins at 
Clare.Ozolins@acer.org). 

Do not re-sample classes unless this has been agreed with ACER. 

 

mailto:maplehelpdesk@acer.org
mailto:Clare.Ozolins@acer.org
mailto:Clare.Ozolins@acer.org
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If you reached the agreement with ACER for re-sampling, a data administrator login must 
be used for the following function. 

 

To re-sample classes or students and allocate instruments to students: 

1. On the Main screen select Sample and allocate instruments > Sample and allocate and then click 
Activate. The Sample and allocate instruments screen will appear (Figure 116). 

2. In the Select Population Type box select: 1: classes OR 2: students depending on whether you 

are sampling classes or students. 

3. In the Select Combined Option box select the available option. The option will be: 

2 - if you are sampling classes; OR 

XXX - if you are sampling students; XXX is assigned on your LSS in the Student combined option 

column and is usually, but not always is a standard ISO 3-letter code for your country (see Table 2 
or your LSS). 

You have to select the option even if there is only one. 

4. In the Select School Type list select ‘Already sampled’. 

5. Click List Available Institutions to Sample. In the Available for Sampling box the AMPL School 
Number of all schools which are available for sampling for the selected population type and 
combined option will be listed. 

 
Figure 116: Sample and allocate instruments screen with a school selected for re-sampling 

6. In the Available for Sampling box select the AMPL School No. of the school in which classes or 
students need to be re-sampled. (Figure 117). 
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Figure 117: Selecting a school for re-sampling 

7. Click  to move this school into the Selected for Sampling box (Figure 118). Once the school 
have been added to the Selected for Sampling box the Sample button will appear. 

 
Figure 118: Multiple schools moved to the Selected for Sampling box 

8. Click Sample. ACER Maple will sample and allocate instruments to the selected population for 
the selected combined option in the selected schools. 

During the sampling and instrument allocation process ACER Maple performs some checks. The 
possible outcomes and required actions are described in Table 32 on page 104. 
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APPENDIX 3 BLIND SAMPLING 
  

 

This procedure can only be used if a school has agreed to participate, but the List of 
Students will not be received from the School Coordinator in time for student sampling. 
Blind sampling is more expensive and less relible than sampling from a List of Students with 
complete - and carefully checked - data. 

Blind sampling does not excuse the School Coordinator from preparing a List of Students. 

If blind sampling is being used: 

1. The number of students in the grade eligible for assessment must be obtained from 
the School Coordinator. 

2. The LST data must be prepared by the data administrator as shown in Table 72, and 
imported into ACER Maple (see section 5.4). Then students must be sampled (see 
chapter 6), and the STF template populated with students ID. 

3. At the same time, the LST data must be completed by the School Coordinator at least 
two days before the assessment takes place, as explained in the School Coordinator 
Manual. 

4. The Test Administrator must visit the school a day before the assessment and manually 
transfer the records into the STF according to Line No. value in the STF. 

For example, if line number 00003 appears in the STF, then the details of the third 
student from the LST completed by the School Coordinator must be transferred into 
STF. 

This must be done for every listed line number in the STF. 

5. The LST completed by the School Coordinator must be collected by the Test 
Administrator and sent to the NC after the assessment, along with all other materials. 

 

Table 72: Example LST data in Excel format ready to be imported into ACER Maple for blind sampling 

1 
 

 AMPL  
(F=1; 
M=2) MM YYYY 

Special  
Educational  

Needs 

2 
Class 
name Student name 

School 
No. 

Line 
No. Gender 

Month of 
Birth 

Year of 
Birth SEN 

3   1001 00001 9 99 9999 0 

4   1001 00002 9 99 9999 0 

5   1001 00003 9 99 9999 0 

6   1001 00004 9 99 9999 0 

7   1001 00005 9 99 9999 0 

8   1001 00006 9 99 9999 0 

10   1001 00007 9 99 9999 0 

11   1001 00008 9 99 9999 0 

12   1001 00009 9 99 9999 0 

13   1001 00010 9 99 9999 0 

14   1001 00011 9 99 9999 0 
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